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Introduction

DipTrace Tutorial allows the reader to get started by designing a simple schematic and its
PCB, we will also design a component and practice with more advanced features.

This step-by-step tutorial is intended for gradual reading starting from the beginning, with
more simple topics at the top and more complex (where we assume that you already know
the basics) at the bottom.

For a quick answer, please refer to the corresponding Help document ("Help \ <DipTrace
module> Help" from the main menu).

Created for DipTrace version 3.0 (June 14, 2016).
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Creating a simple schematic 5

Part I:

Creating a simple schematic

In this part of the tutorial you will learn how to create a simple schematic and generate a PCB
(Printed Circuit Board) using the DipTrace software.

Let's start from the schematic. Open DipTrace Schematic, go to "Start \ All Programs \
DipTrace \ Schematic" in the Windows OS or use DipTrace Launcher on MacOS.

If this is the first time you launch DipTrace Schematic, the graphics mode and color scheme

selection dialog box will pop up.

=)

Please select preferred graphics mode and
color scheme before the first run. Use
"View/Graphics Mode" and "View/Colors" to
change these settings later.

Graphics

Graphics Mode
OpeniGL

@ Direct3D

Windows GDI (slow mode)
Colors

White (standard scheme)
@ Black (comfortable for eyes)

Color Settings |

You can select the graphics mode that works better
for you:

1. Direct3D is the fastest mode for typical Windows
PC, we recommend you to use this mode if it works
correctly on your system. Direct3D suits machines
without high-end graphics system and OpenGL
hardware. However, this mode depends on
hardware/drivers/versions, therefore a small
percentage of computers (usually with new/very
buggy, or very outdated OS/drivers) can have issues
(artefacts on the screen, etc.).

2. OpenGL usually works a bit slower than
Direct3D, but it is more universal, suitable for
different operating systems and less dependent on

hardware/drivers.
OpenGL is the best choice for high-end engineering /

graphic stations with professional OpenGL equipment. However, you can try both modes on
complex projects and choose the best for you.

3. Windows GDI is an alternate mode if both Direct3D and OpenGL failed to work properly
with your graphics card. It is much slower, but doesn't depend on drivers/hardware/OS. This
mode is enough for comfortable work on small and medium-sized projects.

We will use a white background as more acceptable for printing this tutorial, but you can
select the color scheme you want (classic black background is the most eye-friendly). Notice
that you can change the color scheme or define colors any time in the "View \ Colors" main
menu item.

Graphics dialog box will appear after the PCB Layout module has been launched for a first
time. Component Editor and Pattern Editor use the color settings of Schematic Capture and
PCB Layout respectively.

Notice that relative sizes of program panels in the screenshots may differ from what you see
on the screen due to resolution limitations applied in this PDF tutorial.

Sometimes we will hide the Design Manager (which is on the right side of the screen) to add
more design space, but if you have high resolution screen you don't have to do this. Select
"View \ Toolbars \ Design Manager" from the main menu to show / hide the Design Manager
panel or press "Ctrl+2" default hotkeys.

Some schematic and PCB examples presented in this tutorial are designed exclusively as a
demonstration cases of the tools being used, they are not necessarily working prototypes.
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1.1
111

Schematic Ul

Schematic main window

Schematic main window includes: schematic design area, main menu, toolbars, the
Properties panel, Design Manager, Place Component panel, and the status bar.

Main menu-..__ﬂ 4 Schematics - [ DipTrace Exsmples\Schematic_S.dch] =—mn |
Mefile fde Mew Objects Vegfcotion Library Jook Help
tStalgdard'___,...rD@namg b RE|o o A& R - ~AE|+|BH|LEIEc e B~
oolbar Place Companent d et
____________._.léomp{:nents Dl Objects toolbar Refes: UE
i . vl THHCLE
S:lglrjepnt Ilbrary Dscrete SMD Rarme: MCT4HCLESH
bols Addefinal
Ne::i::sa( Py tama: Part 1
. arking 1: RefDes =
Libraries ;::;k Markng 2 vae -
2
T Design Manager al@ v

Place / CAP100

= e - res .
Component CARZO0 < WLE = PRC1TCAH - PIC1TCA4
CAP2SD ]
Compon‘é-ﬁfé-— Part 1 l u;: = ADGAL] - ADG411
—— C2-C25 < 10pF  R2L-RILRM-R4S - SKI 9 UL - ADG411 - ADG411
bl e e US - ADG411 - ADG411
v U TAGE e
- 74 - MCT4HC1E48
Properties [= v facc ncrucien
UB - T4HC240 - 74HC240
& |E a U « 7AHERAD - PAHEAD
Ul - 7605 - HCTBOSACT
Symbol—" g | = paons
ADMZIZE  [q L8
(=23
CAP-2.54/6.6:3 - i
o v p
. Y =
. I
. I T
T m =
Patterm— | - i o — o £ ¢4
L 2l kI -
Fohl | L 1
Sheei 1) 5heet 2/ Sheel 3 i b
BL3(5K1) X=-DA ¥=115 / X=0.35 in V=115 in
Design sheets Cursor coordinates /

Hint area

Design area Design Manager

Design area — create and edit schematic objects (parts, wires, buses, shapes, tables, etc.).
Access to all common functions of the program via the main menu.

Standard toolbar — tools to work with files, cut/copy/paste objects, print, preview and
configure titles, change scale and grid size.

Objects toolbar — default mode, define origin, find and place components, create and edit
wires and buses, place page connectors (Bus connectors), define differential pairs, place
hierarchy connectors and blocks, place shapes, texts, and tables.

Place Component panel — all active libraries, user libraries or only components of the
current project. Select library from the list, find component using the search filters and place
it. Setup the panel, search filters, multi-part component placement tools, symbol and pattern
previews.

Properties panel — displays the properties of active tool or selected object/s.

Design Manager — allows to quickly find any component or net in the circuit.
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Design Manager ¢ @ ey .
TR A Press button to see the list of components, or press button to

D15 - 1N4100

ol see the list of nets. Select component or net in the list, and all pins of
TSN selected component or net will appear in the list right below. Left click in
IC5 - MC74HCO0AD . . . . . . -

%6 TakCiSE the list to highlight object, or double click it to pan the design area to

J2-LIME_DUT -
Compenent Pins:

IC3 4 (P1.2/R%D1) - RET
IC3: 5 [F1.3/TXD1)

selected object.

IC3 19(P2.7/7RD] - Net 26 E . .
E g?ﬁ?%@)%bxé& Press | = | to sort the list of com ponents or nets alphabetically (useful
IC3 21 b Het 82 when changing the RefDes array or adding new components).

IC3 1 [GND] <

Status Bar — left side shows the current hint and the right side shows the cursor
coordinates.

See DipTrace Help for details ("Help \ Schematic Help" from main menu).

Go to "View \ Toolbars \ <toolbar>" to hide / show any of the Ul toolbars (or use "Ctrl+1
through 4" hotkeys).

1.1.2 Custom keyboard hotkeys

DipTrace features customizable hotkeys in all software modules. This makes switching to
DipTrace especially convenient and fast, since you can assign keyboard shortcuts that
you've used to work with. Go to "Tools \ Hotkey Settings" from the main menu in Schematic,
however, the same main menu item leads to the Hotkey Settings dialog boxes in any of the
DipTrace modules: Schematic, PCB Layout, Component and Pattern Editors.

Hotkey Settings @
Function or Dialog Window Hotkey
File -
New Cirl+h =
Open Ctrl+0
Save Cir+s
Save As Crl+Al+S
Save Selected As None
Titles and Sheet Setup None
Preview before Print Cirl+Al+P
Print Cirl+pP
Schematic Information None
Convert to PCB Cirl+B
Back Annotate None
Edit
Undo Ctri+Z
Redo Cirl+Y
Cut Chri+x
Copy Ctrl+C
Pacta Chrl+ o
‘ Set Default Hotkey Configuration | ‘ 0K | | Cancel ‘

In our case we have Schematic hotkeys, but described here can be applied to customizing
shortcuts anywhere in DipTrace. In the Hotkey Settings dialog box you can assign custom
keyboard shortcuts to most DipTrace tools, program actions, and dialog boxes.

Let's assign another keyboard combination for creating a new file:
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1.2

- Left click in the corresponding field,
- Press key or key combination.

If the combination is already assigned to another tool, you can either proceed with a new
shortcut, or leave the old one.

Notice that all hotkeys mentioned in all topics of this tutorial are default ones.
Press Set Default Hotkey Configuration button to restore default values.

Notice that certain keys and combinations are reserved by the system. Please refer to the
Hotkeys topic in the Schematic Help document ("Help \ Schematic Help" from the main
menu) for complete list of reserved key combinations in DipTrace Schematic. Check out the
corresponding topics in PCB Layout Help, Component Editor Help, and Pattern Editor Help to
get more information about hotkeys in the respective programs.

Establishing schematic size and placing titles

We start with establishing the size of schematic sheet and placing the drawing frame, go to
"File \ Titles and Sheet Setup" from the main menu, and select ANSI A from the Sheet
Template drop-down box. Then go to the bottom of the dialog and check Display Titles and
Display Sheet items. Press OK.

4 Schematics o || & &8
File Edit View Objects Verification Library Tools Help
Dﬁ;u|§@‘ ‘n ‘Qq@zsﬁ%vn.nsmv@+|i]]zﬁ|1t:,ﬁt§jc‘m‘@:ﬂm
Place Component 4 * Properties
Components » Titles and Sheet Setup @
Actel i Sheet Template: JANST Al -
Alegro
Alcera Border and Sze | Title Blocks
AMD Barder M
order Margins ———————
Analog Devices g Print Settings
Atmel = Left: 0.5 in
Title Block Editor
Library Tools 4 Right: 05 =0
Fiter Off » Eliectiie
Top: 0.63 Z ) -
Bottom:  0.63 =8
3%83 =] n Height: 8.5 in
ag%gg ¥| Zone Information
Part 1 » Zone Template: ANSI - Zone Font
Auto PWR/GND Nurber of Zones: X: 2 Y: 2
V| Display Zone Border
E Zone Width: X038 i Yi 025 in
| Part Pins:
/| Display Titles V| Display Sheet
CAP-2.54/6.6x3 X
Apply Settings To:  Current Sheet -
.m =
" Sheet 1/ a r
X=-0165in ¥=1.968 in

Notice that you can show/ hide titles and sheet on the design area by selecting "View\
Display Titles" and "View\ Display Sheet" from the main menu.

Now press the Minus Sign (-) hotkey to zoom out until you can see the drawing frame. Plus
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and Minus signs (+) (-) hotkeys, the mouse wheel, and the scale box on the Instruments
toolbar allow for zooming on the schematic. Hover over selected area for more precise
zooming. Notice that we have hidden the Design Manager panel to the right ("Ctrl+2" hotkeys)
to get more space on the design area.

A Schematics E@
File Edit View Objects Verification Library Tools Help
D E ek 3 o sl a®er cwsn - (b4 [EH|LES RS B B e R
Place Component 4 o
Components 4 9 | 1
Actel B REVISIONS
Alegro ZonE | AEY | LESCRPTION [ oate APFRQVED
Alcera
AMD
Analog Devices
Atmel <
Library Tools » =] B
Fiter Off »
[T -
CAP100
CAP200
CAP250
CAP300 -
Part 1 » -] -
Auto PWR/GND
A A
CAP-2.54/6.6x3
SiZE [FSCH Ne, |ch ) REY
caLE I [sreet 1
2 1
" Sheet 1/
X=6.104 in Y=2.682 in

To enter text into the title field simply hover over that field with the mouse (the field highlights
in green), then left click it to open the field properties pop-up dialog box, select or type in the
text (field content), define alignment (Left, Center, or Right), and the font.

In our case type in "Astable Flip Flop" text, then press the Font button and set font size to 12.
Then click OK to close the dialog box and apply changes. You can enter multi-line text into
the title block fields. This text will be saved only for current project. If you need to create a
custom title template with predefined texts, please refer to Title Block Editor (more details
in Schematic Help Title Block Editor topic).
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4} Schematics E@
File Edit View Objects Verification Library Tools Help

D || ek 3 o ‘Qq@q4ss%vu.osinv+|ﬂ]}m|1h%r§c‘m‘@gjm
Place Component 4 o
Components 4
Actel -
Alegro
Alcera
AMD

Analog Devices
Atmel <

Library Tools 4
Fiter Off »

CAP100
CAP200
CAP250

Er— Astable Flip Flop

Auto PWR/GND

e

CAP-2.54/6.6x3

SCALE

' Sheet 1/ a r

X=1671in ¥=-1774in

SIZE |FSCM NO. DWG NO.

To zoom on the title block, hover over it with the mouse, and press the Plus Sign (+) or scroll
the mouse wheel.

Let's practice with different zoom options for a while. Click on the = button (Zoom Window
) and draw a rectangle on the design area where you want to zoom.

To return to previous scale and position, use R button (Undo Scale). Press and hold the
right mouse button to pan on the design area.

Go to "File \ Save As" from the main menu, type in the file name, and make sure that file is in
the directory that you need. Click Save.
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1.3

Place Component

4

Components

d

Varistors
Actel
J
Akera
AMD
Angzlog Devices

Library Tools
Fiter Off

-

UDN2987A
UDN2993B
UDN2993LB
UDN3625M

»
»

Part 1

Auto PWR/GND

&
3
3
1

1TITITIIT 11
ZEFE A
T

SOIC-20/300mi

Configuring libraries

DipTrace has a single cross-module library management system.
Libraries are organized to standard and custom library groups with multi-
level search filters ensuring that correct components can be found
quickly. The Place Component panel has all necessary tools to place
components and manage libraries.

Configuring library groups

Press | Components >

default library groups:

(<Current Library Group>) there are three

Components (all standard libraries, sorted alphabetically by component
type and manufacturer);

User Components (add / delete libraries to / from this library group).
Empty by default;

Project Libraries (auto-generated library with all components of the
current circuit). It is empty if no schematic file is open.

Let's group all libraries that we will need for our project in a single library
group. Select User Components library group, then press the

Library Tools > and select Add Library to "User

Components". In the pop-up dialog box select Components library
group from the Add from Group list. The Components library group
contains all standard DipTrace component libraries. Select Discrete,
Symbols, and Fairchild libraries, use "Ctrl" hotkey for multiple selection.
Press OK when ready.

Add Library to "User Components” Group @
@ Add from Group
Components (LT -
Usar Components Discreta SMD E
Project Libranas Symbals
Newarm Librarias Symibals EIC
Mt Ports
Antennas
Batheries
Buzzers
Capacihorns
Can Syrmbok
Con Backplane
Con Batteries
|Con Board In =
Add from Fie
Ho Library File
[ ok || cancal

Now selected libraries appeared in the User Components library group and we are ready to
start designing the schematic.
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1.4

Add library from the separate file

To add new library to the DipTrace library system, check Add from File checkbox in the Add
Library to <Library group> dialog box and select the file on your computer. You can also
use the Library Setup dialog box to get access to the comprehensive library system settings
("User Components (<Current library group>) \ Library Setup” on the Place Component
panel).

Notice that Library Setup panel allows for configuring both pattern and component library
groups, though pattern libraries are invisible in the Schematic.

More information in the DipTrace Help ("Help \ Schematic Help" from the main menu),
Working with Libraries section.

Designing a schematic

In this section of the tutorial we will show the basic principles of working in the Schematic
module of DipTrace PCB Design Environment.

Please turn ON the grid (if it was turned OFF) with "F11" hotkey. Change the grid size to 0.1

inch, you can select it from the list of grids 005in —~ o1 the Instruments toolbar, or press

the "Ctrl + Plus Sign (+)" hotkeys to increase, or "Ctrl + Minus Sign (-)" to decrease the grid
size.

Notice that you can add new sizes by selecting "View\ Customize Grid" from the main menu.
Measurement units can be changed in the "View\ Units" main menu item. We note only
default keyboard shortcuts in this tutorial. Go to "Tools \ HotKey Settings" to restore the
defaults or change shortcuts.

Now let's start creating the circuit. Select Fairchild library from the User Components library
group on the Place Component panel.

Search component in libraries

Filter - Not Applied Esl| Once the library is selected, scroll down the
T “Fairchid” Lbrary . component list to find 2N4401 transistor or use the
soarch For: oo search filters. Select "Objects \ Find Component” from
Text Parameters o the main menu or press Fiter Off F
e o L) button.
RefDes - [ |:|
Pattem - == In the pop-up dialog box make sure that Fairchild library
Wanufacturer  + = = is set as a search area, then type in "2n4401" into the

Name field, and press Apply Filter. Now only the

Cancel Fiter components with "2n4401" in their names appear in the
component list. The filters button now shows that filter
is ON. All other components are hidden.

Close the Search Filters dialog box.

Notice that you can expand the search results by entering a part of the component name as
well as filter components by RefDes, value, pattern, manufacturer, datasheet, or additional

fields, use the |L| and |_| buttons to add or delete the search filters.

Placing components
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Click on the transistor in the list and move your mouse pointer to the design area. Left click
once to place one transistor. Right click to disable component placement mode.

4 Schematics [ ]
File Edit View Objects Verification Library Tools Help
D W SRE & BB - & QR 0% ~|0in v+|mm|1h.ﬁ@o\m\@@m
Place Component 4 “ part:
User Components » RefDes: Q1
Discrete . . . . . . . . . . . . Value:
SEmboIs Name: 2N4401
’ ’ ’ ’ ’ ’ ’ ’ ’ ’ ’ ’ Additional:
Part Name: Part 1
Marking 1: Default -
Library Tools » . . . . . . . . . . . . Marking 2: Default -
»
Design Manager s E
snarager ¢t (] .
Q1 - 2N4401
Part 1 »

Auto PWR/GND

@ Part Pins:

TO-92

G0

'Sheet 1/ d 3

X=-11in ¥=16in

Drag and drop component if you need to move it to another location on the design area.

To select several objects, press and hold the "Ctrl" key, then left click on each object that you
want to add to the selection or move the mouse to the upper-left corner of the group, hold
down the left mouse button and move cursor to the lower-right corner, then release the
mouse button to select all objects inside the rectangle (press "Ctrl" key to invert selection).
Now you can move these objects at a time.

Sometimes it is necessary to change the reference designator of the component. Hover over
the component with the mouse pointer, right click it, and select the top item (Q1) from the
submenu. In the pop-up dialog box type in a new RefDes if needed. We will keep "Q1".

Component RefDes @

Enter Component RefDes Q1|

[ oK l | Cancel |

We need two transistors for the schematic, select 2N4401 in the component list again, and
place it on the design area. If you have changed the reference designator you don't need to

rename the second transistor, it happens automatically. If you want to rotate the component
before placing it on the design area, press "Space" or "R" default keyboard shortcuts.
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P el s
File Edit View Objects Verification Library Tools Help
Dﬁﬂ|§@‘éﬂ ‘-n ‘QQ@QSUE%vU.lin v+|ﬂﬁ|1k:%!§!c‘m‘@gjaﬁc
Place Component 4 ) ’ ’ ’ ' ' ’ ’ ’ ’ ’ ' “ Part:
User Components P RefDes: Q1
Discrete Value:
SEmbU|S Name: 2N4401
Additional:
Part Name: Part 1
Marking 1: Default -
Library Tooks » Marking 2: Default -
»
Design Manager 5 m
an Manag e (2]
Q1 - 2N4401
. Q2 - 2N4401
| |
Part 1 4 y -
Auto PWR/GND 0
| |
- Part Pins:
TO-92
" Sheet 1/ a
X=-12in ¥=16in

When the search filter is active, you can see only certain (filtered) components of the library.
Press Filter ON button on the Place Component panel, then press Cancel Filter in the
pop-up dialog box to turn the filtering OFF. Now close the search filters dialog box.

Select Discrete library, find RES400 resistor, and place it on the design area. "400" in the
resistor's name stands for 400 mils of lead spacing. If you prefer metric units, select "View \
Units \ mm" from the main menu, however, we will keep inches as these are the most

suitable units for current project.
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@ Schermatics o e )
File Edlt Objects  Verification Library Tools Help
N = Toolbars '\- ‘n ‘QQ@QSUE%vU.liH ,+|§]]}M|’|__[:%E‘c‘m‘ﬁqﬂﬂﬁﬂ
Place Comp ¥ | Part Preview . . . . . . . . . . . S [——
User Corr v Group Similar Parts
= v Display Hint
Symbols Part Markings 4
Fairchild Connectionto Bus
Pin Numbers 4
Hide Power and Gnd
Library T| v | Display Titles
Fiter Off ¥  Display Sheet
INDI Scale » Design Manager E 1.
RES Line Width... Q1 - 2N4401
RES400 Q2 - ZN4401
% ok R - RES400
Graphics Mode 3
RES600
Units
Part 1
Display Origin F1
AT Define Origin »
=
v | Grid F11
Grid Size 4
B—/\ Customize Grid...
T Part Pins:
RES-10.16/5.1x2.5
' Sheet 1/ a r
X=-18in Y=14in

Copy components

We need 4 resistors for this project. You can place them manually, like Q1 and Q2
transistors, but this time we select one resistor on the design area and copy it three times.
There are two ways to copy a component:

1. Once component is selected, go to "Edit \ Copy" from main menu or right click on the
component and select Copy from the submenu, ("Ctrl+C" hotkeys), then select "Edit \ Paste"
three times, or right click on the design area, and select Paste from the submenu.

2. Copy Matrix, good for bulk copying. Select resistor, then go to "Edit \ Copy Matrix" from the
main menu (or press "Ctrl+M" hotkeys).

Matrix @
Columns: 2 =
Rows: 2 =
Column Spacing: 1 in
Row Spacing: 0.4| in

[ 0K ] | Cancel |

In the Matrix dialog box set the number of columns and rows ("2" columns and "2" rows to
get 4 resistors) and spacing (1 inch for columns and 0.4 inch for rows are good), click OK.
Now you can see four resistors on the design area:
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File Edit View Objects Verification Library Tools Help
Dﬁﬂ|§@‘éﬂ ‘-n ‘QQ@QB??%vU.lin v+|ﬂﬁ|1k:%!§!c‘m‘@gjaﬁc
Place Component 4 o o o o o * Pparts:
User Components P RefDes: L ]
i Value: |—|
Name: |—|
Additional: L ]
Part Name: I—I
Marking 1: Default -
Library Tooks » Marking 2: Default -
Fiter Off »
Design Manager s
INDI - an Her=a & L
RES Q1 - 2N4401
Q2 - 2Nea01
R1 - RES400
RES500 R2 - RES400
RES600 % R3 - RES400
R4 - RES400
Part 1 »
Auto PWR/GND
Part Pins:
RES-10.16/5.1x2.5
o[_Jo
" Sheet 1/ .
X=-04in ¥=15in

Move resistors to a proper location, like on the picture below (use mouse or arrows on the
keyboard for orthogonal moving), and rotate components 90 degrees (use "Space" or "R"
shortcuts to rotate selected components). Another method to rotate an object is using the
"Edit \ Rotate" main menu item or right clicking on the object and selecting Rotate from the

submenu.

Notice that you can pan design with the right mouse button or the mouse wheel: move mouse
arrow to the design area, hold down the right mouse button or the mouse wheel, and pan.
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D@g|§@‘ ‘n ‘Qq@v\nmvu.m -+|§]]}M|1[;;%Ec‘m‘@:gaﬁc
Place Component 4 “ Properties
User Components P
= o o o o
= o ) <+
o o o (14
Library Tools 4
Fiter Off »
DI = - . L L L . o L Design Manager CE -
RES A . L L L . A L Q1 - 2N4401
Q2 -zt
A . L L L . A L R1 - RES400
RES500 R2 - RES400
RESG00 S . . . . . L . R3 - RES400
R4 - RES400
Part 1 »
Auto PWR/GND
Part Pins:
RES-10.16/5.1x2.5
o[ _Jo
" Sheet 1/ d +
X=-08in ¥=23in

Components' markings

The reference designators of Q1 and Q2 transistors have inappropriate location, we need
their RefDes to be under the component symbols. To change the RefDes location, select
both transistors, right click on one of them, and select Properties from the submenu. In the
pop-up dialog box select the Markings tab, and specify: " Justify: Bottom" in the Main

Marking section.
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A Schematics (===
File Edit View Objects Verification Library Tools Help
DB ESRE &t BE o~ qaay-oun ~ [+ #H LISk oo 8dd=
Place Component 4 *  Parks:
User Components B T T T RefDes: L = ]
o~ o (x| [w]
; Value: [ ]
Compoenent Properties -3
b ™ ” Adeltonal L ]
o o X -0.3 in Y04 in o
m Markings Marking 1: Default  «
-
Marking 2: Default
Library Tools 4 Main Marking o -
Fiter Off » Show: Default -
. Design Manager g 1.
INDI - Justify: : -
RES Default Q1 - 2N4401
2 - 2N4401
additonalMarkng._|CEMTeT G2 - 2y
RESso R2 -RESA00
Show: Bottom )
RES600 % Left R3 - RES400
. Right R4 - RES400
Part 1 » Justify: Corner
Auto PWR/GND Auto
Use "F10" to switch to "move marking”
mode. "R" or "Space” to rotate marking
while moving. ’
Part Pins:
-
RES-10.16/5.1x2.5 N
[ Attached Pattern... ] o
u
o[ Jo
Sheet 1 [ L
Q2 X=103 ¥=04 X=-02in ¥=04in
Press OK.

Let's display component names for these transistors. Select the transistors again (if not
selected yet), and set "Show: Name and Part" and "Justify: Corner" in Additional
Marking section in the Markings tab of the Component Properties dialog box. This will
show the names of selected components. Notice that reference designators are already
displayed as primary markings. Default means using common Schematic settings for all
components. Displaying RefDes is a common property.

If you want to edit precise markings' positions, press the Unfold (right arrow button under the
Additional Marking section).
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You can show or hide the pin numbers for the entire circuit by selecting "View \ Pin Numbers \
Show" from the main menu, if they are not displayed yet. To change pin display settings for
selected part, right click it, and select Pin Numbers from the submenu.

However, if you're still not satisfied with location of RefDes, numbers, pin names or any other
markings, you can move them around visually with a special move tool. Select "View \ Part
Marking \ Move Tool" from the main menu or press "F10". We recommend to turn OFF the
grid for precise moving ("F11" hotkey). You can move and rotate part markings like separate
objects with "R" or "Space" shortcuts.

"View \ Part Marking" menu item allows the user to change common settings of part
markings. Common settings are applied to all schematic parts, except those with custom
properties.

Use Undo or Redo tools ( buttons) if you are not satisfied with the changes you've
made. The DipTrace saves up to 50 steps. Remember to save schematic into the file. Select
"File \ Save" from the main menu or press the Save button on the Standard toolbar. If current
schematic has never been saved, the Save As dialog box will pop up to define the file name
and location. If the file exists, clicking the Save button or pressing "Ctrl+S" hotkeys is enough.
You can use the "File \ Save As" dialog box to save the same file under a different name, for
example, in order to backup it.
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4 Save As

Savein:

=

Recent Places

, Bxamples

Name
| Spice
4 Astable_Flip_Flop

4 Quick Start
4 Schematic (Symbols only)

- @® o
Date modified
1/13/2014 1:20 PM
1/16/2013 9:36 AM

4/12/2010 3:17 PM
3/17/2005 9:50 AM

Type

File folder

DipTrace Schematic
DipTrace Schematic
DipTrace S5chematic

Desktop 4 Schematic_1 9/7/2011 4:12 PM DipTrace Schematic
— ‘4} Schematic_2 9/7/2011 1:33 PM DipTrace Schematic
= 4 Schematic_3 4/12/2010 3:18 PM DipTrace Schematic

Libraries ) Schematic_4 4/12/2010 3:18 PM DipTrace Schematic

4 Schematic_5 4/12/2010 3:19 PM DipTrace Schematic
:k 4 Schematic 6 4/12/2010 3:19 PM DipTrace Schematic
Computer
t&v 1 T b
Network
File name: | - Save
Save as type: ISchernatic Files (*.dch) vJ I Cancel ‘

Create connections
Connect pin 1 of R1 resistor to pin 2 (base) of transistor Q1. You need to make sure that you

are in the default mode ( button is pressed). Hover with the mouse arrow over the bottom
pin of R1 resistor, and left click it. Then move the mouse arrow down to the base pin of the
Q1 transistor, and left click it to connect wire and create the connection between R1 and Q1.

Now we need to mirror the Q2 transistor, this will make schematic more easy to understand.
Right click on the transistor, and select "Flip \ Horizontal" from the submenu.

@ Schematis ol e
File Edit View Objects Verification Library Tools Help
DEH ERE s BR 2>~ aqaaue-loun ~ [k+|([EH|[LEIEFe oo B=D
Place Component 4 “ part:
User Components P RefDes: Q2
i ! o o o Value:
: : Name: 2N4401
o M < = S
o o o Name: Part 1
. . Optimize RefDes »
ing 1: Default -
. . . . . e . . — . . RefDes Renumbering... 5 N 3
ing 2: ame and ~
Library Tools
k4 » . . . . . . . . . .| B LockSelected Ctrl+L
Fiter Off » Attached Pattern... h Manager . .m L
INDI 0 Spice Settings... -
RES Replace Part 2N4401
T elce 201
RES500 Save to Library 4 ;Eg:gg
RESB00 - Update from Library Y lRES400
RES400
Part 1 b Pin Mumbers 4
Auto PWR/GND RISl '
Rotate R
Flip = Horizontal
i Change Sheet... A Vertical
vy ’ - & Cut Ctrl+X X
ZN4 421 =
Copy Ctrl+C
> Delete Del
RES-10.16/5.1x2.5 2 Properties...
" Sheet 1/ Ll 3
Q2 X=-03 ¥=04 X=-02in ¥=04in
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Connect R4 to pin 2 (base) of Q2, R2 to pin 3 of Q1, and R3 to pin 3 of Q2, like on the picture
below. You can move components or wires to get straight lines,this is not important for
electrical connectivity, but for esthetic pleasure and in order to make schematic well-
organized and easy to understand. If you don't like the automatic wire placement mode, you
can turn it OFF on the Place Wire panel on the Design Manager to your right-hand side.
Set Manual in the Route Mode section or just press the "M" hotkey. The Place Wire panel is
only visible in the wire placement mode.

4 Schematics e ]
File Edit View Objects Verification Library Tools Help
DD’“H|§I§.‘ ‘n ‘@;Q@ﬂ?%-u.m - l}+|ﬂ]}m|h-ﬂ@0‘m‘@@m
Place Component 4 * Place Wire:
User Components B ' - o S - ' Net Class (C): Defauk =
T L] o | &~ Route Mode (M): Automatic -
Current Segment (S): Autoroute
- . N g <
o (14 ox (14
— | | |
Library Tools b Undo (U
Fter OFF NE . L . A L .
INDI v Design Manager = L
RES . . L . A L . Q1 - 2N4401
Q- lsdot
. . . . . . . . . . . . R1 - RE5400
RES500 R2 - RES400
RES600 54| . . . . . . . . . . . . R3 - RE5400
R4 - RES400
Part 1 »
Auto PWR/G

Part Pins:

J2N4d01 | 2N44e1

RES-10.16/5.1x2.5

2

Q2

o[ _Jo

.Shge[ 5 . . . . . . . . — . . . . -

X=-08in ¥=23in

Now select CAP100RP from the Discrete library and place it twice to the design.
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" Sheet 1/ a 3
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Flip C2 capacitor, select "Flip \ Horizontal" from the right-click submenu. C2 capacitor's
positive pin should be facing right.

We need to place two capacitors between the transistors Q1 and Q2 with respect to their
polarities.

You might need to move some components to give enough space for the capacitors and
connections.

Move resistors a bit upwards, and select Q2, R3, R4 and related wires in order to move them
to the right a little bit. Draw the selection box around these objects by holding down the left
mouse button.
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File Edit View Objects Verification Library Tools Help
D@g|§@‘ ‘n ‘Qq@v\nz%vu.m -+|§]]}M|1[;;%Ec‘m‘@:gaﬁc
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Use the right click to deselect all if you are in the Default mode, or double right-click if you are
in another mode (first click to disable an active mode and the second click to deselect all).

Connect the positive pin of the C1 to pin 2 of the Q1.: left click the C1 positive pin and left
click on the wire between the R1 and Q1, the small circle appears if wires are properly
connected.

Then connect C1 pin 2 and C2 pins like on the picture below.
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Scroll down the components list (Discrete library) on the Place Component panel to find the
LED component, and place two of them onto the schematic. Then change the reference
designators to "LED1" and "LED2" (right click on the component and select the first item from
the submenu), rotate these parts with "R" hotkey or Space bar (pressed three times).
Probably, you'll need to move and rotate the RefDes with the Move tool ("F10" shortcut). Then
connect LEDs to transistors like on the picture below.
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Place a battery symbol SOURCE_BATTERY2 component from the Symbols library, change
its RefDes if you need, and complete the circuit by connecting all the rest (see the picture).
Make sure that you see small black circles where two wires connect, if not, then wires are not

connected.
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If you want to move existing wire, hover over it with your mouse (the net should highlight and
the mouse cursor shows possible directions), then left click on the wire and move it while
holding the left mouse button.

Notice that if you are in the Place Wire mode and you click on the existing wire, you start to
create a newwire, not editing an existing one. The Place Wire mode is enabled automatically
when you left click on any component pin.

If some objects do not highlight when you hover over them with the mouse, right click on any
free spot on the design area to switch to the Default mode. If you want to delete a wire, right
click it to open the submenu, and select Delete Wire. To delete a wire segment, select

Delete Line from the same submenu. You can use the Undo to return to the previous state

of the circuit.

Now we will add resistance values "10kC2' for all resistors on this schematic. Since "Q'is a
Unicode character, it doesn't work in vector fonts, which are set by default in DipTrace. We
need to switch TrueType fonts for part markings in order to use the Unicode characters. Go
to "View \ Part Marking \ Font \ TrueType". Since TrueType characters look a bit different from
Vector ones, you might need to adjust the font size. We made it a little bit bigger (8 pt).

Notice that there are various ways to enter special characters. We recommend to copy
symbols from the Character Map ("Start \ All Programs \ Accessories \ System Tools \
Character Map" in Windows OS), and paste them in the DipTrace.
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Now select all resistors, then right click on one of them, and select Properties from the
submenu. Select the Main tab and type "47 kQ' into the Value field. Now click on the
Markings tab, and specify "Main Marking \ Show \ Value", and then specify "Additional
Marking \ Show \ RefDes", and click OK.
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As you remember, we took battery component from the Symbols library. All components in
this library don't have patterns, it's just symbols (pattern preview field on the Place
Component panel says "No Pattern”). But in order to proceed to the PCB layout stage you
should attach related pattern to this symbol. If left blank, DipTrace will not be able to show this
component on the circuit board and error dialog box will pop up.

Hover over the battery symbol, right click it, and select Attached Pattern from the submenu.
In the pop-up dialog box you can see the list of all components of current circuit in the left part
of the dialog box, make sure "B1-SOURCE_BATTERY?2" is selected (you see the battery
symbol in the preview field.

Select Patterns library group from the Pattern Libraries drop-down list on the right. This
library group contains all standard DipTrace pattern libraries separately from the symbols.
Select Misc library from the list and find BAT-2 pattern in the pattern list at the bottom-right of
the dialog box (use the search filters if you want). In most cases DipTrace automatically
assigns pin-to-pad connections according to the pad numbers, but this is not the case with
this battery symbol.

Positive pad is usually square shaped and negative is round. Click on the corresponding row
in the Pin to Pad Table, and type in related pad number in the Pad Number column (NEG
pin should refer to Pad #2, POS pin —to Pad #1).

You can visually set pin to pad connections, just left click on the pin in the symbol preview
field, and then on the corresponding pad in the pattern preview field.
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Press OK when ready to close the Attach Pattern dialog box.

Notice that some symbols in the libraries are intentionally made without attached patterns (for
example, VCC, GND or other logical connectors, Net Ports).

Our schematic is now ready to become a PCB. Do not forget to save the schematic, select
"File \ Save" from the main menu or click on the Save button or simply "Ctrl+S".

You can print schematic or save it in BMP or JPG file. To print in PDF, you need to install any
of the free PDF printers widely available online, and select it in the printer selection dialog
box.

Select "File \ Preview" from the main menu, in the pop-up dialog box customize the preview,
and press Print All to print all schematic sheets, or press Print Current Sheet to print
selected sheet, press Save to create a BMP/JPG file with defined resolution.

1.5 Converting to a PCB

You can open DipTrace schematic files (*.dch) in PCB Layout module, but if you want to
save your time, select "File \ Convert to PCB" or press "Ctrl+B" hotkeys directly in the
Schemaitic. In the pop-up dialog box you can use Schematic rules or load rules from any
other PCB layout file. When you press OK, the schematic will open in the PCB Layout.

Making PCE from Schematic E=ll In case of incorrect exit from the program or if you
® Use Schematic Rules somehow forgot to save the project, it is possible to
ST I T R recover the latest schematic by selecting "File \
e Recover Schematic" in the Schematic or "File /
o] ol Recover Board" in the PCB Layout module.
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Part Il:

2.1

If you want to hide the Design Manager to get more space on the design area, press "Ctrl+3"
hotkeys or uncheck "View \ Toolbars \ Design Manager" main menu item.

Designing a PCB

PCB Layout Ul

DipTrace PCB Layout main window includes: the design area, the main menu, toolbars,
Place Component panel, Design Manager with layers / objects / properties panel, and the
status bar.
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Design Manager

Hint area Design Area Cursor coordinates

You can place and edit different objects (components, ratlines, traces, copper pours, shapes,
tables etc.) on the design area. The main menu provides access to all common program
features.

Other interface elements:

Standard Toolbar — tools to work with files, cut / copy / paste objects, print, preview and
configure titles, launch 3D Preview, change scale and grid size.

Elements Toolbar — tools to switch to the default mode, measure, change origin, place
components, ratlines, pads, vias, mounting holes, copper pours, dimensions, and tables.

Route Toolbar —tools to create and edit traces, create board, run and setup the autorouter,
check design rules, select current signal layer.

Placement Toolbar — placement and auto-placement tools.

Drawing Toolbar — tools to create shapes, text, insert images, and select shape and text
placement layer.
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High Speed Toolbar — define differential pair, edit single trace of a differential pair, free
single trace editing mode, phase tune tool.

Place Component panel — select library, select component and place it on the design area.
Library groups, library tools, search filters, pattern preview.

Layers / Objects / Properties panel (active tab depends on current selected object / tool /
mode).

The Layers tab allows for working with layers (show / hide, add / delete / edit, change
position and layer color) and changing layer display mode;

The Objects tab allows the user to show / hide different objects on the design area and block
certain objects from being selected;

The Properties tab shows properties of selected tool / object and allows the user to change
them.

Design Manager — allows to quickly find any component or net in the circuit board, the same
as in the Schematic.

Design Manager 2 @ Sy .
R " Press button to see the list of components, or press button to

D5 - 1H4100

01 sl oo see the list of nets. Select component or net in the list, and all pins of
IEa-SNTAHE 2D selected component or net will appear in the list right below. Left click in
i vlactiee that list to highlight object, or double click it to pan the design area to
42-LINE_out - selected object.

Component Pins:

IC3: 2[F‘1.2.1‘F!><DW ]-RST -

IC3: 5 [P1.3/T=D1) =

IC3: 19 [F3.7/7RD] - Net 26 5 I:E . .

ICE P2 el Press | = Ito sort the list of components or nets alphabetically (useful
e when changing the RefDes array or adding new components).

IC3: 22 [GND] - GND

IC3: 1 (GND) -

Status bar — shows current hint to the left and cursor coordinates to the right.

Go to "View \ Toolbars \ ..." to hide / show any of the Ul toolbars (or use "Ctrl+1 through 9"
hotkeys). See DipTrace Help for details ("Help \ PCB Layout Help" from the main menu).

2.2 Preparing to route

The routing itself is one of the final stages of board design, but its quality greatly depends on
the preparation.

Right after converting to the PCB, the circuit looks chaotic. Press es button on the
Placement toolbar or select "Placement \ Arrange Components” from the main menu, all
components will be placed near the design center (blue line cross) and arranged according to
the placement settings.
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You can use Auto-placement or Placement by list features after converting to PCB. These
are very convenient and useful tools which allow the user to get advantages of both automatic
and manual placement modes. We will try to place components automatically in Part llil203 of
this tutorial with more complex circuits.

Component markings

Make sure that reference designators are visible. Select "View \ Component Markings \ Main \
RefDes" from the main menu, this command shows the reference designators of all
components, except those with individual settings. If marking's text location doesn'’t look
acceptable, you can justify it, select "View \ Component Markings \ Main \ Justify \ Auto" or
select another mode. To increase the size of the marking text, select "View \ Component
Markings \ Font \ 5pt” from the main menu. You can choose another size, but don't make it
too big.

For the PCB Layout we recommend vector font for most of the time. Switch to TrueType,
because only TrueType fonts support Unicode and non-English characters. Go to
"View \ Component Markings \ Font \ <Font Type>" from the main menu. Vector and
TrueType fonts look a bit different.

To define custom component marking parameters for selected components, right click on
one of them, select Properties from the submenu, then select the Markings tab in the pop-
up dialog box. Remember that you can use the move tool — "F10" or "View \ Component
Markings \ Move Tool". This option allows for moving and rotating (90 degree step) any text
object on the board.

Manual placement

Now place components manually, according to your preferences and design rules. It is a
good practice to keep power supply components in one area and functional blocks in another.
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Apply appropriate layout rules and differential signaling for high frequency circuits. Notice that
we use 0.05 inch (1.27 mm) grid, change it with a drop-down list on the Instruments toolbar.
Select "View \ Units \ Inch" main menu item to change the measurement units.

Create a layout similar to the picture below, with resistors at the top and LEDs at the bottom
of the board. Drag and drop components to move them on the board. Press "Space" or "R"
default hotkeys to rotate selected components 90 degrees. If you need to rotate to a different
angle, select component, then right click on one of them, and choose Define Angle or Free
Rotate for precise and visual rotation respectively.
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Press "F12" to optimize how connection lines visually appear on the screen (this does not
change the net structure).

Changing the net structure

We're going to practice in changing the net structure on the board, adding and removing
connections. Blue thin lines between pads show logic connections, these lines are called
"ratlines". Changing the net structure is not necessary for this board, but you should know
how to do it.

Hover over any pad with the mouse, right click it, and select Delete from Net, the pad will
disappear from the net. This pad is no longer connected with a blue line.
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You can create a pad-to-pad connections visually. Select "Objects \ Place Ratline" from main

N

menu or press button on the objects toolbar. Then hover the mouse pointer over
unconnected pad, left click it, and move your mouse to any other pad (connected or
unconnected), and left click it. A new wire or a new net (in case if both pads were
unconnected), represented as a thin blue line (ratline) will appear. To delete existing
connection, just select Delete Connection from the right-click submenu on the pad.

If you would like to add selected pad to some net without creating a connection visually on the
design area, hover over the pad with the mouse, right click it, and select Add to Net, then
select net from the list of all nets of the project or point it with the mouse cursor on the design
area.

However, the most convenient way to add, delete or rename nets, as well as add or delete
pads to/from the nets is the Connection Manager. Select "Route \ Connection Manager"
from the main menu to launch it. Connection manager is easy and friendly.
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Connection Manager Select net from the Net: drop-down list and you will see all
Net: - N Y pads of the net in the table, you can delete them anytime. If
Net Pads you want to connect some pad to the net, select component

Componpl pad and its pad, using the drop-down menus at the bottom of the

C1 (CAP100RP) 1 (PLUS)

QL (214401) 2(8) dialog box, and press Add button.
R1 (RES400) 1(A)

) [

If you have changed the net structure, please press Undo
until previous design is restored. Close the connection
manager. By the way, if you lose design or schematic
because of incorrect exit from the program, use "File \
Recover Board" in the PCB Layout and "File \ Recover

| beets | Schematic” in the Schematic to recover the latest project
Add to et version.

Component: B1 (SOURCE_BATTERYZ) R

To protect the net structure from accidental change, go to
"Route \ Lock Net Structure" from the main menu.

Pad: 1(POS) -

Add

G

Board outline

We haven't determined the board outline yet. If you will launch the autorouter, it will create an
appropriate rectangle board automatically, but in real life electronic designer usually has
certain board requirements well before starting the project. You can create relatively simple
board polygon directly in the DipTrace or import it from the DXF file (if the shape is complex).

Select "Objects \ Place Board Outline" or press = button on the Routing toolbar, then
place the board outline by left clicking the key points on the design area. Right click on the
final point of the polygon, and select Enter from the submenu or press "Enter" on the
keyboard. For this design we require a simple rectangle board near 2 inches in size, see the
picture below (notice that the origin point is hidden with "F1" hotkey).
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Notice that you can create arcs in the board outline by selecting Arc Mode from the right
click submenu while drawing the polygon.

You can insert new points into complete board outline polygon, or move each point or entire
polygon on the design area. Point coordinates appear as a hint when cursor hovers over it.

There is another way to create board polygon that does not involve drawing it on the design
area. Select "Objects \ Board Points" from the main menu.

Board == In this dialog box you can Add, Insert, and Delete key
Points points. Coordinates are shown and can be edited in
Elncremental absolute or incremental mode. If you check the Arc
2 D X1 Yoo =10 E checkbox for some point, that point will become a middle
AR S0 n point of an arc and the neighboring points will become the
A arc's first and end points. For rectangular boards, check
— Create Rectangular Board box and simply define the
— first point (base), width and height of the board. It is also
possible to make circular and rectangle boards with
cmplie | rounded corners automatically.
[] Create Rectangular Board
[Fl Create Gircular Board Press OK to apply changes or Cancel to close the dialog
[*] Create RoundRect Board box.
ok |[ concel | Notice that you can use "Objects \ Delete Board" from

the main menu if you want to delete the outline polygon.

Origin point

Correct board origin is important, because it is the reference point and beginning of the
coordinates for the circuit board. Bottom-left corner of the board outline is the best place. If
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you strictly followed the instructions given before in this tutorial, then you should see two blue
lines crossing exactly there. However, in the case you do not see the origin point or it is not in
the bottom-left corner of the board, select "View \ Origin" from the main menu or press "F1"

hotkey to show it. If the position is wrong, go to "View \ Define Origin \ By Mouse Pointer" from

the main menu or press + button on the Instruments toolbar, and left click on the design
area (DipTrace helps to target on the key points).
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Now all coordinates in the PCB Layout will be displayed and edited relatively to the origin. But
you can change the origin's position at any moment.

Notice that coordinates of components on the board are calculated by pattern's origin point. It
is defined in Pattern Editor. To show or hide origin of selected component/s, right click on one
of them, and select Pattern Origin from the submenu.

Board cutout

DipTrace allows the designer to create board cutout polygons. You can create cutout of any
shape, but we will create a simple rectangle cutout between LEDs and transistors just to
show you how to do this.

Select Board Cutout layer in the drop-down list on the
~]||005in  ~ % Baard Cutaut ~ drawing toolbar, then choose rectangle drawing tool,
AR @ HEOoe A &|tmm and draw a rectangle cutout on the board on the design
area. Pan, zoom, and change grid size for precise

A | e f::”ers drawing. Board cutout is now ready.
Q O ace ¢
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There is another way to create cutouts. Just draw a shape on any layer of the board or import
it from the DXF file, then right click on the shape, and select Properties from the submenu.
In the pop-up dialog box select Board Cutout from the Type drop-down list, and press OK.
Notice that board cutout does not visually differ from the board outline, you should be careful
not to place a cutout instead of an outline.

Route Keepout
Route keepout is an area on the board not intended for any copper. Autorouter does not draw
traces there, and the program will report errors if you draw them manually. Board cutout
shape does not have a clearance parameter like the board outline.
L7 e The route keepout around the board cutout will do the job.
ST This allows for the clearance between the copper and the
cutout. Since we plan to have copper traces only on the
bottom layer, select the Bottom layer with "2" hotkey, then
select Route Keepout layer in the drop-down list on the
Drawing toolbar, and draw a shape on the Bottom layer.
Create a rectangle which is a bit bigger than the cutout, like
on the picture to the left. Change the grid size to 0.025 in
for comfortable drawing. Then switch back to the top layer
(press "1" hotkey).
2.3  Autorouting

Now it is time to route the printed circuit board. DipTrace has high-quality shape-based
autorouter, and the Grid Router suitable for simple PCBs and single-layer boards with jumper
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wires. Our project can be routed on a single layer (usually it is a bottom one). Single-layer
boards usually have longer traces, but give many other benefits for prototyping. Longer traces
do not effect the project this simple.

Select "Route \ Current Autorouter” from the main menu, and choose Shape Router, it's the
best option for complex and simple designs (unless you need jumper wires). Go to "Route \
Autorouter Setup” from the main menu to set up the autorouter.

Notice that autorouter settings depend on selected router (different panels for different
autorouters).

In the Shape Router Setup dialog box (which is selected now) go to the Settings tab,
check Use Priority Layer Directions box, select Top in the list of layers, and set Off in the
Direction: drop-down list below. This means that autorouter will not create any traces on the

Top layer.
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If you want to route the board with jumper wires you need to select the Grid Router, and
check Allow Jumper Wires box in the Autorouter Setup dialog box. In our case we don 't
need that. Press OK to apply changes. Then select "Route \ Route Setup" from the main
menu. In the pop-up dialog box you can change the trace width and clearance between
traces for default net class and the diameter of vias for default via style. Route Setup
dialog box is the quickest way to change these parameters, but more complex projects would
require using several net classes and via styles. You can press All Classes... and All
Styles... buttons to access the respective dialogs. We will discuss Net Classes[471and Via
Styles[43] later in this tutorial.
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If you are new to DipTrace, we strongly recommend you to use the settings like on the picture
above for this tutorial project, it will help to avoid any misunderstandings and errors later.
Press OK to close this dialog box and apply changes, then change the grid size back to 0.05
inch.

Now it's time to route the circuit board. Select "Route \ Run Autorouter" from the main menu.
You'll get something like on the picture below. Your layout doesn't have to be exactly like the
one shown, so don't be confused if you are new to PCB design and some traces doesn't
coincide with the picture.

Notice that color of the traces depends on the layer color. We will change it in the next topic
of this tutorial.
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Automatic DRC

DipTrace has several verification options on different levels of PCB design. For example,
Design Rule Check (DRQ). It verifies object sizes, length/phase parameters of high-speed
nets, and clearances between different objects according to user-defined rules. The DRC
results in the error-report list. Violations are marked with red and magenta circles directly on
the design area. Design Rule Check in DipTrace operates in regular (offline) and Real-Time
modes. If Real-Time DRC is active, you've probably noticed some red circles while moving
components and creating traces. But it should be OFF by default, therefore we will discuss
verification procedures later.

Regular or Offline DRC (Design Rule Check) runs automatically after autorouting. This
project is very simple and you shouldn't get any errors, if there are some, make corrections
and relaunch the DRC by selecting "Verification \ Check Design Rules" from the main menu

DR
or press v button on the instruments toolbar. To change design rules, select "Verification \
Design Rules" from the main menu. To hide error circles on the design area, select
"Verification \ Hide Errors". To disable automatic DRC after autorouting, uncheck the
corresponding checkbox in the "Route \ Current Autorouter” main menu item.

Select "File \ Save" from the main menu, in the pop-up dialog box define the folder, type in the
name of the file and press Save.

Notice that now you can skip all topics till the Printingm, because your PCB is actually ready
to output, but if you want to learn some basic useful features of the DipTrace PCB Layout, we
don't recommend to skip those.
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2.4

Working with layers

The traces are in lower contrast, because they are on the Bottom layer of the board, while the
Top layer is active. We can see those traces because the Contrast layer display mode and
50% opacity between the layers are default settings.

Look at the Layers tab on the Design Manager (press "Ctrl+3" hotkeys if the Design
Manager panel is hidden). If you want to switch to another layer, double click it in the list or
press the corresponding hotkey (they are noted in the brackets next to the name of each
layer), or you can use "T" and "B" keyboard keys for top and bottom layers respectively. You
can also change active layer in the list box near the DRC control buttons.

We double click the Bottom layer in the list to activate it. Make sure you click on the layer
name (text) in the list, not on the blue check mark or elsewhere. Grey color is quite dim itself,
click on the colored rectangle right next to the Bottom layer and select red color in the pop-up
dialog box. Press OK to change the bottom's layer color to red.
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All layers are divided by two basic types: Signal layers and Non-Signal layers. DipTrace user
can easily add, delete, and edit both. Our project is a simple circuit board with two signal
layers: Top and Bottom. But as you can see in the list, there are much more of them. Assy,
Silk, Paste, Mask are non-signal layers. DipTrace creates them automatically on both sides
of the board (and gives corresponding names to each of them depending on their side of the
circuit board - Top Silk, Bottom Paste etc.). Each layer carries a special type of information.

Top / Bottom Silk are silkscreen layers, all texts and graphical information are automatically
added there. Top / Bottom Mask and Paste layers carry information about solder mask and
solder paste application zones. Some non-signal layers are necessary for correct board
manufacturing, the others provide additional functionality, for example, when drilling PCBs at
home. More information about each layer in the Gerber Output@ﬁ topic of this tutorial.
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Signal layers

Traces and copper pours can be created only on signal layers. There are two types of signal
layers: Signal and Plane. Signal layers usually contain traces and sometimes copper pours,
while Plane layers are inner (inside the board), they contain one or several copper pours.
Autorouter can create traces only on signal layers.

+ [ GOTom Sk
v - Bottam Assy
v - Board Outline

If you want to add, edit, create, or delete layer, go to "Route \

Layer Setup" or press button on the Layers tab on the
Design Manager. In the Signal / Plane tab of the pop-up

@ a, dialog box you can specify the name, type, color etc. of each
— . signal or plane layer. Notice that you can't change some
parameters for certain layers.

We will add a new plane layer called "Tutorial Layer" just to show you how it works. Press
Add button in the Layers dialog box, then enter the layer name, select type and color. Press
OK to create a new layer, now it appears in the list. Plane layers can be connected to one of
the nets, usually it is Ground or Power, in our case it is unconnected. You can also define a
single size for all pad rings on the layer. All pads on inner layers are round no matter what.
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Press the Close button to close the Layers dialog box, as you can see the Tutorial Layer is
already on the layers panel, between Top and Bottom layers.

PCB stackup

Create one more plane layer, because circuit boards should always have even number of
layers. Right click it in the list on the Tutorial Layer, and select Insert Layer, in the pop-up
dialog add new plane layer. Now when you right click on the plane layer in the list you can
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change the stackup, select Move up or Move down in the submenu to change the board
stackup. Click on the color rectangle to quickly change the color of the corresponding layer.
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Non-Signal layers

Customizable non-signal layers used for various
engineering purposes. They improve speed and total
convenience of electronic design in DipTrace. If you
need to create a non-signal layer, select the Non-
Signal tab in the Layers dialog box ("Route \ Layer
Setup"” from the main menu), then press the Add
button, enter layer name, select color and layer side:
None, Top or Bottom. None means that layer will not
be locked to some specific side of the board.

We do not need any custom non-signal layers. Close
this dialog box.

There are some quick-access buttons on the Layers

L]
tab of the Design Manager: ' _ add Layer,

Layer Setup, Contrast v layer display mode,

Remember to use 1,2,3,4 hotkeys to quickly change active layer.

Notice that in DipTrace you see the bottom layer of the circuit board like if it was transparent.
Pick "View \ Mirror" from the main menu to mirror entire circuit board. Now you see how the
bottom layer actually looks like. However, this is not necessary, because Gerber Export
automatically creates the correct copper layout on the bottom layer.

Delete non-signal layer if you have created one, we don't need them for this project. But do
not delete custom plane layers, we'll use them later for practicing with vias. Save the design.
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2.5 Working with vias

DipTrace supports through and blind/buried vias (if divided by physical properties). Vias are
also divided by two logical types that don't depend on their physical properties:

Trace Vias (regular vias), which are technically parts of the traces and appear automatically
when you move trace segment to another layer;

Static Vias (similar to pads), which are placed manually, they have much more variable
properties than trace vias.

All vias in the DipTrace, disregarding their logical type, are organized to Via Styles.

We don't need a lot of different via styles for current project, but we will add some in order to
teach you the basic principles of working with vias.

Let's create two additional via styles: one with blind/buried vias of the same size as the
Default via style (0.039 inch diameter and 0.02 inch hole), and the other via style for through
vias of bigger diameter. Go to "Route \ Via styles" and check if Default via style has
aforementioned parameters. Change them if you need. Then press Add button to add a new
via style. It will appear under the Default one. Left click it, and type in the name, change via
type to Blind/Buried, and specify the layers involved (top and bottom layer of the via). In our
case we make blind vias from Top layer to Tutorial Layer. Specify via properties like on the
picture below. Blind vias are impossible on printed circuit boards with only two layers, that is
why we did not delete tutorial layers from the previous topic of this tutorial.
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Now add one more through via style called "2 Tutorial ViaStyle", and enter 0.065 inch outer
and 0.03 inch hole diameters. Press OK.
Notice that we've changed the bottom layer color to violet.
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Trace vias

Now unroute one of the nets (we will route it manually). We have chosen the net that
connects resistors' pads with a battery.

Switch to the Bottom layer, then right click on the net that you want to unroute, and select
Unroute Net from the submenu. Go to "Route \ Manual routing \ Add Trace" from the main
menu or press the Tilde Sign (~) hotkey. Left click on the first pad (R1:2), then on the second
pad (R2:2) to create a trace. Now left click on the R2:2 again, but do not create a trace all the
way to R3 resistor. Just route it to some point between the R2 and R3, left click to set a trace
segment between the pads, then right click, and select "Segment Layer \ Top" from the
drop-down submenu (if you're routing on the bottom layer and vice versa). Trace via will
appear automatically, now we can continue routing on the opposite side of the board to
another pad, and then left click it. Create one more segment between the R3 and R4
components. Notice that trace color is defined by the layer color. Do not route entire net all
the way to the battery.

Start creating the trace heading from the R4 resistor. Select 2 Tutorial ViaStyle from the Via
Style drop-down on the Manual Routing panel on the Design Manager to apply selected
via style to the vias being created. Auto means that DipTrace will use a via style that takes
less space on the board, but in our case we select the style with a bigger vias (2 Tutorial Via
Style). Now create a trace via (go to the opposite board side) and finish the trace to the B1
component.
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Static vias

Press A button to place a new static via on the design area or you can make it directly
from the trace via, just right click on it, and select Convert Via to Static. Then specify which
vias to convert: Current via, Selected segments etc. Static vias behave almost like pads.
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If you change the parameters of some via style, all vias of that style, even those on the

design area, will change automatically.

We can change style, type, diameter of the static via and apply new settings to current or
selected vias or nets in the Via Properties dialog box. Right click on one or several vias, and
select Via Properties from the submenu, make some changes, and press OK. If there is no
via style with the parameters you've entered, DipTrace will ask if you want to create a new via

style.
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You can convert static vias back to trace vias, right click on the static via, and select Convert
to Trace Via from the submenu, and select which vias to convert. If you've placed a static via

directly on the design area, you can not convert it back to trace via.

Delete all vias and route the trace on a single layer, but do not use the Undo tool, because

this will delete custom via styles.

2.6 Net classes

All nets in DipTrace are organized to Net classes. Net classes allow the user to apply
numerous parameters to any net with a one click. Net classes work with manual and

automatic routing (Autorouters). Specify net class parameters before routing nets.

We are going to practice in working with net classes using the same project, therefore, we
need to completely unroute it first. Go to "Route \ Unroute All" from the main menu. Then
select "Route \ Net Classes" from the main menu to open the Net Classes dialog box. You
can see that only the Default net class is available and all nets belong to this class. Press
Add button and a new net class appears in the list of all net classes, right under the Default.

Left click it, and type in the name.
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In the Class Properties tab specify trace parameters and clearance value. In our case we
will make traces of a new net class significantly larger (0.03 in) with 0.05 clearance.

Notice that Star symbol (*) in the input field means that it is default value.

If you uncheck All Layers, the list under this checkbox becomes active, allowing different
trace parameters on different layers of the board. We don't need this now.

Uncheck Use All Styles checkbox in the Via Styles section, and choose which via styles you
want to use with this net class. Just press << and >> buttons to add or delete via styles to/

from the list of active. The E button allows the user to preview parameters of each via
style. We have allowed only custom via styles for this net class (see the picture below).

New net class exists, but it does not have any sense if no nets belong to it. So we're going to
add nets. In the lower-right of the Net Classes dialog box you can see the list of all project
nets and the name of current net class of each net in the brackets. In our case it is Default

net class. Select one or several nets with "Ctrl" key, and press the E button to add them
to the net class (Class Nets list right above).
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As you can see, the Tutorial NetClass contains one net (Net 6 in our case) with .03 inch trace
width.

The Clearance Details button allows you to set different clearances depending on the type
of the objects. Press Class to Class... to specify clearance between the nets of different net
classes. Class to class clearance is used by DRC and has priority over regular net class
clearances. Make sure Use Clearance in DRC item is unchecked, and press OK to close
the Net Classes dialog box and save changes.
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Autorouting with net classes

Now you have two different net classes, one net belongs to Tutorial Net Class and the rest —
to Default. It's time to route the board with autorouter, select "Route \ Run Autorouter” from
the main menu or press "Ctrl+F9" hotkeys and you'll get something like on the picture below.
As you can see, the traces on the PCB have different width, because they belong to different
net classes with different parameters.
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If everything is clear, unroute the board again ("Route \ Unroute All"), open the Net Classes

dialog box and reassign Net 6 from Tutorial NetClass to Default class (use the

button). Press OK, then launch autorouter again and you'll get the circuit board with all traces
of the same width. Tutorial NetClass still exists, but it doesn't do anything, because no nets
belong to it.

Manual routing with net classes

Select the Bottom layer, and left click on one of the nets (for example, Net 8 between the
resistors and a battery), you'll see the Net Properties panel on the Design Manager to your
right-hand side. In the Net Class drop-down list select Tutorial Net Class. Then right click on
the same net and select Unroute Net from the submenu. Now press the Tilde Sign (~)
hotkey to activate manual routing mode, left click on the first pad (R1:2), and create a trace to
another pad (R2:2), and left click it to create a trace segment. You'll notice that the trace is
much wider because it is in another net class.

Notice that DipTrace allows for changing net class of the routed net, but in order to apply
changes, the net has to be unrouted and routed again.
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We don't need that trace width diversity on the board. Please Undo ("Ctrl+Z") several times
or manually delete all custom net classes, via styles, and inner layers to get the layout right
after autorouting|ss.
Save the project ("File \ Save" from main menu).
2.7 Manual routing

Simple projects like ours can be routed automatically, but for complex boards manual routing
is a must. Actually, the entire board can be routed manually, but because of low speed of
manual routing usually a combination of two methods is the best choice for complex projects.
This allows the designer not only to get a well-working prototype, but to succeed in
reasonable terms. Critical nets are routed manually and the rest — with autorouter.

Our simple board is already good enough, but we're not done with practicing yet. Moreover,
sometimes you may need to correct traces after the autorouter.

Editing modes

You should already know how to create traces — select "Route \ Manual Routing \ Add Trace"

from the main menu or press > button, then left click on the first pad to start routing, and
click on the next pad to create a trace. Just make sure that correct layer (Bottom) is
selected.

Editing traces is a bit different. Press Al button or simply left click on the trace and drag &
drop trace to another location. The Edit Traces mode allows the user to move traces with 45
or 90 degrees angles. This is very convenient for almost any design, but sometimes you
might need traces editing tool with more capabilities. Go to "Route \ Manual Routing \ Free
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>

Edit Trace" from the main menu or press
traces without any restrictions.

button on the Route toolbar. Now you can edit

Don't forget to change the grid size (with the 008in  ~ drop-down on the Standard toolbar

or "Ctrl+Plus Sign" and "Ctrl+ Minus Sign" hotkeys). To configure the list of available grids,
select "View \ Customize Grid" from the main menu. "F11" hotkey hides or shows the grid on
the design area.

Remember, if you don't knowwhich tool you are working with, right click a couple times on a
free spot on the design area, and DipTrace will return to the Default mode.

Nodes

Any routed net is divided to traces (often called "tracks"). Trace is the copper track between
two pads of the net. Trace (track) consists of segments. Segment is the route between two
nodes. Node is a point on the route, which divides a trace to segments (red dot and a small
square on the picture below). Designer can move existing nodes, add new ones or delete
them. This gives more opportunities while editing traces. Left click on the trace segment, and
press "N" hotkey to add a new node in selected place, then select it, and move to some point
outside the board outline (Free Edit Mode on the picture below).
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If you don't need some node any more, you can delete it — right click on the node, and select
Delete Node from the submenu. In the same submenu you can change the name, color,
width, and the layer of the net, trace or segment etc.
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Manual routing offers greater opportunities, but with more chances to commit an error.
Fortunately, the DipTrace has Real-time Design Rules Check which verifies board in real
time and enables the user to see errors before actually making them. We will have a detailed
discussion about DRC later[73).

Real-time DRC

Let's turn ON Real-Time DRC and continue. Go to "Verification \ Design Rules", in the pop-up
dialog box check Enable Real-time DRC, then select the Real-time DRC tab, and check
Manual Routing and Moving Objects options (if not already selected). Press OK to close
the Design Rules dialog box. You can see that two red circles have appeared at the points
where the trace crosses the board outline, these circles shows errors.

Now select a random trace and intentionally move it too close to another trace or object. Red
circles report a clearance error before you place the trace to a new position, the same
happens when you move objects or edit components if the corresponding items in Real-time
DRC tab have been checked.
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Notice that we have hidden the grid on the picture above ("F11" hotkey) for more precise
editing.

Now return the trace (between R3 and R4) to its initial position.
Change layer

DipTrace allows you to move existing net (trace or trace segment) to another layer, right click
on the trace segment of the net, and select "Segment Layer \ Top" or use the Segment
Layer drop-down list in the Net Properties panel on the Design Manager. Two trace vias
appear automatically. You can choose several segments of the same or different nets with
"Ctrl" or "Shift" buttons and change their properties at a time.
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Now return that segment back to the Bottom layer, and select the bottom layer on the Design
Manager.

Manual routing panel

It's time to practice more in the manual routing. Right click on one of the nets, and select
Unroute Net from the submenu. We have selected Net 8, but you can choose another one.
The "Unroute Net" command from the net submenu applies to all selected nets. Then press

> button on the Route toolbar. Manual Routing panel is on your right-hand side (Design
Manager panel). Do not try to change the net class of existing net in there, net class should
be defined in the Net Properties or Net Classes dialog boxes before routing.

Notice that you cannot change the net class of existing net in the Manual Routing Panel.
This change will be ignored and applied only to the new net. Don't forget that net exists not
depending on whether it is routed or unrouted.

Fortunately, we have only one net class to avoid confusion and concentrate on the subject.

In the Route Mode drop-down list (on the Design Manager) we can specify the group of
trace segments that we are going to need for routing, therefore, we will be able to select
current segment not from the list of all segments but from the list of segments of one mode.
Custom route mode is available.

Select the Arcs/Curves route mode, then left click in the Current segment field and select
3-point Arc. Left click on one of the pads of unrouted net (this will be the first point of an arc),
then left click on some point between the two pads higher than the blue connection line (this
is the second point), like on the picture below.
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Then move mouse arrow to the second pad, and left click it. You will see an arc.
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On the Manual Routing panel you can choose highlighted nets. If you highlight only current
net — no other nets will glow, even if you'll touch them with the new trace.
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You can undo by pressing the "U" hotkey while routing. Notice that there are hotkeys that will
make manual routing really easy and quick.

"M" — switch between routing modes,

"S" or "Space" — change current segment,
"W" — set trace width,

"T" — switch to Top layer,

"B" — switch to Bottom layer,

"L" — segment layer,

"J" — switch to jumper wire or back (if you are in Bottom layer, jumper will be placed to Top
and vice versa),

"A" — angle step,
"H" — highlight net,
"1" —"0" in the top of keyboard — switching between layers (up to 10).

Go to "Tools \ Hotkey Settings" from the main menu to view and change the hotkeys. Refer to
the PCB Layout Help document ("Help \ PCB Layout Help") for more details about custom
keyboard shortcuts and manual routing.

Now please Undo ("Ctrl+Z") several times or change the layout to the state after autorouting
(no net classes, via styles, new layers etc.).

Measuring trace length

DipTrace allows for easy and convenient trace measuring. Current project is simple,
therefore we don't need to use this tool, but if you design high-speed circuits with differential
pair signaling, trace length becomes very important .

Notice that hint of each trace already includes its length.

Please select several traces (you can use box selection or "Ctrl" button). Right click on one of
selected traces, and choose Show Trace Length from the submenu.
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You will see the small boxes with trace length values near all pads of selected nets, they are
also highlighted when hovering over the trace with a mouse cursor. Values are in current
measurement units (inches in our case), they change in real-time when you edit the trace.
Notice that in some situations you may be unsatisfied with current color. Trace color depends
on the layer color.
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Now please hide the trace length boxes, using the net submenu (select the same item) or
Undo tool.

Selecting objects by type /layer

Sometimes it is necessary to select all objects on one layer or exclusively components, nets,
vias etc. With current layout it is very easy to achieve visually with the mouse and "Ctrl" key,
but what if the layout is very complex?

Select "Edit \ Edit Selection" from the main menu.
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Check Components item, and click OK — all components are selected now.

Let's make it a bit harder and model a real-life situation, when we need to select only
unconnected vias in the predefined area of the board.

First of all deselect components with a right click on an empty spot. Then place several static
vias and connect only some of them to nets randomly, while leaving a couple of vias

unconnected. Use "Objects \ Place Static Via" from the main menu or A button to place

vias and "Objects \ Place Ratline" or ™ button — to create connections visually. Left click
on the via, and then left click on the pad to add via to the pad's net.

Now define selection area using the box selection. This box represents an area where we
plan to select unconnected vias so we will not include all vias of the layout to this selection.
Notice that we are on the Bottom layer, where we have all the traces.
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All objects in the box are selected. We need to extract only non-connected vias from the
selection. Open "Edit \ Edit Selection" dialog box, choose Mode: Keep Selected, check
only Vias checkbox (other boxes should be unchecked), and then select Not Connected
from the Vias drop-down list. Click OK and only unconnected vias becomes selected.

Next step could be connecting these vias to some net, all at a time. In real life this can be
used to connect ground net to plane / copper pours. Right click on one of selected vias (it
should be highlighted in red), select "Add to Net \ Selected Vias" from the submenu, and
specify the net in the pop-up dialog box.
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Choose some net from the list, and click OK. All vias will be connected. Remove all static
vias from the board and return the circuit board to the previous state (select all vias and press
"Del" key) or Undo.

2.10 Placing text and graphics

With DipTrace you can add texts, shapes and logos in BMP, DXF, or JPEG formats directly
on the board and export them to Gerber.

Select the layer where you're going to place graphics, usually it's a silkscreen layer (Top Silk
in our case), double click it in the Layers tab of the Design Manager panel.

PCB Layout allows the user to change layers with two drop-down lists on the Instruments
toolbar and in the Layers tab on the Design Manager panel.

Drop-down list on the Drawing toolbar allows you to select any non-signal or Signal / Plane
layer for placing graphics. If you have selected Signal / Plane layer, all shapes, texts and
logos will appear on current signal/plane layer, which is specified with the drop-down list on
the Route toolbar.
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Let's make the board polygon a little bit bigger to place additional text at the top. Drag and
drop upper-left and upper-right vertices of the board outline a little bit upwards. Make sure you
click on the vertex point not on the outline. DipTrace makes visual editing very easy with

appropriate grid size
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You can move the board outline. Left click on the line (not the vertex), then drag and drop it.

Remember that if you can not highlight and edit certain objects, probably, you are not in the
default mode. Therefore, right click on a free area to cancel current mode. Objects located on
inactive layers of the board can't be edited (unless you are in Contrast Edit layer display
mode).

Press button, left click where you would like to place text, type in the text, and press
"Enter" to finalize.

Use the mouse to move text around the design area until you'll find a good location. When
text object is selected, font settings, font type (Vector, TrueType), and text layer can be
changed in the Text Properties tab on the Designh Manager, or with the right click
submenu. Use vector font, because it is directly exported to Gerber. For Unicode and Non-
English characters select TrueType fonts, however, these export to Gerber as small lines
(created by a special recognition algorithm).

Some PCB manufacturers do not accept TrueType text objects in copper layers.

© 2016 Novarm Software



64 DipTrace Tutorial
< PCB Layout - [D:\Tutorial_2016.dip] =N
File Edit View Objects Placement Route HighSpeed Verification Library Tools Help
DD"‘EI|§@30‘3€.E-O |QQ@293%vD.DSinv = s [ Topsik - @‘59%:;5|
[B]lm + | @ osce - 84| . 0 A @ BE |/ 8 ~&xE|)|v & wa - <&
Place Component 1;::::: ..::...::........::::':':EAW
Components |4 R FE T S Text:
Alegro AN ew Boarde o niiriiiini s | [y Top Sk~
Altera D AP D D "New Board" DA Layer: Top
Analog Devices REREEEEEE RS £ Lock Selected Ctrl+L [ her: one
Atmel T, e Font Type: Vector -
Burr-Brown il o o e & Font: [—
Cumenes B AU I IS [ Ctrl+X
Library Tools Bl . ED L &VD R 2 Copy —
Fiter Off » &y X Delete Del
AM27C256-150EBL2 - Font Type v | Vector
AM27C256-150ED3 : B I Font.. TrueType
AM27(C256-150EL2 R, o S P Properties... § o
mgggggg}gﬁg oA e e
e | ey G ()| | e e @
R ::::::::,:::::*.::::::::: “:| [81-soURcE_BaTTERY2 n
AM27C256-155CBD3 R ol R Y DO C1 - CAP100RP
AM27C256-155CBL2. |-~ - - oo | e E i
ey RESSERSE B oot Bl | (R e
Sxtaxd. SRR B o me]) ) gz |

,|||i|||1 CUli ol st compenent Ps:

= = :: :3_,: o @

=111t S I .

Top Silk X=11lin ¥=22in
Text object is on the silk layer, it inherits the layer's color. If you need to change the text color,
move the text object to the Top Assy layer and then change Top Assy color.

You can change layer of the graphics and text object any time. Select graphic object, right
click it, and select Properties from the submenu. In the pop-up dialog box select another
PCB layer in the Type field to move object to another layer or define different properties (for
example, create a route keepout used for autorouting, etc.). In our case we just leave that text
on the Top Silk layer.
Notice that you can add shapes to mask, paste, signal, route keepout and board layers.
These properties can be defined on the Drawing toolbar or in the Shape Properties dialog
box.

2.11 Copper pour

Copper Pour is used as a low-impedance conductor for Power and Ground nets. Pours are
usually located on inner layers of the board, but can be placed on top and bottom sides as
well.

Place copper pour

Change the grid size to comfortable 0.025 inch. Select the Bottom layer, then go to "Objects \

. -]
Place Copper Pour" from the main menu or press % | hutton on the Elements toolbar. Now

you can draw a copper pour polygon borderline by defining its key points on the design area,
then right click on the last polygon's point, and select Enter from the submenu to finish
drawing. We need a copper pour that covers the entire bottom layer of the board. You can
draw a precise polygon manually or create a random shape (for example, like on the picture
below) and use the Depending on Board feature which will pour the entire layer automatically
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(regardless of the initial shape). When you select Enter from the submenu, the Place
Copper Pour dialog box pops up.
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This dialog box has three tabs: Pouring, Connectivity, and Border.

Pouring tab allows you to specify different non-solid fills for the copper pour, clearance width,
line width, line spacing, island removal options, pour priority, and current state (poured or
unpoured). You can also apply net clearances as copper pour clearances by checking the
corresponding item. DipTrace has shape-based copper pour system.

Connectivity tab — here you can connect copper pour to the net, select thermals and change
their settings. DipTrace supports separate thermals for SMD pads. The Hide Net Ratlines
regime can automatically show ratlines only for unconnected traces or other if specified.

Border tab allows you to define the border points and build the copper outline automatically.

Check Depending on Board checkbox and keep all other settings like on the picture above.
The Snap to Board checkbox means that copper pour will resize depending on the board
outline. Click OK to place a copper pour.
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Board outline clearance specified in the copper pour settings is not applied to board cutouts.
Always use route keepout to allow for a certain clearance between the copper pour and
cutout, like we did before.

Copper pour can be in two states: Poured and Unpoured. The second state is often used for
editing, because only the copper pour border is visible. To change the copper pour state right
click on the copper outline (not on the copper pour's body), select State from the
submenu, and choose the item you need.

As you can see, we have a copper pour, but it is not connecting any net. Now we will practice
and connect two different nets using two copper pours on the Bottom layer. Copper pour
priority option will help us to achieve our goal.

Connect copper pour

Unroute one of the nets (for example, Net 8 which connects resistors to the battery), right
click on the trace, and select Unroute Net from the submenu. Remember the net name ("Net
8"). Right click on the copper pour border, and select Properties from the submenu. Go to
the Connectivity tab, and select Connect to Net: Net 8, then select appropriate thermals
(for example, 4 spoke), and press OK to update the copper pour.

Notice that you should click directly on the copper pour border (not on the copper body or the
board outline) in order to open copper pour properties dialog box.
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You can see that connection lines (ratlines) are hidden now and the net (Net 8) is connected
to the copper pour with thermals of selected type (4-spoke thermals).

Now we will place the second copper pour. Select another net that we will connect with a
copper pour (for example, Net 3 that connects R3:1, C1:2, and Q2:3) and unroute it, then
right click on the edge of existing copper pour, and open the Copper Pour Properties
dialog box. Select Current State: Unpoured, but do not close this dialog yet.

Pour priority

Now it's time to change pour priority for existing copper polygon. Specify: Pour priority: 1 in
the Pouring tab.

You can enter any value, depending on how much copper pours you plan to have on this
layer. Lower value means higher priority, therefore copper pour with Pour Priority: O will have
higher priority than Pour Priority: 1.

Notice that two different-net copper pours with the same priority level will intersect. Real-time
Design Rule Check will show numerous errors in this case.

Press OK to apply new settings. Notice that in unpoured state ratlines are displayed
automatically. Unroute Net 3, then select copper pour placement tool ("Objects \ Place
Copper Pour"), and draw the second polygon that covers pads of the Net 3, like on the picture
below.
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In the pop-up dialog box connect the second copper pour to Net 3, and specify the thermal
type (4 Spoke should be fine). Press OK to close the dialog box and create a copper pour

polygon.
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Now select Net 8 copper pour, which is unpoured now. Right click on its border, and select
"State \ Poured" from the submenu. You will see that two copper pours connecting two
different nets are independent and Net 8 copper changed according to the Net 2 polygon
which has higher priority level.
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Thermals

Some pads require custom thermal connections that will be different from the copper pour's
thermals. Right click on the pad (when the pad is highlighted), and select Thermal Settings
from the submenu, then check Use Custom Settings checkbox, and select a new thermal
connection.

Some pads can become unconnected after placing a copper pour, because of selected
thermal type and the layout structure (net connectivity check will report this), so selecting
separate thermal settings for pads will help you to fix those issues.
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After changing thermal settings click OK to close the dialog box, then right click on the copper
pour border, and choose Update from the submenu to see these changes applied.

Select "Objects \ Update All Copper Pours" from the main menu to update all copper pours at
atime.

We'll try different thermals for pads to show you how it works.
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On the picture above you can see that one pad has 4-Spoke 45-degrees thermal, another
one is connected directly, and the third pad has 2-spoke 90-degrees thermal connection.

When the copper pours are used as Ground and Power planes, SMD

vias usually connect to them by fanouts. You can create fanouts
manually with the Fanout12 feature or automatically by Shape Router
381,

We have decided to remove all unconnected parts of both copper
pours. Go to the Properties of each copper pour and check
Unconnected item in the Island Removal section of the Pouring
tab. Press OK. Save the project.

2.12 Locking objects

Sometimes while making changes to the schematic or PCB, you need to lock some objects
so you don't change them accidentally. Let's see how to do this in the DipTrace.

Switch to the Top layer, select several objects, right click on one of them, and click Lock
Selected from the submenu.
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Notice that locked objects have their selection rectangles in lower contrast (in our case color
is similar to the copper pour, so we've made only current layer visible (with the drop-down list
on the Layers panel). "Locked" text appears in the hint of the locked objects, you are unable

to move, resize or edit them without unlocking first.
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2.13
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Now please unlock all objects, select all with "Ctrl+A", and unlock ("Edit \ Unlock Selected"
from the main menu or "Ctrl+Alt+L" keyboard combination).

You can lock components after placing them on top or bottom side of the board. Select "Edit \
Lock Components \ Top" to lock top components. Using this mode you can do the routing
and not worry about accidentally changing something. Select "Edit \ Unlock Selected" from
the main menu to unlock components on the board, then return to the contrast layer display
mode using the drop-down on the Layers tab (Design Manager).

Design verification

DipTrace has several verification procedures united in the Verification main menu item. We
recommend to use all three of them: DRC, Net Connectivity Check, and Compare PCB to
Schematic.

DRC (Design Rules Check)

This feature is one of the most important verifications. It allows the user to check clearances
between the objects, allowable object sizes, and differential pair parameters according to the
set of design rules. DRC works in regular (offline) and real-time modes. Real-time DRC
checks all user's actions on the go. For example, when you move some component or create
a new trace too close to another object, Real-time DRC shows red circles, which mean that
the clearance between these objects (trace, pad, copper pour) is smaller than specified
target value. If Real-time DRC is completely turned OFF, you would not see errors until you
start DRC manually in regular mode by selecting "Verification \ Check Design Rules" from the
main menu or by pressing the "F9" hotkey. Error list or "No Errors Found" message will pop
up. Most likely current PCB doesn't have any errors, because it is very simple.

Now select "Verification \ Design Rules" to setup design constraints. There are four tabs in
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the pop-up dialog box: Clearances, Sizes, Real-time DRC, and Options.

Clearances. Specify object-to-object clearances. Uncheck All Layers item, select layer from
the list below, and define object-to-object clearances applicable on particular PCB layer.

Notice that clearance settings are NOT applied to nets with custom net class clearance (Use
Clearance in DRC option in Net Classes|47]dialog box is checked) or Class-to-Class
settings.

Sizes. Specify minimum and maximum allowed sizes for different objects on different layers.

Real-time DRC. Customize real-time DRC. You can turn it ON/OFF for specific actions, for
example, manual routing, creating / editing, and moving objects. If you uncheck Enable Real-
time DRC item, real-time verification will be completely turned OFF. But if you uncheck all
secondary items in the corresponding tab, and leave only Enable Real-Time DRC item
active, you will see errors right after completing a certain action, not while performing it. For
example, if Moving objects item is checked, you will see errors before moving component
to a new location, if this option is unchecked — you will see errors right after moving it, still no
need to launch DRC separately. If Enable Real-Time DRC is unchecked, you would not see
any errors, unless you start DRC manually.

Options. Setup other options.
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For this tutorial example, please turn OFF the size verification and Real-time DRC by
unchecking the corresponding items. Make sure that Check clearances and Show a list of
errors... checkboxes are checked. Keep settings like on the picture above (these values are
quite small, but still within technical capabilities of most PCB houses).

Open the Options tab and make sure that Class-to-Class Rules, Trace by Length, Copper
Pours, or whatever objects you want to be verified are checked. Now lets try to see how DRC
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works in regular mode. Even if the real-time DRC was ON during the design process, we
recommend to verify project with regular-mode DRC at least once before exporting to
Gerbers, just to make sure that everything is fine. Press OK to apply changes and close the
dialog box.

Our project does not have errors, therefore we will create them intentionally. Select Bottom
layer ("B" hotkey), switch OFF the grid ("F11" hotkey), and move some trace until it touches
the copper pour or another trace. Go to "Verification \ Check Design Rules" or just press "F9"
hotkey to launch DRC. The list of errors will pop up automatically.
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Errors can be sorted by layers. You can see the description of each error including current
value and target value. Left click on the error in the list and DipTrace will show where to
change the target constraint in the Rule Details section. Press Localize to see selected error
on the design area and fix it. Red circle means a clearance error, magenta circle — size error.

Move trace back to it's original location without closing the error-report dialog, and then press
Run DRC button. This time everything is good and No Errors Found message appears.

Net connectivity check

This verification allows the user to check if all nets are properly connected. For such simple
design this feature is not necessary, but if you have larger board with many layers, pins,
copper pours, and shapes, net connectivity verification becomes really useful. It checks entire
design and displays the list of broken and merged nets. Please select "Verification \ Check
Net Connectivity" from the main menu, and click OK in the pop-up dialog box. Most probably
your design will not have connectivity errors and you will see the No Errors message. More
information about Net connectivity checkkool.

Comparing to Schematic
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2.14

This procedure allows you to check if PCB corresponds to the source Schematic file.
Verification shows the net structure errors and unknown components. Select "Verification \
Compare to Schematic" from the main menu then choose source Schematic file, and press
OK. If your net structure was not changed and has no errors, you will see the "No Errors
Found" message, otherwise the list of errors will pop up.

Net connectivity check and Comparing to Schematic features work fast and provide an easy-
to-understand user interface with reliable functionality.

Layout information

How about counting the number of pins or the board area? Select "File \ Layout Information”
from the main menu in the PCB Layout module.
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Here you can preview the number of different objects, layers, board and hole sizes. Press

B button in the Holes section to open the Holes by Size dialog box. Press Show on
Board button to highlight holes by size directly on the design area.
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2.15
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Close the dialog box, and save the layout.

Panelizing

With DipTrace you can panelize similar or different boards on a single layout.

Panelize p

roject

If you need several copies of the same PCB, select "Edit \ Panelizing" from the main menu.

© 2016 Novarm Software




78

DipTrace Tutorial

@ PCB Layout - [DA\Tutorial_2016.dip] ===
File Edit View Objects Placement Route High Speed Verfication Library Tools Help
O w |§ [& EID‘ [ Ns) |Q & O 242% - | 0.0250n v | = Top Assy . @‘ 2% |
bowm o+ |8 oese - #|N o0 a0 RS SE NNE¥E»E|YE 0 - o£ea
Place Component 4 i m
Components >
Panelizing @ “, - Top Assy
Allegro - + Il Top sik
Altera Columns: 2 = + Top Mask
AMD | : =
. e New Board - + Il Top paste
Analog Devices 4 Rows: 2 v T
Atmel - i o
Burr-Brown X Spacing: 0 in + I soteom @
Fomvnnn % fo] fo) o o) - . ) + I sottom Paste
Library Tools » VT n + Bottom Mask
— [yl g | ;
Fiter Off » a:l:| D’:|:| D':|:| a:l:| [¥] Show Panel Border v - Bottom Sik
+ - Bottom Assy
AM27C256-150EBL2 ~ o o <o = Left: 02 in | | + Il 5oarc outine
AM27C256-150ED3 ) m
AM27C256-150EL2 Right: 0.2 i ~ Contrast - m
AM27C256-1501BD3 — 01 0z cl &2 Top: 0.2
AM27C256-1501BL2 ’ i : _
— D M £
© @ |o. ol e af@s
AM27C256-15011 2 + v B1 - SOURCE_BATTERY2 -
AM27C256-155CBD3 Panel Size C1 - CAP100RP [
AM27C256-155CBL2 _ Bl _ _ i TanoRe H
AMITOICE 4 CEEND Width: 4 in LED? - LED —
RLCC-32/11.5x14x1.27 Height: 54in Q1 - 2N4401
Q2 - 214401 -
H = 8 Component Pins:
M ﬂ 5
- -
- -
- -
- -
RLITIE _ -
“ »
X=0.548 in ¥=2771in

We will make 4 copies of this circuit board, 2 columns and 2 rows. Spacings between the
boards will be zero. Showing the panel border may help us to determine the approximate
PCB panel size. Board to panel border distance (sometimes called "rail edges") will be 0.2 in
for all sides. Some manufacturers need panel border in the board outline layer, so we will
also check the Show Panel Border checkbox. Click OK.
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We can see only boxes with "Copy #" text on the design area, but in the Print Preview dialog
box ("File \ Preview" from the main menu), while printing or exporting to manufacturing
formats, you will see a final layout.

It is possible to exclude some objects from panelizing (for example, holes or shapes). To
exclude any object from panelization, right click it, and check Do Not Panelize. This item is
available only if Panelizing is active.
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Notice that panelizing works only if PCB has a board outline.

Now open the Panelizing dialog box and change the number of columns and rows to "1" to
remove copies and let us practice with panelizing different boards on a single layout.

Panelize different projects

Check "Edit \ Keep RefDes while Pasting” item from the main menu, then select all objects
("CtrlI+A") of your second layout, and press "Ctrl+C" to copy them, then right click on empty
spot on the design area (this will be an upper-left corner of the second board), and select
Paste from the submenu.
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We got the second copy of our PCB (but it can be a different PCB if you want). Reference
designators will not change.

Notice that you need to create a common board outline, board cutouts and additional non-
signal layers may be required for correct manufacturing.

If Keep RefDes while Pasting item is checked, pin limitation of your DipTrace edition (Free,
Lite, Standard, Extended) does not apply, so you can easily panelize several 300 pin layouts
even with DipTrace Freeware.

2.16 Printing
We recommend to use the Print Preview dialog box to print PCBs, select "File \ Preview"

from the main menu or press & button on the Standard toolbar. Notice that we didn’t
describe creating titles in Designing a PCB section of this tutorial. If you want to display
titles, select "File \ Titles and Sheet" from the main menu, and select ANSI A in the Sheet
Template drop-down list, then check Display Titles, and close the dialog box before opening
the Print Preview dialog box.

More detailed information about Titles and Sheets as well as creating and editing titles with
the Title Block Editor in the DipTrace Help ("Help \ PCB Layout Help" from the main menu).

Use Print Scale drop-down list or Zoom In / Zoom Out buttons to change the scale of the
layout on the sheet and press ('1') button to move design on the sheet.

In the upper-left you can select current Signal/Plane layer and layer display mode. If you want
to get a mirrored PCB and/or text, check Mirror and/or Flip Text checkboxes (the Flip Text
box is disabled if "View \ Flip Text Automatically” main menu option is ON).
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Press Print button to print the layout. Press Save if you want to save image in BMP or JPEG
file. Small button with colors to the left from the "Zoom Out" tool allows the user to define print
colors ("View \ Colors...\ Print Colors" from main menu).

Notice that only layers with default color depend on the color scheme.

For printing all in black and white without changing layer colors, check Print in Black only
box.
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Layers P Seale: 99% - [ Pt |
Current: Top - —

A Flip Text Print Scale: 244% w .| | Save... |
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For hobbyist's attention. Be aware that laser printers often introduce some degree of
dimensional distortion due to heat expansion of the paper. It depends on your laser printer
and the quality of the paper used. For most people it's not important. However, one way to
cope with this issue is to preheat paper by running it through the printer, without printing on it
(for example, you can print just a dot in the corner). For ink-jet printers this is not the issue,
since ink-jet technology does not heat paper. Laser printers do not always distort image
visibly, but you have to be ready that this can happen. You can use the Calibration feature in
the Print Preview dialog box to minimize heat distortions.

There are two methods of prototyping a PCB at home: using a TT (Toner Transfer) or UV
exposure. TT is definitely a method for a laser printer and UV exposure is better with ink-jet
printers.

Close the Print Preview dialog box and Undo several times to remove the second PCB and
return the board without panelization. Then save the layout.
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Part lll: Generating files for manufacturing

3.1 DXF

DXF output allows for exporting data to many CAD / CAM programs which support DXF
import (AutoCAD and others).

DXF export

To export the circuit board to DXF format, select "File \ Export \ DXF" from the main menu,
select layer from the list of all layers, and check / uncheck the corresponding boxes to show /
hide different objects on this layer (text, pictures, vias, etc.). Setup the offset (distance
between zero and the bottom-left corner of the board: design origin or custom value), mask
and paste layers if needed. You can save each layer into a separate DXF file, but in order to
export entire board into a single multi-layer DXF, press Select All button.

Notice that "Edge_Top" and "Edge_Bottom" are not selected. Technically these are not the
physical layers of your circuit board. They are exported only if you are going to manufacture
the board with milling method.

Press Export button, specify the name of the file, location, and save the circuit board into a

DXF file.
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All layers of the board will be exported into a single DXF file. You can open it with AutoCAD or
another program that reads AutoCAD DXF.

Export for milling (DXF and G-Code)

Milling method is convenient and cheap for non-complex boards.
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3.2

Notice that copper pours (unlike thermals) are not considered, when exporting edges for
milling.

Select "File \ Export \ DXF" to open the DXF Export dialog box, then select Edge_Bottom
layer, because all traces of our PCB are on the Bottom layer (if you have traces in top layer,
select Edge_top), check Mirror checkbox to mirror the design (for the bottom layer). This will
allow us to see the actual bottom side of the board. You can leave default values if you're not
familiar with specific milling settings or define the Edge Width parameter. Center line of the
milling will be calculated as a half of the Edge Width value. Milling depth depends on the edge
width and the instrument angle.

Press Export button, and save the DXF file.

=>l§Snlld\'ﬁ"nrkseDrawmgs-[a:tahla_edgedxf] = @
(85 File View Tools Window Help — b
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The edge exported from the DipTrace is a set of polylines with defined width. DipTrace
checks design before export and if object-to-object clearances are less than the edge width,
DipTrace shows the warning message and enables designer to correct the errors.

Notice that CAD programs usually show polylines with sharp angles, therefore picture can be
slightly different, but when you mill the board or simulate milling with CAM program,
everything will look a bit different, because of the instrument radius.

CNC drilling machines work with G-Code files. Convert your edge from the DXF format to G-
Code, using ACE converter, FlatCAM (both are free), or another software.

Please Undo several times to return the copper pour if you deleted one.

Gerber RS-274X

DipTrace allows the user to export the circuit board to Gerber format, accepted by almost all
PCB manufacturers around the world.
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Select "File \ Export \ Gerber..." from the main menu. In the Export Gerber dialog box you
need to select layers which you are going to export (use "Ctrl" and "Shift" for multiple
selection), specify which objects will be exported to Gerber for each layer (select layer from
the list and use the corresponding checkboxes in the Objects section).

@ PCB Layout - [D:\Tutorial_2016.dip] (===
File Edit View Objects Placement Route High Speed Verfication Library Tools Help
DD”H|§I§SD‘ Enn|@Q@22D%vD.D25inv @ sec [F Top Assy . @‘gg |
[B]lm + | @ osce - 84 . 0 a0 BE |/ @8 ~&xE| )|y & wag - <&
Place Campanent 4 Export Gerber RS-274X [:5] [ Layers [Objects | proparties|
Components Layers:
b > TZD Assy i [ Fil | [ apem ] LM Top Ay
- lles ertures i
i:ltegm Top Sik [¥] Traces g j Il e sic
era Top Mask Top Mask
Top Paste ]pads Settings v - Top Paste
. _.
i?alulg Devices A Bottom ¥]vias Recognize Accuracy: 0.002 in W Top (1
me Bottom Paste Pad/Vi Holes
Burr-Brown Bottom Mask Eapad/ Board Outline Width: 0.006 in +/ Il Bottom (2
Fomrnee 2 Bottom Sik Mt Holes R o00a + I sottom Paste
Bottom As older Mask swel: g in
Library Tools » Bood Outine Text + Bottom Mask
: Board Tables Paste Mask Shrink: 0.004 in + Bottom Sik
Fiter Off » Top Dimension -
Bottom Dimension 9] Pictures ] Paste Mask for SMT Pads Only + Il eottom Assy
AM27C256-150EBL2 - _ + [l 5oard outine
AM27C256-150ED3 [ Dimensions
AM27C256-150EL2 ol Symbols [ Miror Unis - ot < @
AM27C256-1501ED3 R T TR © Inches
AM27C256-1501BL2 @ Plate g : _
(@] Design Manager =
AM27C256-1501D3 Non-piated Blesialcas £LEnS on Manag i @ S
AM27C256-1501L2 All Holes B1 - SOURCE_BATTERY2 -
AM27C256-155CBD3 Offset gé - g:gigggg
AM27C256-155CBL2 EREE i X:|0.394 |in ¥:(0.394 |in LED1 - LED i
AR TICE ACCIMD . LED2 ’LED P
RLCC-32/11.5x14x1.27 Add Comments Use Design Origin Q1 - 23401
Q2 - 2N4401 -
.
njm, (o) (oot ) s ] | coroonencens
- -
= -
- -
- -
- -
- -
- -
- -
~nm- . -
4 | r
¥=243%in ¥=2.868 in

Press the Preview button to preview selected layer. Unlike DXF, all layers should be
exported to Gerber separately, one layer per file. The image below shows the bottom layer of
our PCB in the Gerber preview dialog box. You can zoom in and out. Press Close button to
close the preview panel.
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<% Gerber - Preview EI@

Bottom ® 5| Scale: B54% - | Close |

Press Export All and DipTrace will generate files for each layer automatically. Remember
that PCB houses need Gerber and N/C Drill files[e01to manufacture your PCB. Once you
export those, you can archive them for convenience and send out for manufacturing.

Gerber layers

1. Top Assy — this is assembly layer, it includes all shapes / texts placed on the Top Assy as
well as objects defined in the "View \ Assembly Layers" main menu item. Assembly layer in
this project includes the board outline, because it is selected in the "View \ Assembly Layers"
main menu item, but you can select another object or hide the board outline on this layer.

2. Top Silk —includes pattern shapes, texts and all other shapes and texts placed in the Top
Silk layer. Do not change these settings, and press Preview. Notice that if you use the
TrueType fonts, some parts of the text can be invisible (depends on the font and size), you
should make Recognize Accuracy value a bit smaller, but do not apply minimums.

3. Top Mask —this is a solder mask layer. It is generated automatically, based on pads,
custom pad settings and common Solder Mask Swell parameter, defined in the Export
Gerber dialog box. This layer also includes shapes placed in the solder mask layer. We
should uncheck the Vias box (exclude vias from the export), because vias are usually
covered with the solder mask. To change custom solder mask settings for pads, right click
on the pad, and select Mask \ Paste Settings from the submenu.

4. Top Paste —this layer is used for SMD pads only, so we can check Paste Mask for SMT
Pads only.

5. Signal layers (Top, Bottom, etc.) —these are copper layers. Please check the Vias
checkbox for all of them and preview each one to make sure that layers are correct.
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Notice that Pad/Via Holes item in the Objects section should be checked only if you plan to
drill holes manually (not using a PCB house). If Pad/Via Holes check box is checked, two
Gerber layers will be created inside one Gerber file: Positive Drawing and Hole Clearing. The
second layer is used to remove artifacts over the drill holes. Manufacturers prefer Gerber files
without pad/via holes.

6. Bottom Paste, Mask, Silk and Assy layers are just like their analogs from the top side. By
default all text objects in Bottom layers are flipped — "View \ Flip Text Automatically" option
from the main menu.

7. Board Outline layer includes the board outline with defined width.
8. Board layer includes the board as a filled polygon.

9. Top/Bottom Dimensions — layers created specially for dimensions. These layers are
blank in our case, because current project does not have any dimensions on the design area.
Top / Bottom Dimensions can help some manufacturers to avoid mistakes in sizes.

Notice that NOT all layers are necessary for successful board manufacturing. It depends on
your project and additional features that you order.

Other settings

The Offset parameter in DXF, Gerber, N/C drill and Pick and Place export dialog boxes is the
distance between zero and the bottom-left corner of the board. You can use a custom value
or design origin (check the corresponding item or enter values in the Offset section of the
Gerber export dialog box).

Press the Files button in the upper-right corner of the Export Gerber dialog box, define
filename and extension for each Gerber layer, and include or exclude certain layer/s from
exporting when you press the Export All button. Select layer in the list, and type in a new
name and extension. Layer name and project name tags are supported. We will not change
anything, keep the <layer> tag — all files will be named as layers. Press OK.

Gerber Files @
Layer Filename Include into "Export Al
{ Top Assy | «layer=.gbr Yas
Top Sik <layer=.gbr Yas
Top Mask <layer=.agbr Yas
Top Paste <layer=.abr Yas
Top <layer=.abr Yas
Bottom <layer=.gbr Yas
Bottom Paste <layer=.agbr Yas
Bottom Mask <layer=.abr Yas
Bottom Silk <layer=.abr Yas
Bottom Assy <layer=.gbr Yas
Board Qutline <layer=.agbr Yas
Board <layer=.abr Yas
Top Dimension <layer=.abr No
Bottom Dimension <layer=.gbr No
Drill Symbols <layer=.agbr No
Yes
Flename may include the following tags:
=<layer= - lyer name
<project> - name of the project file (without extension)
oK | | Cancel
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Drill Symbols (Legend)

Some PCB houses require Drill Symbols. DipTrace allows you to export them as a separate
Gerber file. Check the Drill Symbols check box in the Export Gerber dialog box, then press
Set Symbols button. In the pop-up dialog box you need to manually assign each hole with the
symbol from the list in the right side, or press the Auto button to assign all symbols
automatically. Close this dialog box.

@PCE Layout - [D:\Tutorial_2016.dip] == =)
File Edit View Objects Placement Route High Speed Verfication Library Tools Help
DD”H|§I§SD‘ Enﬁ|QQ@22D%vU.D25iﬂv = ac [ Top Assy - @‘gg |
[B]lm + | @ osce - 84| . 0 A @ BE |/ 8 ~&xE|)|v & wa - <&
Export Gerber RS-274X |22 || Drill Symbols (=
Layers:
Tzzrisw Objects - Hole Symbol )ELUSS* -
Top Sik Traces [ fles ] [ Apertures ] Round 0.028 in Cross y=
Top Mask ) T=
Top Paste Pads Settings Round 0.028 in X v
Bottom Recognize Accuracy: 0.003 |in Round 0.038 in T Box_Cross
Bottom Paste Pad/Via Holes ) ) ) Box_X
Bottom Mask Board Outline Width: 0.006 |in Box_Y A8
Bottom Sik [V Mt Holes Box_Y
Bottom Assy Text Solder Mask Swell: 0.004 |in
Board Outline -
Board =t Paste Mask Shrink: 0.004 |in
Top D _
Bsgtu%ms:jﬂisrlrsmn Pictures Paste Mask for SMT Pads Only
Dimensions
i @ Inches !
@ Plated Flip Text -
) Non-plated [CIEnable G54 © Metric Symbol Size: 0.047 i Line Width: 0008 i |
() All Holes m
ose E
x[0a% |0 v:[03% |n
CEDZ - CED
[¥] Add Cormments [¥] Use Design Origin Q1 - 2H4401
Q2 - 2M4401 -
- -
- -
- -
- -
- -
-unm- . -
bl »
X=2438in ¥=2.868 in

Now check the Add Comments check box, and press Preview. You will see the drill symbols
and a table with hole parameters.
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Close the preview panel, and press Export to save Drill Symbols in the file. Drill symbols will
be exported in the separate file just like any other Gerber layer. If apertures are not defined,
DipTrace will ask you to set them automatically.

Uncheck the Drill Symbols check box when done, otherwise you will get a blank file /
preview while exporting silk, assy, signal layers, etc.

DipTrace allows the user to export any texts, fonts, and Unicode symbols (even Chinese
hieroglyphs) as well as raster black and white images (company logo, etc.) to Gerber format,
but you should define the Recognize Accuracy for such objects. 3 mil is set by default, you
can use the accuracy of up to 0.5 mil.

We recommend to check Gerber files with third-party viewer, before sending them to
manufacturer. The best option is to use the same software (or a free viewer) as your board
manufacturer, because some programs may read Gerber files a bit differently from the official
RS-274X specification.

We tried to take into account specifics of different manufacturing software in DipTrace
Gerber export feature, but verifying files is a very good practice.

If you don't know what software your manufacturer uses, we recommend Pentalogix
Viewmate, it has strict RS-274X conformity.

3.3 Gerber X2

Gerber X2 is the latest evolution of Gerber format and DipTrace is one of the first electronic
CAD systems with Gerber X2 support. If your PCB manufacturer accepts Gerber X2 files,
you can completely enjoy the benefits that this format gives to the engineer. Gerber X2 stores
information about PCB stackup order, function of each layer, PCB attributes, and pad
functionality.
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3.4

Select "File \ Export \ Gerber X2" from the main menu in the PCB Layout. Since Gerber X2 is
compatible with Gerber RS-274X[s4), the dialog boxes are very identical and exporting
procedures does not differ from the ones described in the Gerber Output/s4] topic of this
tutorial.
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However, Gerber X2 saves comprehensive drill layout in Gerber-formatted file (not just Drill
Symbols, like Gerber RS-274X). To export drills, check the Drills check box, select all copper
layers (they should be selected by default) to export through holes or press Export All to
export all holes of the project automatically into the corresponding Gerber file/s. Each type of
the hole goes into a separate Gerber Drill file.

Check with your PCB house if they accept Gerber X2. Since most of the manufacturers will
require drills in the N/C Excellon format, please refer to the respective topic/eol of this tutorial.

N/C Drill file (Excellon)

If you order board manufacturing at a PCB house, you need to provide Gerber and N/C Drill
files to them. Select "File \ Export \ N/C Drill" from the main menu, then press the Auto
button to define the tools, and press Export All to save all necessary files automatically. Use
the Preview button to visually check the layout.
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If you want to export just the holes of a certain type separately from the other, select the layer
pair of the via style, and press Export.

Notice that for through holes all layers should be selected, for Blind/Buried vias — only top
and bottom layers involved in the via style.

3.5 ODB++

DipTrace allows the user to export the circuit boards into ODB++ format for manufacturing.
Select "File \ Export \ ODB++" from the main menu in the PCB Layout. In the pop-up dialog
box you can check or uncheck certain PCB layers for exporting, change default solder mask
swell and paste mask parameters with respective fields and check boxes, edit the offset
values and define export mode. Default settings usually work for most cases, so do not
change them unless you need.
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3.6
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If As Compressed file item is checked, DipTrace will zip all ODB++ files into a single file for

sending out to the board manufacturer. Press Export and specify the folder where to save
the output files. You can preview ODB++ files with a free Mentor Graphics ODB++ Viewer.

Order PCB

For those who doesn't want to look for a PCB house to manufacture the project, DipTrace
allows for a simple ordering tool with Bay Area Circuits, our parther PCB manufacturer in
California. No need to export Gerber or N/C Drill files, enter few details and manufactured
board will be delivered to your place. Go to "File \ Order PCB" from the main menu in
DipTrace PCB Layout, review the board parameters, specify quantity, manufacturing time,
shipping address, name, phone, email, and some additional details. The price will be

automatically calculated.

Order PCB from Bay#rea Circuits @
Board Parameters Price
Board Size: 1.8%2.5in Quantity: 5 = Per Unit: $11.75
Number of Layers: 2 Turn Time: 10 days Total: $58.73
Solder Mask Color: Green
Order Details

SETLT BT First and Last Name * Ermail Address *
- 0.062 thick John Doe John_Doe@*****,com
- FR4 (standard temp for 2 layers,

high temp for 4 and 6 layers) Company Confirm Email Address *
- 5,1'5 min trace and space P JDhI‘I_DDE@*****.CDm
- 0.010 smallest finished hole size
- HASL Finish Phone *
- Solder Mask Both Sides ] e
- Silk Screen Both Sides if wanted
Additional Options Shipping Address

Country * City *
Mo Solder Mask (2-layers only) - ] ey
United States B Sacramento
Comments Address * State *
Californial -
Zip Code *
Close Place Order...
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Press Place Order button to open the order page in your web browser, review the total cost,
including shipping. Online payment via PayPal.

DRC checks your PCB automatically. If there are errors, we recommend to carefully review
and fix them. Please do not allow for any ambiguity, especially related to Solder Mask and
Solder Paste settings. Describe it in the Comments section, or contact Bay Area Circuits to
clarify any of the question that you think may arise.

Email: support@bacircuits.com

855-811-1975 FREE (toll free)

510-933-9000 (local)

510-933-9001 (fax)

Corporate Headquarters

44358 Old Warm Springs Blvd

Fremont, CA 94538

Congratulations! You have finished designing a simple project with DipTrace.

Please, save your Schematic and PCB files if you want. It took longer to read this tutorial then
to actually create a project. :-)

P.S. Do not forget to uncheck the Use Priority Layer Directions check box in the
Autorouter Setup dialog box if you plan to route 2+ layer boards.

Part IV: Creating Component Libraries

In this part of the tutorial we will teach you how to create component and pattern libraries with
DipTrace Component and Pattern Editors. In most cases you can find appropriate pattern in
DipTrace standard libraries and attach it to a new component, but for educational purposes
we will create a new pattern from a scratch.

Important:

In this tutorial we often refer to components as patterns or footprints (if talking about the PCB
Layout), while in the Schematic components are often called symbols, component symbols,
or schematic symbols, all these mean the same.

A regular component in DipTrace consists of schematic symbol, pattern drawing and,
possibly, a 3D model. All three represent the same entity, but on different stages of the
design: schematic capture, PCB Layout, and 3D visualization / export respectively.
Components and attached patterns are saved in files with *.eli extension. DipTrace also
allows access to patterns separately from the components. Pattern libraries are stored in the
files with *.lib extension. *.wrl, *.3ds, *.iges, and *.step files store 3D models. Patterns and
schematic symbols can exist as separate stand-alone parts, but correct component always
have all of them properly connected.

Different schematic symbols can have the same pattern (footprint) attached to each of them
and vice versa, for example the same resistor can be in regular and SMD packages.

Component Editor is used to manage components — draw schematic symbol and connect
them with pattern drawings (footprints). However, pattern drawing is not editable in the
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4.1

4.1.1

Component Editor, Pattern Editor should be used instead.

Read Working with libraries topic in the Component and Pattern Editor Help documents for
more details.

Designing a pattern library

Open DipTrace Pattern Editor, i.e. go to "Start \ All Programs \ DipTrace \ Pattern Editor" on
Windows machine, or use DipTrace Launcher on MacOS.

Customizing Pattern Editor

First of all we need to show a center point and X,Y-axes, select "View \ Display Origin" from
the main menu or press "F1" hotkey (if it is not displayed yet). Notice that you can change the
origin at any time while designing a pattern ("View \ Define Origin \ ..." from the main menu or

press + button on the Instruments toolbar). Origin is a zero point of the pattern when you
place, rotate, or change pattern's position by coordinates in the PCB Layout.

Pattern Properties panel in the upper-left of the design area allows the engineer to design
patterns by types or templates, define pattern attributes, attach 3D model, and change default
pad settings. The panel can be hidden, minimized or moved during pattern design. To
minimize the panel, click the arrow button in its upper-left corner. To hide / show this panel
select "View \ Toolbars \ Pattern Properties” from the main menu.

4 Pattern Editor - [E\DipTrace\Lib\_General.lib] (=2 Ech ===
Library Pattern Edit View Objects Layer Tools Help

0O = ‘ | ‘ 0 & 1570% - | 0.025n - N O @O o @ A & sc Topsik -

(Ko +|o w8 &+ ® | -
Select Pattern 4 | S0IC-8/150mil Pattern
Pattemns » A Pattern Properties i (']:') : X
General Hame: SOIC-8/150mil
Antennas - =
Batteries RefDes: u ==
BGA - =
BQFP i Layer 0
Cap

Datasheef:

Cap SMD : : : : :
CFP

| 3D Model.. || Additional Fieids  w | . . . . .
L‘braw Tools 4 Pattern Template et
e S : -
SOIC-8EP/150mi \ Pad Properties... \
SOIC-8/209mil e _ .
SOIC-8/300mil
SOIC-14/150mil
SOIC-14/209mil
SOIC-14/300mi
SOIC-16/150mi o ' '
SOIC-16/209mil
SOIC-16/300mil o o ] o
SOIC-18/300mil
SOIC-20/209mil
SOIC-20/300mil
SOIC-24/209mil o o : o

SOIC-24/300mil
SOIC-28/300mil
SOIC-30/300mil
SOIC-32/300mil
SOIC-36/300mil
TSSOP-8 =

*

X=0.025in ¥=0.225 in

Use the Plus Sign (+) and Minus Sign (-) hotkeys or the mouse wheel for zooming in and out
in the Component and Pattern Editors or change scale in the scale box on the Instruments
toolbar. Go to "View \ Pad Numbers \..." to show / hide the pad numbers.
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4.1.2 Create/Save library

Press

Library Tools

>

Create alibrary

\ New Library on the Library Manager panel on the left side of

the screen. In the pop-up dialog box enter the library name, hint, and select the library group.
We recommend to create this library in the User Patterns library group offered by default.

Press OK.

MHame:

Hint:

Create New Library

Library Group:

5

My Library (Patterns)

My first library

Components
Patterns

User Components

m/| s

-

Other Libraries

[ 0K H Cancel |

The name of your library will appear on the Library Manager panel, User Libraries library
group becomes selected automatically. Now please save newly created library in the
separate file.

Save library

4 Save As

i

Recent Places

Network

Save

Name

Savein My Libraries

File name:

astype

- en

° E-

Date modified

No items match your search.

==

Type

Custom_Pattems_1

Pattem Libraries ("lib)

Select "Library \ Save" from the main menu.
We recommend to save user libraries in
"Documents/DipTrace/My Libraries" folder for
Windows users, which is offered by default,
however, you can select another location (Mac
users should save custom libraries in another
location, because you can accidentally lose
the "My Libraries" folder when uninstalling the
software).

DipTrace does not allow for saving user
libraries in the folder with standard libraries.

Type in the file name (not shown in DipTrace)
and press Save.

Now we have "My Library (Patterns)" pattern library, which belongs to the User Patterns
library group and is saved on your computer. Notice that file has *.lib extension, saying that
this is a pattern library.

4.1.3 Designing aresistor (pattern)

We will design the first pattern of our library, it is going to be a resistor with 400 mils lead

spacing.

First we need to name the pattern and fill up the basic description fields. Type "RES 400" into
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the Name field, "R" — into the RefDes field and "47kQ' — into the Value field on the Pattern
Properties panel. In DipTrace Pattern and Component Editors you need to define just a
basic RefDes (not a number index). For example, when you place several resistors: R1, R2,
R3, etc., the designators will be assigned automatically. Use Windows Special Characters
Map to find and copy/paste special symbols for Ohms, Farads etc.

4 Pattern Editor - [E\My Libraries\Custom_Patterns_1.lib] EI@
Library Pattern Edit View Objects Layer Tools Help
Dm’:ﬂ‘ | ‘Q@l?gl%vﬂ.ﬂﬁln - N O @O S @ A & s Topsik -
(K]m +|o s 8820 »|™ -
Select Pattern 4| RES 400 Pattern
User Patterns » - Pattern Properties i ('I') : X
My Library (Pattems Template: Hone -| = . . . . . Layers
MHame: RES 400
RefDes: Rl
Value: 47kQ
Datasheet:
Library Tools »
4 [ 3D Model... H Additional Fields b]
Pattern Tools » Pattem Template
style: Free - a
[ Pad Properties... ]
4 ]
X=02in ¥=0.25in

For this pattern we have used the Free style, but it is faster to use Lines instead. You'll see
how to do this in one of the subsequent topics.

Placing pads

Please make sure that 0.05 in grid is selected (change measurement units in the "View \
Units" main menu item) then minimize the Pattern Properties panel. Select the Place Pad

o . . .
tool ( button on the Objects toolbar) and left click on the design area to place two pads
like on the picture below. Right click to exit the placement mode.
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4 Pattern Editor - [E\My Libraries\Custom_Patterns_1.lib] EI@
Library Pattern Edit View Objects Layer Tools Help
Dﬁﬂ‘ |n ‘Q@QlEEE%vD.DSin N YO B O @ A O s Topsik -
(Blm +] 6 ¢ & & & »| 1 -
Select Pattern 4| RES 400 Pattern
. . . . . . . e a .
User Patterns » | »> Pattern Properties ($) - X
Loyrs
o
Layer 0
°
Library Tools » Layer 1
Pattern Tools »
4 ]
X=-0.05in ¥=035in

Such placement is not an accurate method, it requires manual correction of pad coordinates.
Let's place a dimension line, this will make editing more simple and visual. Select "Objects \
Place Dimension \ Horizontal" from the main menu or Place Dimension \ Horizontal tool on
the Objects toolbar, left click in the center of the first pad, then in the center of the second
pad, move the mouse pointer a bit upwards, and click one more time to place a dimension
line. The key points of the object are highlighted when you hover over them with your mouse.
Dimension pointer is attached to the key point, it recounts automatically when you move or
resize objects.
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4 Pattern Editor - [E\My Libraries\Custom_Patterns_1.lib] EI@
Library Pattern Edit View Objects Layer Tools Help
Dﬁﬂ‘ |n ‘Q@QlEEE%vD.DSin N YO B O @ A O s Topsik -
hm+| o @@ o[dw -
Select Pattern 4| RES 400 Pattel| I e
. . . . . . . A a .
User Patterns » | »> Pattern Properties ($) - X
Layers
°
Layer 0
©
Library Tools » Layer 1
Pattern Tools »

Layer 2

l r

X=025in ¥=015in

Right click on the dimension line, and select Properties from the submenu to change Layer,
Units, Arrow Size etc. Drag and drop the dimension line like a regular object if needed.

Layers
On the right side of the screen there is a layer list. One layer per object on the design area.

These are only the logical layers for convenient editing (not signal or silk layers that you used

to work with in the PCB Layout).

Select layers 0 and 1 (hover over the Layer 0, hold down the left mouse button, move the
mouse cursor to Layer 1, and release the mouse button). Now merge this layers by selecting

“"Layer \ Merge Layers" from the main menu or press ! button on the Layers panel. You
have made a single layer with two pads in it; double click it to open the Layer Objects dialog
box. Select pad / pads with incorrect coordinates and change X-axis coordinates to make 400
mils (0.4 inch) distance between the pads, then click OK to close the dialog box.
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4 Pattern Editor - [E\My Libraries\Custom_Patterns_1.lib] =0 =R
Library Pattern Edit View Objects Layer Tools Help
Dﬁﬂ‘g{, |n ‘Q@QlEEE%vD.DSin N YO B O @ A O s Topsik -
hom+ |6 &80 ST -
Select Pattern 4| RES 400 Pattern
. . . . e A roe
User Patterns » | »> Pattern Properties @ - X
Loyrs
°
Objects - Layer 0 [
Layer 0
Object Xt YL X2 Y2 x3  v3 e
Pad 1 -0.2 0.1
Pad 2 02 0.1 |
Library Tools » Layer 2
Pattern Tools »
Delete Selected Objects |
X1: 0.2 in X2: in X3: in
¥1i: 0.1 in Y2: in Y3 in
0K Cancel
4 ]
X=035in ¥=015in

You can see that dimension line was recounted automatically and now displays correct

distance value.

-

=5
L]

Pad Properties
Template: Mone
Type: Surface
Shape: Rectangle
Points
Width: 0.08 in
Height: 0.059 in
Hole
Shape: Round
Diameter: 0.03 in
0.039 in
ok ||

Cancel |

Pad properties

Pads can have default or custom properties. Default are
applied to all pads of the pattern, custom — only to
selected pad/s. To change default pad settings, select
"Pattern \ Pad Properties” from the main menu or press
Pad Properties button on the Pattern Properties panel.
In the pop-up dialog box you can change the pad shape:
Ellipse, Oval, Rectangle or Polygon (click Points for
polygonal pad customization). You can make round or oval
holes and change the hole diameter (for Through pads
only). Pad templates allow the user to quickly apply
selected parameters in different dialog boxes of the
Pattern Editor and PCB Layout.

Change pad shape to Rectangle, width to 0.08, height to
0.059, and Type to Surface, then click OK to apply
changes. You can also change the measurement units
(mil is 1/2000 inches).
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4 Pattern Editor - [E\My Libraries\Custom_Patterns_1.lib] EI@

Library Pattern Edit View Objects Layer Tools Help

DD"E‘ |-ﬂ ‘@g@quza%vo.osm N NOB O @ A& & #c Tepsik -
hom+ |6 &80 ST -

Select Pattern 4| RES 400 Pattern

User Patterns » | »> Pattern Properties . . . ’ ’ ’ ’ "B @ : X
tayas

Layer 0

Library Tools » Layer 2

Pattern Tools » ] ] ] ] ] ] ]

X=0in ¥=035in

Notice that you can select the side for the surface pads, i.e. place them on the bottom side of
the PCB. Select pad(s), right click on one of them, and select Change Side from the
submenu. Select current side for placing new pads and shapes on the Objects toolbar (drop-
down box with the "Top" text).

We need the first pad to have custom pad properties. Right click on the first pad, and select
Properties from the submenu (if pad is not highlighted while hovering over it, you're not in the

default mode — right click on any free spot or press button on the Objects toolbar). In the
pop-up Pad Properties dialog box, select the Type / Dimensions tab, and uncheck Use
Pattern's Pad Properties box to enable pad’s custom settings.

Polygon pads

Let's create a hexagonal-shaped pad. The fastest way to achieve that would be selecting an
appropriate (Polygonl) template, but let's practice a bit. Do not assign any template, change
type to Through-Hole, shape to Polygon, width and height to 0.09 inch and pad hole
diameter to 0.04 inch, then press Points to open the Polygon Points dialog box. Here you
can create regular or custom polygon shapes that are not available in the templates drop-
down list.

Select: Regular, 8 Sides, and specify 0.045 inch Radius. Edit custom shapes with the table
below or visually in the preview field (drag and drop the polygon's points).
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{) Pattern Editor

Pad1l X=-02 ¥=01

o || =R
Library Pattern Edit View Objects Layer Help
O = &3 4 Lol @ @Q 1345%  ~ | 0.05in i I & BE R @ | Top -
NN O @O © A @ s TopSk v
Pad1 £2 || Polygon Points @
Humber / Position | Type / Dimensions @ Regular A
Use Pattern’s Pad Properties il 8
Radius: 0.045 in
Template: Mone -
Ruotation: Side -
Type: Through-Hole -
Shape: Polygon - 5et Points
Points.__ Incremental
1(0.042; 0.017) X: |0 in
Width: 0.09 in 2 (0.042: -0.017)
3(0.017; -0.042) v: o in
Height- P 4 [-0.017; -0.042)
e 0.09 in 5 (-0.0427 -0.017)
6 [-0.042; 0.017)
Hole 7 (-0.017: 0.042) Add
8 (0017 0. 042)
Shape: Round - Insert
Diameter: 0.04 in Delete
0.035 in
[Comen
0K | | Cancel

X=-02in ¥=01in

Press OK to apply the polygon shape.

You can change pad coordinates and direction in the Number / Position tab of the Pad
Properties dialog box, but do not do this. Press OK. Changes will apply to all selected pads.
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4 Pattern Editor - [E\My Libraries\Custom_Patterns_1.lib] EI@
Library Pattern Edit View Objects Layer Tools Help
Dﬁﬂ‘g{, |n ‘Q@QlEEB%vD.DSin N YO B O @ A O s Topsik -
(K]m + 0 0o @ ¢ 0 /T -
Select Pattern 4| RES 400 Pattern

. . . . . . . A a .
User Patterns » | »> Pattern Properties ($) - X
Layers

Layer 0

Library Tools »

Pattern Tools » ] ] ] ] ] ]

Layer 2

X=0in ¥=035in

There is also another way to create polygon pads, select the Polygon tool on the Drawing
toolbar and draw a shape directly on the design area. Make sure that shape is on the signal
layer (select Signal from the drop-down list on the Drawing toolbar prior to drawing or change
shape layer in the shape properties dialog box — right click directly on the shape on the design
area). When shape on signal layer is ready, right click it, and select Convert to pad from the
submenu. This options is visible only for Polygon drawing tool.

Please define the following properties for the pads:
first pad — 0.09x0.09, Through-Hole, Rectangle, hole diameter — 0.04;
second pad — 0.09x0.09, Through-Hole, Ellipse, hole diameter — 0.04.

Now let's place a silkscreen for this resistor. Select Rectangle button on the Drawing panel,
make sure Top Silk layer is selected. Place a rectangle by clicking on two key points on the
design area.
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4 Pattern Editor - [E\My Libraries\Custom_Patterns_1.lib] EI@
Library Pattern Edit View Objects Layer Tools Help
Dﬁﬂ‘ |'(j ‘Q@197°%' 005~ N \@DOO/\;OM Top Sik -
hom+ |6 &80 ST -
Select Pattern 4| RES 400 Pattern
- - - - - 7 a =
User Patterns » | »> Pattern Properties ($) - X
Lavers
a L]
Layer 0
Library Tools » Layer 2
Pattern Tools » L
Layer 2
< v
X=015in ¥=03in

Now disable the rectangle placement mode (right click on the free spot or press button).

Silk shape looks a bit small for this pattern. There are several ways to change it: 1) Select
"Layer \ Objects" from the main menu and enter new coordinates; 2) right click on the shape,
select Properties, and change points in the pop-up dialog box; 3) drag-and-drop shape's key
points. We will use the last method, but first we need to change the grid size to 0.025 inch
with "Ctrl+Minus Sign" hotkeys or with the grid box on the Instruments toolbar, then hover
over rectangle's key points, and resize the shape (the mouse cursor shows possible
directions).
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4.1.4

4 Pattern Editor - [E\My Libraries\Custom_Patterns_1.lib] EI@
Library Pattern Edit View Objects Layer Tools Help
Dﬁ"ﬂ‘éﬂ |-ﬂ ‘@g@qwm%v 0025~ N SO BE O @ A & fec TopSik -
(K]m + 0 0o @ ¢ 0 /T -
Select Pattern 4| RES 400 Pattern
- - -
User Patterns » | »> Pattern Properties . . . . . . . . . ($) = I X
Lavers
. . . . . . . . . . . . . a o
Layer 0
Library Tools » Layer 2
Pattern Tools » -

Layer 2

l r

X=0125in ¥=015in

Center the pattern by selecting "Edit \ Center Pattern" from the main menu or "Ctrl+Alt+C".
The resistor is ready.

Try to rotate and mirror the first pattern of your library, select "Edit \ Rotate Pattern” to rotate
and "Edit \ Vertical Flip", "Edit \ Horizontal Flip" to mirror it.

Press Save on the Standard toolbar. We will attach 3D model for this resistor in the next
topic of this tutorial.

Attaching a 3D model

Please make sure that you have downloaded and installed free 3D Models package from
DipTrace official website, which contains more than 6,500 3D models for various

components.

When component footprint (pattern) is ready we can attach a 3D Model. Press Im
button on the Pattern Properties panel. In the pop-up dialog box press All Models button
and the list of all available 3D models will pop up, 3D models are sorted by libraries. We will
probably find appropriate resistor model in the _General library. Scroll it down to find the res-
10.16_5.1x2.5.step model, left click it, and it will appear on the footprint. Sometimes you
might need to map a 3D model respectively to the footprint (like on the picture below).
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3D Model [#£34] | Available 3D Models ===
3D Model File: 4-models3d -~
v res-10.16_5.1x2.5.5t2p L) - Antennas
:-BGA
[ Load Model | [ Al Models << | ©-Cap SMD
[] Turn Off Automatic Search > CFP E
. " :-Con Board In
Fie Units: Heters > Con Flat Flexible
3D Model Properties >-Con Headers
»-Con Memory Cards
X shift: o [ >-Con Phone Jacks
Y Shift: 0 in >-Con TB Barrier Blocks
>-Con TB Headers
Z shift: (] [ >-Con Wire to Board
> CQFP
X Angle: 0 deg. . DIP
Y Angle: 0 deg. >-DIP Peg Leads
»-DIP SMD
Z Angle: 0 deg. + - Inductors
> LGA
X Scale: 1 2] > Optosensors & LED
Y Scale: 1 »PGA
> QFN
Z Scale: 1 . QFP
» -Resistors
[CIFlip by Z Axis 507
»-50P
»-50T
B > Sound
Colors >-Switches
Background > T0
> - Varistors
Pads 4|_General
Sik Screen . dip-10.step
. i bedip-14.step
dip-16.step
dip-18.step
dip-20.step
dip-22.step
dip-24.step
&, N i A e 2
To edit this list please change model folders in
"Tools / 3D Preview / Pattems and Models
Search” in PCB Layout program.

Mapping a 3D model

DipTrace automatically places a 3D model to fit the pattern's drawing, however, sometimes
you may need to adjust 3D model location or the scale. Just enter appropriate values into the
corresponding fields on the 3D Model Properties section (shift, angle, and scale for each
axis). In our case we see that we need to rotate the resistor 90 degrees and shift it up a bit.
Specify 90-degree Z Angle and 0.03 inch Z Shift. You can rotate 3D model by three axes,
zoom in/ out, and pan 3D Model preview with the mouse (left, right, and wheel clicks) or
using the wheels at the bottom of the dialog box.
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30 Model (3
3D Model File:
res-10.16_5.1x2.5.5tep
File Units: Meters
3D Model Properties
X Shift: 1] in
Y Shift: 0 in
Z Shift: 0.03 in
X Angle: 0 deq.
Y Angle: 0 deqg.
Z Angle: a0 deq.
X Scale: 1 fa]
Y Scale: 1
Z Scale: 1
[ Flip by Z Axis
Colors
Background
Pads
Bl sik Screen
[ oK ] [ Cancel ]

Press OK to attach 3D model, and then save the pattern library. More details about DipTrace
3D Modulep24 later in this tutorial and in the DipTrace Help ("Help \ Pattern Editor Help" from
the main menu).

4.1.5 Designhing BGA-144/13x13

Pattern Tools 2

Press , then select Add New Pattern to My Library (Patterns)
Library on the Library Manager panel. This will add an empty pattern to the library. The
pattern is selected. We will create BGA-144/13x13 (x0.8_10x10) pattern using available
pattern types and automatic pad numeration. Maximize the Pattern Properties panel and type
in the pattern's name.
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<) Pattern Editor - [EAMy Libraries\Custom_Patterns_1.lib] == ]
Library Pattern Edit View Objects Layer Tools Help
Dﬁﬂ‘ | ‘Q@1223%v 0.02sn ~ o~ Ty OO S @ A & e TopSik -
BEREIERS EE L
Select Pattern 4| BGA-144/13x13 Pattern
User Patterns » hd Pattern Properties i ($) : I x
e (e Template: None e .o . o P . Layers

Hame: BGA-144/13x13]

RefDes: .o . .

- .o . .

Datasheef:
Library Tools »

v [ 3D Model... ] [ Additional Fields P]

Pattern Tools » Tt T
RES 400

Style: Free
BGA-144/13x13 -

I [ Pad Properties... ] .
] = v
X=-0.05in ¥=0325in

Change units to mm, select "View \ Units \ mm" from the main menu, then go to "Pattern \
Pad Properties” from the main menu and define: Type: Surface, Shape: Ellipse, Width:
0.45 mm, Height: 0.45 mm. Press OK to apply changes to default pad properties. On the
Pattern Properties panel set: Style: Matrix, Columns: 13, Rows: 13, X Pad Spacing: 0.8
mm, Y Pad Spacing: 0.8 mm. 13x13 pad matrix and pad spacing dimensions appears on the

design area.
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4 Pattern Editor - [E\My Libraries\Custom_Patterns_1.lib] EI@
Library Pattern Edit View Objects Layer Tools Help
D& W [0 o8 & van «|oasm- N WOE O @ A & & Toosis -
(K]m + 0 0o @ ¢ 0 /T -
Select Pattern 4| BGA-144/13x13 Pattern
User Patterns » hd Pattern Properties i ($) : I x
Tempiate:  None - & Layers
MHame: BGA-144/13x13
RefDes: . L Layer 0
ayer
i 9000000000 ooe .
Datasheef: 3..... ......
Library Taols ’ ‘EDMDE‘EL.. H Additional Fields P‘ . . . . . . . . . . . .
Pamem Toos M| | pattem Tempiace L B K N N K N N N N N N J
RES 400 . . R . L
e e o 00060006000 OCGOIOGS
Columns: 13
° 0000000000000
X Pad Spacing: 0.8 mm
Y Pad Spacing: 0.8 mm . . . . . . . . . . . .
Pad Properties... . . . . . . . . . . . .
0 000G OOSNOOGSEOOSDS
S0P 00 O0OOSOOOSIOIOSOIOSS
L B B N N N N N N N N J
L N N N N NN N NN N NN
4 L3 =
X=-6.99 mm ¥=6.99 mm

Click |2 button on the Pattern Properties panel to prevent accidental changes. Minimize
the Pattern Properties panel. Pan design area if necessary with the right mouse button or
zoom with the mouse wheel. For BGA-144/13x13 pattern we should delete 5x5 rectangle of
pads in the center, like on the picture below. Select these pads using the box selection (move
mouse to the upper-left corner, hold down the left mouse button, move to the bottom-right
and release the button), then press "Delete" key on the keyboard to delete selected pads.
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¢ Pattern Editor - [E\My Libraries\Custom_Patterns_1.lib] EI@
Library Pattern Edit View Objects Layer Tools Help
0= | © B @ 1628% v | 063Bmr Y N N OO0 O @ A O s TopSik -
(K]m + 0 0o @ ¢ 0 /T -
Select Pattern 4| BGA-144/13x13 Pattern
User Patterns » |> Pattern Properties f ($) : I X
Layers
0000 OQ0OGCOGOOOSEOSNOSDS
000000060606 OCGCOGSSDS Layer o
0006006060606 OCGKOGSS
Lbrary Tools » 000 00O06OGCOGCOOSSS
Pattern Tools » . . . . . . . .
RES 400
LN N N L N N
. eeee e0o0oeo
LN N N o000
L N N o000
o900 0S o000 OO
00060060606 OGCOGFSISS
00000000 O0OGEOSPS
00 0000006060000
< 3 )
X=6.99 mm ¥=571 mm

Select "View \ Pad Numbers \ Show" from the main menu to display pad numbers. Notice
that our matrix has 1 — 169 numbers with some missing numbers in the center. This is not
right. BGA pads should be A1,A2, A3 etc. Select all pads ("Ctrl+A" or a box selection), right
click on one of the pads, and choose Pad Array Numbers from the submenu. In the pop-up
dialog box, select Type: BGA Matrix, keep other settings, and press OK button.
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4 Pattern Editor - [E\My Libraries\Custom_Patterns_1.lib] = || =) R
Library Pattern Edit View Objects Layer Tools Help

Dﬁ"ﬂ‘éﬂ |-ﬂ ‘Q@QISES%vD.GESva N WO E O @ A & fec Topsik -
(%) m +\o°u°§:§a:o©x|m .

Select Pattern BGA-144/13x13 Pattern

User Patterns | »> Pattern Properties ‘ fl ($) : I X

M Pattemns Layers
|§| [ Pad Array Numbers =
Type: [BGA Matri] -
E Numbers:  Leftfo-Right =
[@le]el4
Library Tools » E
Pattern Tools » [

RES 400 [

e ele]e]

eo]o]e
@/elle]d
Qiolak
c/ellee
@/o]e]éTe
celelc/cielslolele

l r

Layer 0

Characters:  Top-Down -
First Number: 1
First Character: A -

Strings

[®|e|@e][e]e|e]
DIRCIEICIE
[ele|el[ele]e]

Before:

After:

%

Example
Al A2 A3 A4
B1 B2 B3 B4
C1 or] foc] 4

EEEEHE

nuﬁm‘

LRIEEICEIE
[e/0]ele]o]o]

Padl X=-4.8 Y=4.8 X=-445 mm ¥=5.08 mm

Now pad numeration is correct.

Notice that for Contour type of numeration the first pad will be the one you right clicked on.
This allows the user to numerate contours (QUAD patterns) starting from the upper-left,
center, or any other pad of the pattern.
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¢ Pattern Editor - [E\My Libraries\Custom_Patterns_1.lib] EI@

Library Pattern Edit View Objects Layer Tools Help
0= | © B @ 4223% v | 06Bmry N N OO0 O @ A O s TopSik -

Rlm + |0 ¢ @+ 0 /|10 -

Select Pattern 4| BGA-144/13x13 Pattern

" eeco0o0o0
... 000000
e O ® O QO O
20000
0000
r 2 s I 4 -

¥

ST E X

Layers

Layer 0

A

X=-064 mm ¥=5.08 mm

Now draw a silkscreen for the pattern (like on the picture below), using the tools on the
Drawing toolbar. Change grid size with "Ctrl+Plus Sign", "Ctrl+Minus Sign" or turn it OFF/ON
with "F11" hotkey. You can move objects with drag and drop or with the Move Layer feature
(select layer in the list on the right side and drag-and-drop all objects of this layer directly on
the design area with respect to each other).
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4 Pattern Editor - [E\My Libraries\Custom_Patterns_1.lib] EI@
Library Pattern Edit View Objects Layer Tools Help
D& W [0 o8 & van«|oasm- N WO E O G A & & Topsis -
(Fla + o v @0 | -
Select Pattern 4| BGA-144/13x13 Pattern
User Patterns » | »> Pattern Propertes | - - o - oo B . i ($) : X
= 3 Layers
2006
Layer 0
202
2060 e@
Library Tools » @ @ @ @ Layer 1
Pattern Tools » o ‘
RES 400 @ @ @ @
eoee

Layer 3

Layer 4

Layer 5

6606666
660666066a¢
006606060
00660686

X=2.22 mm ¥=6.99 mm

BGA pattern is ready. You can attach a 3D model now. Unfortunately, there is no BGA-
144/13x13x0.8_10x10 3D model in the standard 3D model libraries, but we don't need that
precision for the 3D model. DipTrace allows the user to attach any 3D models in *.3ds, *.wrl,
*.step, and *.iges formats to any footprint. You can download models from the component
manufacturers' websites or create them in any 3D CAD.

3D model properties

Press ‘m button on the Pattern Properties panel.

If you have appropriate model on your computer click |_| button, select 3D model file on your
computer, and press Open. You can also enter 3D model's disk address, and press Load
Model button — a 3D model will appear on the preview area. Change 3D Model Properties in
case the model does not correspond to the footprint.

For example, we have decided to take the bga-144 12x12x1.27 17x17.step 3D model from
the BGA library in the standard 3D model package and scale it down a bit to fit the footprint
(see the picture below).
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3D Model (3
3D Model File:
boa-144_12x12x1.27_17x17.5teD  |uue)
[ Models <<_|
File Units: Meters
3D Model Properties
X Shift: 1] mm
Y Shift: 0 mm
Z Shift: 1] mm
X Angle: 0 deg.
¥ Angle: 0 deg.
Z Angle: 0 deg.
X Scale: 0.63 a

Y Scale:

Z Scale:

[ Flip by Z Axis

Colors
Background
Pads

Bl sik Screen

0.63

0.62

(Y

@@Q@I

[ ok

H Cancel I

Try to enter different values into various fields and you will understand how to fix model's

location. Press OK. Notice that button glows green when the pattern has

attached 3D model and glows red when it does not.

Save the pattern library ("Ctrl+S" or Save button on the standard toolbar).

4.1.6 Real component design. SOIC-28 pattern

When you are familiar with the basics, we can try to create a real component according to
the datasheet. It's gonna be the simple Microchip PIC18F24K20 component with SOIC-28
pattern.

When you start creating the component from the scratch and you don't have an appropriate
pattern, always start from the pattern creation and then proceed to component's symbol.

We start from making a pattern. Add new pattern to the library ("Pattern \ Add New Pattern To
"My Library (Patterns)" Library" from the main menu), then enter name "SOIC-28", and
RefDes —"IC".

Select Style: Lines on the Pattern Properties panel, and set Number of Pads: 28. In our
case pads are way to small for this pattern.
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4 Pattern Editor - [E\My Libraries\Custom_Patterns_1.lib] EI@
Library Pattern Edit View Objects Layer Tools Help
DD"E‘ |-ﬂ ‘@g@qnau%v 38mm~ N SN B C @ A & #c TopSik -
Maviocnsor|m -
Select Pattern 4| 50IC-28 Pattern
User Patterns » hd Pattern Properties | - o o - - e - fl ($) : I X
Tempiate:  None = Layers
Name: s01C-28 R
RefDes: Ic
Layer 0
ke e o ® ©
Datasheet: L
Library Tools 4 S
v [ 3D Model... H Additional Fields PJ .....
Pattern Tools » Pattern Template
RES400 | | eniee T oA |
Style: Lines
BGA-144/13x13 ML
SOIC-28 Number of Lines: 2
Number of Pads: 2
Pad Spacing: 2.54 mm | e
Line Spacing: 7.62 mmo o
{ Pad Properties... J .....
4 ]
X=0.32 mm ¥=6.99 mm

We should define correct pad spacing, line spacing and pad settings. You can find SOIC-28
(7.50 mm) footprint dimensions on the Microchip package specifications PDF at the
Microchip's website (page 197 in the latest revision at the moment of writing this tutorial) or
you can take the SOIC-28 pattern from standard DipTrace libraries as an example.

Define default pad settings (press Pad Properties button to open the dialog box): Type:
Surface, Shape: Rectangle, Width: 0.6 mm, Height: 2 mm. Press OK. Then specify Line
Spacing: 9.4 mm and Pad Spacing: 1.27 mm on the Pattern Properties panel.
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4 Pattern Editor - [E\My Libraries\Custom_Patterns_1.lib] EI@
Library Pattern Edit View Objects Layer Tools Help
0O = ﬂ‘ | © ‘Q € 1345% ~ | 038mr ~ 0 N v O @ © @ A O s TopSik -
(K]m + 0 0o @ ¢ 0 /T -
Select Pattern 4| 50IC-28 Pattern
User Patterns » - Pattem Properties o o .- (%) : ] X
My Library (Pattemns. Template: None - = Layers
e P . o
Mame: SOIC-28 e O A
"
RefDas: Ic T . - ! ! .
T . - ! ! . Layer 0
Value: 25,2 26472 2487 2 2
Datasheet: A B . . | - | | .
Library Tools » O e .
Y (3D model.. | [ Addionalpelds  w] | < oo A I
Pattern Tools » Tt T
RES 400 N
Style: Lines
BGA-144/13x13 ML
SOIC-28 Number of Lines: 2 b
Number of Pads: P i
Pad Spacing: 127 o s O
Line Spacing: 9.4 mm | .

Pad Properties...

l ¥

X=-9.52 mm ¥=7.84 mm

Pad numbers are correct, we don't need to renumber them. Lock pattern properties to avoid
accidental changes. Draw a silkscreen (like on the picture below), using line / polyline and arc
tools found on the Drawing toolbar (turn ON/OFF the grid, change grid size, and hide Pattern
Properties panel if you need).
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4.2

42.1

4 Pattern Editor - [E\My Libraries\Custom_Patterns_1.lib] EI@
Library Pattern Edit View Objects Layer Tools Help
D& @ [0 o8 & pav-|ossm- N WOE O G A & & Toosis -
(K]m + 0 0o @ ¢ 0 /T -
Select Pattern 4| 50IC-28 Pattern
User Patterns > |> Pattern Properties . - . . A - - A‘%’ : ] X

Loers

..... !I . . . . . . er
i: 26 4 o 17

Layer 1

Library Tools »

Pattern Tools »

RES400 | |~ | -
BGA144/13x13 | | - - | . .
SOIC-28

Layer 2

..... ayer 3

Layer 4

..... . . . . . . Layer s

l ¥

X=2.54 mm ¥=8.26 mm

Datasheet requires the pattern to be rotated 90 degrees — select "Edit \ Rotate Pattern” from
the main menu or "Ctrl+Alt+R". Attach soic-28 300mil.step 3D model from the _General 3D
Models category.

We will attach this pattern to PIC18F24K20 component, which we will create in the
Component Editorli41] later in this tutorial.

Save this library and close the Pattern Editor.

Designing a component library

Open DipTrace Component Editor, i.e. go to "Start \ All Programs \ DipTrace \ Component
Editor" in Windows or use DipTrace Launcher on MacOS.

Component Editor allows the user to create / edit and manage components and libraries in
DipTrace. Component Editor allows attaching component's pattern to the symbol, but it
doesn't allow pattern editing — use the Pattern Editor| a1,

Customizing Component Editor

Customizing the Component Editor is almost the same as customizing the Pattern Editor.
Select "View \ Display Origin" from the main menu to show a zero point and X, Y axes (or
press "F1") if you can't see the origin point. Component Properties panel in the upper-left side
of design area can be minimized or hidden using the buttons on the panel and in the main
menu.

In the Component Properties panel you can define the symbol style (4 styles available): Free
(without any specific properties), 2 sides, IC-2 sides, IC-4 sides. The only difference between
"2 sides" and "IC-2 sides" is a rectangle shape (IC Symbol) for the last one.
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The fields that might look unfamiliar are the Part Type field and the Part field. The part type
can be Normal, Power and GND or Net Port. Component can contain only one Power and
GND part (if you prefer to hide all power nets of your schematic, then all power pins should be
in this part). Net Port is a single-part component, we use net ports to connect wires logically.
Net ports are usually applied to Ground or Power nets and schematics with flexible structure
(we will design such component later).

The Part field indicates current part of multi-part component.

% Component Editor - [E\DipTrace\Lib\__discrete.eli] IEI@

Library Component Edit Miew Objects Layer Tools Help
D& | | & ®uuk- W - [k]+|2 @+ N, O0@O 0N 0 &
Select Component 4| CAP Component

Components » A Component Properties . . - . . . . . . i "I" : ] X
Dace B Lovers

Discrete SMD Hame: cap

z

Symbols RefDes: C e Zg
Symbols EIC
Net Ports Value:
Antennas Manufacturer: ’ ’ ’ ’ : ’ : : .

Batteries ‘iG
Buzzers Datasheet: . . . . . . . . .

Capacitors
Con Symbaols
Con Backplane

Layer 0

Layer 1

‘ Pattem... || Additional Fields ~— »

Library Tools » Part Type: Hormal -
»

Component Tools Part: Part 1

F - |
CAP100 Symbol Template . . . . . .
CAP200 Style: Free B
CAP250
CAP300 ‘ Pin Manager... ‘
CAP350
CAP400
CAP450

CAP500
CAP400AP

3]
[¥]

=

CAP-2.54/6.6x3

Part 1 1 r

X=-01in ¥=045in

If you need to define pin settings before creating a component, select "Objects \ Pin
Placement Setup" from the main menu. We will not change these parameters now, but
notice that length and X,Y spacing should be divisible by the grid step to create all key points
on the grid. We recommend to use 0.1 inch grid.
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4.2.2

@ Compenent Editor - [E:\DipTrace'Liby__discrete.eli]

Library Component Edit
D& | |

Select Component 4| CAP Component

View Objects Layer Tools Help

8 & 1011% -

0.lin

Components » hd
-

Discrete SMD
Symbols
Symbols EIC
Net Ports
Antennas
Batteries
Buzzers
Capacitors

Component Properties

Name: CAP
RefDes: C
Value:
Manufacturer:

Datasheet:

I R - I NI N w [ = G I P ™

[=r=]=]

“p 3 X

Layers

= Za

Layer 0

i

Pin Placement Setup

Additional Fields

Con Symbaols [

Con Backplane Pattern... ] [

Normal

Library Tools » Part Type:
»

Component Tools Part: Part 1

E
CAP100
CAP200
CAP250

Symbol Template
Style: Free

Type:

[] Show Name

B X Spacing: 0.1

CAP300 [ Pin Manager...

CAP350
CAP400
CAP450
CAP500
CAP400AP

CAP-2.54/6.6x3

[¥] Justify by Connection

Length: 0.15

¥ Spacing: 0.1

Layer 1

Part 1

X=-03in ¥=005in

Designing a resistor (component)

Like in the Pattern Editor, first we need to create a new library, because DipTrace won't let
you add new components to standard libraries.

Library Tools >

Press

Create library

, then select New Library, in the pop-up dialog box enter the

library name, hint, and select the library group. We recommend to save this library in the User
Components library group, offered by default. Press OK.

Create New Library @

Mame: My Library

Hint: My Component Librany

Library Group: Components -
Patterns

lUser Patterns
Other Libraries

m

[ ok

” Cancel ]

We will design the resistor using Free style and visual pin placement. Define component
name, RefDes, and value "47kQY', use the corresponding fields on the Component
Properties panel. After specifying these attributes, please minimize the panel, using the

arrow in its upper-left corner.
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4 Component Editor EI@
Library Component Edit View Objects Layer Tools Help
ODE - |-n Q@lﬂll%vU.USm--}—|@é‘§E-} NN o OB C e v &
Select Component 4| RES 400 Component
User Components » v Component Properties i "I" : I X
I | terste:  tore - @ Layers
Mame: RES 400
RefDes: R
Value: 47kQ
Manufacturer:
Datasheet:
- [ Pattem... ][ Additional Fields ~ »
Library Tools »
Component Tools P Part Type:  Normal v
part: Part 1 B
Symbol Template
Style: Free - 2
Pin Manager... ]
No Pattern
No Pattern

X=-0.25in

¥=045in

Select the Place Pin tool on the Objects toolbar (

Place pins

)

button), then move the mouse cursor

to the design area, and place two pins with left clicks. Rotate one pin 180 degrees, (select i,
and press "Ctrl+R" twice), make sure that pins are placed by 0.1 inch grid. Now change grid
to 0.05 inch, select the Rectangle tool, and place graphics for the resistor.
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< Component Editor =N =R
Library Component Edit Miew Objects Layer Tools Help
D& | |o cl@a®usn- osn - | [Bl+]|@ s/ Y OBOCO N 6 &
Select Component 4| RES 400 Component
- - -
User Components » | »> Component Properties ('I') - I X
E— Loy
Layer 0
2.
Layer 1
- [
Library Tools »
Component Tools P Layer 2

No Pattern

No Pattern

Part 1 1 3

X=015in ¥=03in

Notice that you can move pin(s) using the drag-and-drop method. If you want to move or
rotate several pins, select them first.

Attach pattern

The symbol of the resistor is ready, but the component is not ready yet. We should attach a
pattern to this symbol, otherwise we will not be able to generate the circuit board from the
schematic with this resistor. Select "Component \ Attached Pattern” from the main menu or
press Pattern on the Component Properties panel. We need to connect this symbol
drawing with a pattern drawing created before in the Pattern Editor. Select User Patterns
library group (because, as you remember, we've saved the pattern library in that group (see
"Designing Resistor"[es] topic of this tutorial). There is only one library in that group. Select it,

and select RES 400 pattern that we've created earlier.

Notice that DipTrace automatically creates pin-to-pad connections by numbers. You can
review and reassign them if necessary. Connections should be like on the picture below.

To create or redefine pin-to-pad connections, hover over the pin, left click it, then move
mouse to the corresponding pad, and left click it to connect them. To delete connection, right
click on the pin or pad, and select Disconnect pin from pad item from the submenu. When
you move cursor over one of connected pins/pads, both are highlighted. If component is more
complex, use the Pin to Pad table (select pin and type in the corresponding pad number into
the Number field below.
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4 Attached Pattern EI@
My Library s B 472% Hide Ratlines £ 578% ~ Pattem Lbraries
dh User Patterns -
brary (Pattems

| - aC_]o

Component: RES 400 Previous Pattern: |E|
Part: Part 1 - New Pattern: RES 400 Y Library Setup...
Pin to Pad Table Side: Top| - Patterns

Pin Pad Number —— : Fitter Off [

A 1 eck Pattern Dimensions =

2 2 T BGA-144/13x13

Variable Pattern Parameters S0IC-28
Number:
[ oK ] | Cancel |

Pin numbers (therefore component's pin to pad connections) can be changed with the Pin
Manager (select "Component \ Pin Manager" from the main menu) or in the Pin Properties
dialog box.

If current pattern is wrong, you can undo to the previous one or delete it by pressing the
corresponding buttons (Previous Pattern, New Pattern). Change pattern side with the
corresponding drop-down list.

All components of the library are in the left part of the dialog box, this allows the user to attach
patterns to several components at a time. However, we don't need this now. Our Library has
only one component.

Everything looks good. Press OK to close the Attached Pattern dialog box. The resistor is
ready and contains both schematic part and PCB pattern with 3D Model.

Save component library. Press the Save button on the Standard toolbar, select location (not
in the folder with standard libraries), enter file name, and press Save.

Notice that this is the file with *.eli extension, this means that this is component library file.

4.2.3 Designing a capacitor

Select "Component \ Add New to "My Library" from the main menu to add new component to
the library.

We will design capacitor using the 2 sides component style (Style box on the Component
Properties panel); type in the component's name "CAP", RefDes — "C", Value — "2uF" .
Change component width and pin spacing to 0.1 inch, left and right pins to "1".
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< Component Editor - [E\My Libraries\My_Library.eli] EI@
Library Component Edit View Objects Layer Tools Help
D& | |o cl@a@mm « osn - | [Bl+][@ s/ Y OBOCO N 6 &
Select Component 4| CAP Component
User Components ~ p - Component Properties il ('I') : I X
AT | temeste:  None - & Lavers
Name: CAP .
RefDes: C
Layer 0
Value: 2)F
Manufacturer:
Datasheet:
- [ Pattem... ][ Additional Fields ~ »
Library Tools »
Component Tools » Part Type: Normal -
RES 400 Part: Part 1
Symbol Template
e |
Style: 2 sides - 2 | B il
Width: 0.1 in
Pin Spacing: 0.1 in
Left Pins: 1
Mo Pattern Right Pins: 1
Pin Manager...
No Pattern
Part 1 « ] v
X=015in ¥=086in

Now please minimize the Component Properties panel, change the grid size to 0.012 inch,

and draw the capacitor's graphics, using three lines and one arc.

< Component Editor - [E\My Libraries\My_Library.eli] EI@

Library Component Edit View Objects Layer Tools Help

ODE - |-n Q@197U%vu.u12|n-+|4;S:§-:-\‘\/I:II:IOC)/\/OBB=

Select Component 4| CAP Component

User Components » | »> Component Properties il ('I') : I X

My Lbrary | Layers
=— —a
Layer 0
Layer 1

Library Tools »

Component Tools P Layer2

RES 400 -

CAP
Layer 3
Layer 4

No Pattern

No Pattern
Part 1 ‘ N '
X=0075 in ¥=0.225in
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Show pin names for the component symbol, select pins (or select all using "Ctrl+A" hotkeys),
right click on one of them, and choose Pin Properties from the submenu. In the Pin
Properties dialog box check the Show Name box, and press OK.

& Component Editor - [E:\My Libraries\My_Library.eli] (o= =]
Library Component Edit View Objects Layer Tools Help
DS HE| & @ |-n Q@lQFU%vU.Ulzln-+_|-1.;'§:§.:.‘\‘\/|:||:|OO/\,OABC
Select Component 4| CAP Component
- -~ L)
User Components » | »> Component Properties D . - S S S (-I-) el v W4
,—| P . . R R R v
=n=n
L o Layer 0
.| Pin Properties @
Type: None -
Electric: Undefined - Layer 1
[¥]Show Name ]
Library Tools b . o . oo Name: 2
. . . . R . R R Layer 2
Component Tools P _ _ _— ) — Fonit of Mame... — S - .
RES 400 . . — . o Number: 2 .o R - . -
Length: 0.15 in Layer 3
’ ’ Posttion C (
Pin Xz 0.05 in
Pin Y: 1] in Layer 4
No Pattern
No Pattern
Part 1 1 r
Pin 2 (2) - Undefined X=0.05 Y=0 X=0112in ¥=0012in

Now you can see the pin names, but they are in wrong places (probably overlaying each
other) and you need to move them. Select "View \ Move Tool" from the main menu or press
"F10", then hover over the pin names, and drag them to new locations one-by-one, then right
click to return to the Default mode.

Notice that you can use such method to move pin names, numbers and part attributes in
Schemaitic.
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O d

Select Component

4

Library Tools

Component Tools

RES 400
CAP

No Pattern

No Pattern

< Compenent Editor - [E:\My Libraries\My_Library.eli]
Library Component Edit Miew Objects Layer Tools Help

)

0 & 1970% -

CAP Component

0.012in -

User Components » | »> Component Properties
My Lbrary |

k o+

Part 1

-

5

E=3 EER (XS
SNy o OO0 C @ v & s
- - .
$ L rx
Layers
" La
Layer 0
Layer 1
Layer 2
Layer 3
Layer 4
r
X=0.2in ¥=0.212 in

You can show inversion line in the pin name, just hover over the pin with your mouse, right
click, and select Pin Name from the submenu, type in "normal ~invert" text, and press OK,
then move the pin name using the move tool ("F10" hotkey). The Tilde Symbol (~) in the pin
name starts and ends the inversion, so using it you can define the inversion for separate
parts (signals) in the pin names.
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< Component Editor - [E\My Libraries\My_Library.eli] EI@
Library Component Edit Miew Objects Layer Tools Help
D2 | |r) 8 & mn v wzn - | 4|0 FEB AN Y 2 OOCO A O s
Select Component 4| CAP Component
User Components » | »> Component Properties = "I" : I X
M SRR ' EITE
. DI o L 2 g
..... Layer 0
SEEEEEER ST IR T U Ut IR IR TR IS Lavr
Library Tools » L N T . .
s > JOCMAQAL IAVErt |4
RES 400 B A R s P . - _
..... . A T Layer 3
: Layer 4
Mo Pattern | |
No Pattern
Part 1 q 3
X=0138 in ¥=0362 in

You probably don’t need to see the pin names for simple passive components like capacitors.

Select "Component \ Pin Manager" from the main menu to open the Pin Manager dialog box
and change "normal ~invert" pin name back to "1". Now hide pin names for both pins: select
pin row in the table, and uncheck Show Name box at the bottom of the dialog box. Close the

Pin Manager.

Notice that you can change pin numbers (i.e. related pads), coordinates, length, type, and
electric type of pins in the Pin Manager dialog box.
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< Pin Manager o[BS
| Sort Pins Part: Part 1 -
MName X Y Length Type Electric Show Mame
1 -0.05 0 0.15 MNone Undefined Mo
2 0.05 O 0.15 MNone Undefined  No ]
Add | | Delete
Name: 2 X: 0.05 Type: None - Length: 0.15 in
Number: 2 Y0 Electric:  Undefined -« Show MName
oK | | Cancel |

In the Component Editor you can set individual show/hide pin numbers settings for current
component ("Component \ Pin Numbers" from the main menu) and common program
settings (the same as in the Schematic) in "View \ Pin Numbers \ Show" from the main

menu.

Let's show capacitor's pin numbers. If you need to move pin numbers, use the Move Tool

("F10").
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< Component Editor - [E\My Libraries\My_Library.eli] EI@

Library Component Edit Miew Objects Layer Tools Help

D2 | |r) 2 & % 0zn v | G 4| ® F BN Y A OO C @ A O A
Select Component 4| CAP Component
....... 7 a .
User Components > | > Component Properties | .. ... ... o (-I-) = Ip] X
'ﬁ‘ ........... Layers
........... — —a
........... Layer 0

Layer 1

Library Tools Bl

Component Toos b ﬁﬁﬁﬁfﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁ‘]ﬁﬁﬁﬁ _ﬁﬁﬁ2ﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁfﬁﬁﬁﬁ J““

RES 400 -

........... e e
___________ - |\ o e

Layer 4

Mo Pattern | |00

No Patter S EEEES S

X=01in ¥=0375in

The next step is attaching a pattern to the capacitor. Open Component Properties panel
and press Pattern button. We did not create a pattern drawing for this component, because
we will take appropriate pattern from the standard DipTrace libraries. Select the Patterns
library group, then select CAP library below, and CAPPR-2.54/5.08 from the list of patterns.
You can use the search filters.

Pin-to-pad connections assigned automatically are good.
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4 Attached Pattern EI@
My Library s € 709% ~ []Hide Ratines € 1173% ~  Pattem Lbraries
dh Patterns -
RES 400 General B
Antennas
Batteries L
BGA 35
BOFP
= 4
D Cap 5MD

,:: CFP
Con Backplane

Con Batteries
Con Board In
Con D-Sub

Con Edge Cards
Con Flat Flexible
Con Headers

Con Jacks
Component: CAP Previous Pattern: Con Memory Cards -
Part: Part 1 - New Pattern: CAPPR-2.54/5.08 Library Setup...
Pin to Pad Table Side: Top - Pattemns

P Pad humber |

Check Pattern Di i
1 1 ECK Tattem Jmensions CAPPR-2.5/6.3h9.8 -

5 5 — — R CAPPR-2.5/6.5h12
Varigble Pattern Parameters CAPPR-2.5/6.8h12
CAPPR-2.5/8h5
CAPPR-2.5i8h9.8
CAPPR-2.54/5.08
CAPPR-2/4h6.8
CAPPR-2/5.5h12
CAPPR-2/5h11 B
CAPPR-2(5h5
CAPPR-3.05/3.81h6.35
Mumber: CAPPR-3.5/8.5h12

’ 0K ” Cancel ]

Press OK. The capacitor is ready. Save the changes.

4.2.4 Designing VCC and GND symbols
In this lesson we will practice in creating net ports by designing VCC and GND symbols.

VCC

Press Component Tools b , then select Add New Component to "My Library”, type in

"VCC" in the Name field on the Component Properties panel, and select Net Port in the
Part Type drop-down list.
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% Component Editor - [E\My Libraries\My_Library.eli] = =
Library Component Edit View Objects Layer Tools Help
D2 | |r) 2 & % 0zn v | G 4| ® F BN Y A OO C @ A O A
Select Component 4| VCC Component
- T g R S S -l 2 ¢
m Template: None C i | Layers
Mame: VCC
e e | R
Vaue:
s ] IS I S S S I
Datashest: SEREEEE EESEEEE S
- [ Pattem... ][ Additional Fields b] .................
Library Tools 4 Sl NP s
Component Toos o W g || i
e8I I
RES 400 Part; Pawerandand || B
cap | | S N
swmbolTempate DDl
Style: Free B
[ P Manager... J | SRR
No Pattern SRR EEESEEEEETRREEE SRR
No Patter S RIS EEERREE : S
SRR LR R R R Lo :
X=-0.075in ¥=015in
L . .|
Minimize the Component Properties panel, then press the Place Pin button on the

Objects toolbar and place a single pin, rotate it vertically (select it, and press "R" hotkey).
Select the line tool on the Drawing toolbar and draw a line like on the picture below, use 0.05

inch grid.
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< Component Editor - [E\My Libraries\My_Library.eli] EI@
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Hide the pin number if it is visible, select "Component \ Pin Numbers \ Hide" from the main
menu. Pin number for the single-pin component looks kind of weird. VCC symbol is ready.

GND
Now add one more component ("Ctrl+Ins" hotkeys), and create a GND symbol the same way
like the VCC symbol.

Select "Edit \ Center Symbol" or press "Ctrl+Alt+C" for GND because in our case its origin is
not in the center, so you have to center it to make component's origin hidden by default in the
Schematic. Use 0.012 inch grid to draw a GND symbol's graphics.
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4.2.5

< Component Editor - [E\My Libraries\My_Library.eli] EI@
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Notice that net ports do not need patterns. This special type of components is used only in
Schematic to connect wires without visual connections, net ports do not exist on the circuit
board.

Save the library file.

Designing a multi-part component

Despite being represented as a single physical package on the circuit board, some electronic
components has a multi-part schematic symbols. Building a multi-part schematic symbols
involves a bit different technique.

Creating a symbol

We will design a simple multi-part component with four "And-Not" symbols, a power part and
attach DIP-14 pattern, which is available in the standard libraries.

Add new component to the library, i.e. select "Component / Add New Component To Library"
from the main menu. Enter the name and Reference Designator.
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< Component Editor - [E\My Libraries\My_Library.eli] EI@
Library Component Edit Miew Objects Layer Tools Help
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Creating parts

DipTrace allows for creating multi-part components using separate or similar parts. The only
difference between these is that similar parts share the same layout of pins and symbol
drawing, except the pin numbers (i.e. related pads). We will proceed with similar parts,
which, by the way, can be grouped later in the Schematic.

Each part of the multi-part component can be Normal, Power and Ground, or Net Port. Power
parts and power nets can be hidden in the schematic capture. Only one power part per
component.

We will design a component with 4 similar AndNot gates and one power part. Select
"Component \ Create Similar Parts" from the main menu, type "4" in the pop-up dialog box,
and press OK to apply. Tabs with the part names has appeared in the bottom-left of the

design area.

Similar parts are created based on currently selected part. They share the same name and
layout of pins.
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Now you can see the following 4 parts: Part 1 (1), Part 1 (2), Part 1 (3) and Part 1 (4). All
similar parts have the same part name. Change it to "AN" in the Part field on the Component

Properties panel.
The power part for the component is missing. Select "Component \ Add New Part" from the

main menu to add a single part to the component, select new part tab (Part 1) in the bottom-
left of the design area and rename it to "PWR".

Notice that new part is a separate part and does not belong to "AN" group.

Start designing a component with the power part. On the Component Properties panel
specify: Style: IC - 2 sides, Width: 0.3 inch, Height: 0.25 in, Left Pins: 2, Right Pins: 0,
then select Power and Gnd from the Part Type drop-down list. Make general component pin
numbers visible ("View \ Pin Numbers \ Show" from the main menu), if they are hidden.

© 2016 Novarm Software



134

DipTrace Tutorial

% Component Editor - [E\My Libraries\My_Library.eli] = =
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Library Tools 3 S 1
Component Tools P Part Type: Power and Gnd,
Norra [ l—
RES 400 Part: Power and Gnd S
CAP Het Port y
VCC Symbol Template Lo 4
GND
AndNoEX Style: IC - 2 sides - 2 %
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Press the Pin Manager button on the Component Properties panel and change pin names
to "VCC" and "GND", pin numbers to "14" and "7", electric type to Power, the Show Name
box should be checked for both pins. Notice that you can change Type, Show Name and
Length parameters for multiple pins.

4% Fin Manager ==
[ Soit Phs ] Part  PWR -
Hamsg Humb er X Y Length Type Elactric Show Name
[ vee 14 015 0.05 |0.15 Hone Power Vs
GHD 7 015 005 015 Hane Pawer Yes
add pekte |
Marma:  WCC ¥ 015 n Type: Han ) - Length: 0,15 n
Number: 14 Y1 0.05 i Electricc  Power - ] Show Mame
ok || cancal |

Pin Manager dialog box itself and the width of the rows are resizable. These settings are
saved when you close the program.
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Now press OK to close the Pin Manager dialog box. Then minimize the Component
Properties panel and see the first ready part of the component.

[E= BB (=)

< Component Editor - [E:\My Libraries\My_Library.eli]
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Design the other parts of the multi-part component: select one of the AN parts, maximize the
Component Properties panel, and define the following parameters: Style: IC-2 sides,
Width: 0.2 in, Height: 0.25 in, Left Pins: 2, Right pins: 1. Now minimize the Component

Properties panel again.

, A5 .
Select the text tool on the drawing toolbar ( i button), hover over the symbol, left click, and
type "&" character, then press "Enter” or left click to place the text (see the picture below).

Move the text if you need.
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Right pin of a typical "And - Not" (Not And) part should be inverted or "Dot" type. Right click on
the third pin, select Pin Properties from the submenu, in the pop-up dialog box specify

Type: Dot. Click OK to apply changes and close the dialog box.

Notice that you don't need to draw another AN parts of the component if they were created as
a group, they will be automatically generated.
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< Component Editor - [E\My Libraries\My_Library.eli] EI@

Library Component Edit Miew Objects Layer Tools Help

ODE - |-n Q@lszs%vu.mzm-+|4;S:§-:-\‘\/I:II:IOC)/\/OBB=

Select Component 4| AndNot4X Component

User Components » |> Component Properties R . L L . L LB ('I') : I X

I — oes
Layer 0
&
Layer 1

Library Tools »

Component Tools P

RES 400

CAP

VCC

GND

AndNot4x

No Pattern

No Pattern
AN 1]/ AN [2) /AN [3)/ AN [4)/PWR 1 ’
X=0175in ¥=0.25in

Select AN (3) or AN (4) part just to make sure that parts are the same. All parts in the group
are absolutely identical, but with different pin numbers.

Pin Manager

Select "Component \ Pin Manager" from the main menu. In the Pin Manager dialog box

select part (using the drop-down list in the upper-right), define pin numbers, then select next
part and so on, until you define pin numbers for all AN parts. Use the Down arrow button or
"Enter" to quickly switch to the next pin when you're typing in the Number or Name fields.

Don't forget that pin #7 is used in the GND part, therefore you should miss it while
renumbering pins of the functional parts, going from pin #6 straight to the pin #8.

Please set correct Electric type (2 input pins and one output pin) for one of the parts and the
other parts will inherit this automatically. Click OK.
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& Pin Manager

e~
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The next step is attaching related pattern to the multi-part component. Press the Pattern
button on the Component Properties panel. In the attached pattern dialog box select the
Patterns library group (library group with all standard pattern libraries), then select DIP library

and DIP-14 pattern in there.

Notice that you don't need to specify pin-to-pad connections, they have been assigned
automatically and should be correct, because we've specified correct pin numbers in the Pin
Manager (this is why pin number array was not straight).

Select different parts (drop-down list below the preview field) and visually check connections
to ensure that they are all right. Press OK to attach pattern and close this dialog box.
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Multi-part component is ready. Save the library file.

4.2.6

Using additional fields

Name, RefDes, Value, Manufacturer, and Datasheet are default component fields in the
DipTrace, usually these are what most users will ever need, but sometimes additional
description or other information is necessary. In this case you can use additional fields.

Select "Component \ Default Additional Fields" from the main menu. This dialog box allows
you to specify default additional fields and their values. For example, we need to have the link
for one more datasheet online: type in "Datasheet #2" into the Name box, specify Type: Link,
enter the web address, and click Add button. Now this additional field will apply only to all
new components that you will create. If you want to add this additional field to all existing and

future components in this library, then press the Add to All button.

© 2016 Novarm Software




140

DipTrace Tutorial

@Cumpunent Editor - [E:\My Libraries\My_Library.eli] | = || = H 12 \
Library Component Edit View Objects Layer Tools Help
0= |-n Q@519%vu.u12|n-+|@$§5§ NN o OB C e v &
Select Component 4| AndNot4X Component
User Components » v Component Properties il ('I') : I x
I | terete:  tore - @ Layers
Name: AndNot4X j‘:lbl'
RefDes: 1c
. . Layer 0
Value:
Default Additional Fields (=3
Manufacturer:
Field Name Default Value
Datasheet: Datasheet #2 http:\\datasheets.con
- [ Pattem... ][ Additional Fields ~ »
Library Tools »
Component Tools P Part Type: Power and Gnd LA —
s 400 BE "
CAP b
veC Symbol Template Name: Datasheet #2
GND 5
AndNot4X Style: IC - 2 sides -2 Type: Link -
Width: 0.3 in Default Value: http:\\datasheets.com
Height: 0.3 in
AddtoAl | [ chose
Left Pins: 2
DIP-14 Right Pins: 0
o o Pin Manager...
[} e}
< <
3 o
=3 =3
[} e}
o o - 4
AN [1)/ AN [2),/ AN (3], AN [(4)PWR 1 r
X=-0513 in ¥=0.538 in

Now all components in this library will have this additional field with the datasheet link. Close

Default Additional Fields dialog box. Select

Component Tools

4 , then select Add New

Component to "My Library" or press "Ctrl+Ins". Click Additional fields button to see the
list of all additional fields for a new component.
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4.2.7
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It has this Datasheet field.

Now make sure that Untitled component is selected on the Library Manager panel, right click
it, and select Delete Components or simply press "Ctrl+Del" to delete it. You can also
select several components and delete them at a time.

You can assign custom additional fields to the component, just press the Additional Fields
button on the Component Properties panel and practice a bit.

Additional fields in Schematic

Right click on the component with links to the datasheets on the design area in DipTrace
Schematic, and select Links from the right-click submenu, the web browser will pop up

automatically. You can assign additional fields as component markings for all or only for

selected components in the DipTrace Schematic.

Designing PIC18F24K20

In this topic we will create a real-life PIC18F24K20 component according to the datasheet
and attach SOIC-28 pattern that was created beforefi13)

Go to the Microchip website and search "PIC18F24K20", then select "Datasheets" on the left.
Or use direct link (however we don't guarantee that it works at the moment you read this
tutorial). Go to "Pin Diagrams", the first diagram is what we need.

Switch to the DipTrace Component Editor and add a new component ("Ctrl+Insert"), type in
the name "PIC18F24K20", then specify: Style: IC - 2 sides, Left Pins: 14, Right Pins: 14,

RefDes and manufacturer.
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DipTrace allows the user to enter pin names manually or import them from external BSDM
file (select "Library \ Import \ Add BSDL Pinlist" from the main menu). We will do this
manually. Press the Pin Manager button on the Component Properties panel and enter pin
names from the pin diagram in the datasheet found online. Notice that you can resize the pin
manager panel and change the width of the columns (we made the Name column wider to
see the full pin names). Also when you entered the pin name, just press "Enter"” to switch to

the next pin name easily.
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After entering all pin names, specify electric type for pins, and check the Show Name box for
all pins of the component. Notice that you can select as many rows as you need and change

certain properties at a time. Press OK.

Our symbol has inappropriate look, width is too small with pin names overlaying.
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On the Component Properties panel change width to 1.9 inches and height to 2 inches. Pin
names still overlay a bit, but we will regroup pins which will probably fix this. We made an IC a
bit bigger, because it will make it easier to do the pin regrouping. Change grid to 0.1 inch and
place pins by this grid (select all pins, right click, and select Snap to Grid from the main
menu).
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Make buses (Group pins)

We need to group pins logically. First we will make the busses: select "Component \ Make
Buses from Pins" from the main menu. This feature allows the user to extract buses based
on the pin names and group pins by buses. In the pop-up dialog box you can define possible
bus dividers. By default only "/" is selected and it is OK for current component, however,
some manufacturers use different dividers.

Press Extract button and you will see available busses and number of pins for each of them.
Select RA, RB, and RC buses using "Ctrl" key. Change Bus to Bus spacing to 1.3 inches,
because pin names are quite long.
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Press Make button to make the buses and close the dialog box. DipTrace sorts wires by

buses to the left from the IC symbol.

< Component Editor - [E\My Libraries\My_Library.eli] EI@
Library Component Edit View Objects Layer Tools Help
D@ M| o cla 2w ~jon - [[B+|s s\ N OBOO AN & &
Select Component 4 PIC18F24K20 Component
User Components » |> Component Properties o il ('I') : I X
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There are some pins that do not belong to selected busses (4 pins that left on the symbol).
Select them, use "Ctrl" and box selection, then move pins away from the symbol, for
example, to the bottom, because we need to place the busses first.

@ Component Editor - [E:\My Libraries\My_Library.eli] =N =R
Library Component Edit Miew Objects Layer Tools Help
0 | |n & & 203% - | 0.l v+|-1;°§:§.:.\‘\}|:||z|oof\,0&3c
Select Component 4| PIC18F24K20 Component
User Components P | » Component Properties . B ('I" : 0 x
My Lbrary [HEE Layers
]
Layer 0
2L RAD/ANG/CIZING- -
E—= RA1/AN1/C12IN1-
a—g RA2/AN2/Vref-/CVref FC2N+
G—— RA3/AN3/Vref+/C1IN+
Liorary Toals y| B RA4/T@CKI/CIOUT
=—— RAS5/AN4/5§S/HLVDIN/C20UT
Component Tools  ¥| | 518 ages e kOUT/RAS
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CAP . . . .
vCC
GND
AndMNot4X
Mo Pattern
. N AT . o . 28
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No Pattern G— Vas Vas 19
Part 1 “ o
X=-01in ¥=13in

Place buses to the IC rectangle like on the picture below. Use box selection to select a bus,
then drag it. Press "Shift+R" to rotate the bus and "Shift+F" to flip pins, or select these
commands from the pin submenu (right click on one of bus pins). Move the rest of pins to the
IC rectangle (press "R" to rotate selected object / pin).
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& Component Editor - [E\My Libraries\My_Library.eli] =N =R
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Sometimes you need to place pins by electric type, select "View \ Pin Colors by EType" from
the main menu and the software assigns different colors for pins of different electric types.

Press |3 button on the Component Properties panel to lock properties.

Final step is attaching SOIC-28 pattern to the component. Press Pattern button on the
Component Properties panel and select SOIC-28 pattern from My library (we've created it
beforeﬂsﬁ). Select User Patterns library group, then select My Library (Patterns) and SOIC-28
from the list below. All pin names and pin numbers are already there. You can check pin to
pad connections in the table. We don't need to change anything. Just press OK.
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4.2.8

4 Attached Pattern

Pin Pad Number
~MCLR/Vpp/RE3 1
RACD/AND/CL12IMO- 2
RA1/AN1/C12IM1- 3

RAZ/AN2{Vref-/CVref/C21l 4
RAZ/AN3 Vref+/C1IN+ 5
RA4/TOCKI/C1OUT 6
RAS/AN4{~S5~/HLVDIN/( 7

Number:

My Library s € 134% =~ [Hide Ratines
o —
| —
RES 400 ozl / i
HRUBTANETCTINES  RCRRIOT |
CAP Mttt T | M=
Vee i " A ey % | =
GND B2 R T Lo R BG4 SDLIR0s 2 / |
AndNot4X o ey | =
PICI8F24K20 * . iy DR
o2 TR R, RO TIOEA, 11 = <_:'____—-
<] Pv— _ =
oZlin | -
e s
|
|
i
Component: PIC18F24K20 Previous Pattern: SQIC-28
Part: Part 1 New Pattern: SOIC-28
Pin to Pad Table Side: Top

8 421% -

Check Pattern Dimensions

Variable Pattern Parameters

(=[O sl

Pattern Libraries

User Patterns -

Library Setup...

Patterns

RES 400

BGA-144i13x13

PIC18F24K20 component is ready! Save the library.

SPICE settings

With DipTrace you can export schematics into LT Spice to simulate it and see how the circuit
works. We will review the simulation step later, for now we need to define correct SPICE
settings for the component, otherwise Spice simulation for this component will not work. Now
we will specify that our CAP component is a capacitor with some value, so it will work in the
SPICE netlist. Select CAP on the Library Manager, then select "Component \ Spice
Settings"” from the main menu. Set: Model Type: Capacitor, then double click in the
Parameters table in the Value cell (the value reads "1uF" text) and enter a new value —"23
WF" (DipTrace supports Unicode characters). Press "Enter" or just move focus to another

field.

In the Template field you can see how this part looks in the SPICE netlist language. In our
case pin-to-signal map is correct, however, if you need to edit it, enter signal names into the
table on the left side of the Spice Settings dialog box. The list of available signals is right

below that table.
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@ Spice ettings = )E =
Maodel Type: Capacitor -
1 I { 2 Function: none
E | \ Bl Template:  C_C N+ N- 1uF IC=0
Parameters
Parameter Value
Pin Signal Value (Capacity, F) 23 pA
1(1) M+ IC (Initial voltage, V) 0
2(2) M-
Signal:
Available Signals
M+
N_
- Get Spice Model from Library |
[ 0K ] | Cancel |

Capacitor is a very simple component, we don't need specific text file model to let the
simulation software know how this component works (model type and capacity is just fine).
However, for transistors you can load models from external files (usually SPICE models are
available on the manufacturers' websites) or enter model text manually if you know how to do
that (see SPICE Language documentation for details). Also there is a SubSkt Model Type,
which allows the user to enter/load model of almost any part as a program.

Press Get Spice Model from Library button to load existing Spice settings from another
DipTrace component.

Notice that this dialog box is also available in the Schematic Capture, you can define Spice
settings after completing or while drawing the schematic.

Library design is ready. Click OK to apply changes and close the Spice settings. Save the
library file.

4.2.9 Library verification

It is very important to verify library for the most common types of errors. We've investigated
the work of our library designers and added an automatic error verification to the Component
Editor.

In the Component Editor select "Library \ Check "My Library" Library" from the main menu. In
this dialog box you can see the total number of components / parts / pins in your library and
all possible errors.

© 2016 Novarm Software



150 DipTrace Tutorial

Library Verification £% || Components with "Electric=Undefined” Pins @
Quantity Components Pins
. RES 400
C ts: i)
omponents CAP
Parts: 10 VCC
) GND
Pins: 48 PIC18F24K20

Possible Errors

]

Without Patterns: 2

+

Simifar Components: not sorted

Similar Pin Numbers:
Shorted Pins:

. Save Report | [ Close
Unconnected Pins:

Unconnected Pads:
Thru Pads without Holes:
Undefined Pins:

0000000

Pin Superposition:

Close

The following errors can be found automatically:

1. Components without patterns — search components without patterns. Keep in mind that
some components may have only schematic symbol intentionally.

2. Similar components — search components with similar names. Notice that library should
be sorted ("Library \ Sort Components in <current library>" from the main menu) to enable
correct verification.

3. Similar pin numbers — two or more pins have similar numbers (connected to the same
pad). This is probably a mistake in the component, please press the ... button and check pin
numbers for listed component.

4. Shorted pins — pins are shorted by internal pad-to-pad connections.

5. Unconnected pins — pins do not have the corresponding pattern pads. It's not always an
error.

6. Unconnected pads — some pads of the pattern are not used (no corresponding pins). It is
not always an error.

7. Through pads without holes — verifies components for the through pads without a hole. In
majority of cases this is a mistake in SMD pattern, please check if pads do really have the
surface type selected.

8. Undefined pins — some pins have "Undefined" electric property.

9. Pin superposition ? some pins superimpose on the symbol, in majority of cases this is a
mistake made while placing the pins.

To see details (list of components and pins) press |_| button next to the corresponding
mistake. You can save the list of errors can as a text file.

Save changes and close the Component Editor.
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4.2.10 Placing parts
Schematic

Open the Schematic module, i.e. go to "Start \ All Programs \ DipTrace \ Schematic" in the
Windows OS or use the DipTrace Launcher if working on MacOS. Select My Library from
the User Libraries library group. Place a couple of resistors and capacitors to the design
area. Just left click on the component on the Place Component panel and left click on the
design area. If the origin is shown, press "F1" to hide it. Usually you don't need the origin point
for designing schematic.

Notice that you can place components using "Objects \ Place Component" dialog box or with

I

the button on the Objects toolbar.

Notice that colors of components, selections, etc., depend on the color template and user
preferences.

Multi-part component placement

Library Tooks > Select multipart component (ANdNot4X). DipTrace always shows that
Fiter Off | current component is multi-part or net port in the symbol preview field on
RES 400 -1 the Place Component panel (<the number of parts> or "Net Port" text).
CAP ) We have created AndNot 4X with four similar parts and a power patrt.
oL "I You can place all parts as a single item or each part separately, use the
I
poiesnaon Al Parts ’ button. Switch to AN(4) to place each
AN () *l component part one-by-one or PWR to place only the power part. If Auto
YIAuto PURIGND .| PWR/GND item is checked, component's power part automatically
appears on the design area when you place the first logic part of
—& ‘ component.
. Select AN(4), leave Auto PWR/GND checked, and place AndNot4X

component part by part. The DipTrace automatically selects the next
part from the part group and places the power symbol for the
component.

Notice that program will automatically switch to the next part, when all parts had been placed.
Make sure you place parts only with RefDes from 1.1 to 1.4, like on the picture below.
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A Schematics E@
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RES400  +f - DesgnMenager 5[] L
CAP
vee = AR AR AR AR Soool |cL-auF-cap
oo SRR C1o C2 SRR S fé';kﬁf}qdisiéx
AndNotaxX__ ISR YIS T P P 1 - Andno
CraT=rr—— E—| _____ E—| e R SRR S0 o[ KL2- Andiotsx
AN (4) ’ L . P . C e . C e e . C e e . . . IC14-AndNDt4X
) Auto PWR/GHD B a2 e BTSRRI
G o & |y etla g asla ], MIGE R
o S N1 SRR S NN BN S N oo
& USRS
[o—a
] R ol ol ol ol S Part Pins:
14 e €4
= vee =& |45
g g ............ 7] ao | 1] pEa
I S ND- 1
ook el b
o o S N NN
o it e .
Q s} -
' Sheet 1/ N ¥
X=-02in ¥=195in
AN (4) b AlPars As you can see the similar parts of the multipart
7] Auto PVR/GND V] ANE) component are already grouped inside the part selection
s PR drop-down list. Select "View \ Group Similar Parts" from the
2 main menu to ungroup parts. If this item is checked, all
] S logic parts of the component (AN(4) in this case) will be
B grouped inside the All Parts pop-up menu. If unchecked,
you will be able to select and place each AN part
separately.

Connection via net ports

Make sure that you have two complete AndNot components on the design area (IC1 and IC2)
with two power symbols. Now we'll try to use the net ports. Select VCC and GND net port
symbols from the library, and place two of each to the schematic. Connect pins like on the
picture below.

Notice that two wires connected to the same pins of the same-type net port are connected to
a single net automatically.
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P el s
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D || ek 3 B o |8 @ & @ - s - %+|ﬂ]}m|1h%c‘m‘@:@1m
Place Component 4) . o D - Properties
IC1.2 IC1.3
User Components P | - : | %
. e &
. E—t & —
I - to T pEe T e
. —a —3 .
Library Tools Mo T e IC1.4
; e [P n
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| RN * o BN | R ® o 1C2 - AndNot4X
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- L o Part Pins:
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& | .
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NO Pattel’n ...............
" Sheet 1/ a 3
Net 0 X=-1TFin ¥=-035in

To rename net which connects VCC pins, right click on the wire, and select the first item
from the submenu or right click on the pin, and select the Net Name.

Notice that you can change part names directly in Schematic (on the Component
Properties dialog box).

Schematic allows the user to:

1) Connect pins to nets without wires (right click on the pin, select Add to Net, then select
net, check Connect without wire, and press OK);

2) Merge nets by name (check Connect Nets by Name checkbox in the Net Properties
dialog box);

3) Connect pins to the net with similar name automatically (check Connect Net to Pins by
Name checkbox in the Net Properties dialog box). The last method is the fastest way to
connect VCC, GND (if you plan to hide power nets and parts), CLK, etc. More information
kati@ in this tutorial. Close the Schematic. Do not save the changes.

PCB Layout

Open DipTrace PCB Layout module, i.e., go to "Start \ All Programs \ DipTrace \ PCB
Layout” on Windows or use the DipTrace Launcher on MacOS.

As you already know, correct component always includes at least a schematic symbol (for
Schematic) and attached pattern (for PCB Layout). Schematic works only with symbols,
while PCB Layout allows to select component libraries and place component's patterns on
the board. If you have selected component library and there are components without
attached patterns, you can not place them on the board. Notice that there is the Patterns
library group for convenience, which allows the user to place patterns as separate entities (no

© 2016 Novarm Software



154

DipTrace Tutorial

schematic symbols attached).

Select User Patterns library group and My Libraries (Patterns) library. You will see that all
three patterns that we have created during the lessons of this tutorial are available here. Now
select My Library from the User Components library group. As you remember, we did not
attach patterns only to net ports, therefore we can not place them on the circuit board in the
PCB Layout. All other components work just fine, because they all have attached patterns.

Place all components of the library to the design area, excluding the VCC and GND (select
component on the Place Component panel and left click on the design area to place it), then
return to My Library (Patterns) from the User Patterns library group and place BGA-
144/13x13 pattern, which we did not attach to any of the symbols, therefore it is not available
in the component library.

Change common marking settings to show RefDes and Name ("View \ Component

Markings \ Main \ RefDes" and "View \ Component Markings \ Additional \ Name"). For
individual customizations, right click on the component, select Properties, select the Markings
tab. You might need to justify texts in the "View \ Component Markings \ Main (Additional )\
Justify \ Auto" main menu item.

Select Bottom Side in the drop-down list on the Objects toolbar if you want to place
components on the opposite side of the board. For existing components you can change side
with the right-click submenu. For example, R3 resistor is on the bottom side (see the picture
below).

< PCB Layout (=0 =R
File Edit View Objects Placement Route HighSpeed Verification Library Tools Help
Dﬁn|§@30‘g{,E|nn|@Q@354%vl.27mmv @ ac [ Top Assy - @‘59%:;“
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"R2" ;
NIl RES 406 " RES 40| opimicReds S ] Ree 3
oo e oo R4 RefDes Renumbering... |~ £11i] Valve: 47k
o‘:ln o nl:l s S SYTEEN I Namme: RES 400
. @G-P 83‘;-] S RES 75 ST Pattern: RES 400
o i .. ... .RES. B LockSelected  CirleL AL S
Change Side « 2555
LibraryToo\s | IR C1 . . 02 S . Rotate R \2. P P v 54.61
Fiter OFf v, . o Define Angle = Angle: e
s S S u Rl L BT Marking 1: Defaut -
CCRB L UCRB D119 rdepsdRngsintayer | D Marking 2: pefeu -
Y e EnnooT
o Replace Component... ) _
e Updatefrom Library ~ * |. . | R IETNLIEE & @H’
Save to Library 3 R1 - 47k - RES 400 -
: 0 S : T R2 - 47k{ - RES 400
C Ungreup Component C ] o R3 - 47kQ - RES 400 L
0 . (R— o R4 - 47k - RES 400 3
o e *[24K20 | |a-aE-ow
BGA-144/13x13 Ar Snap to Grid ¥ C2 - 2pF - CAP
1C1 - AndNot4X A
#  Cut Ctrl+X B Component Pins:
- cutec e
> Delete Del
30 Model...
L. L. L. B L. padpropet‘esm R
“ [ »
Properties... |
R2 (47k0) X=-35.56 Y=54.51 ¥=-3175mm  ¥=5588 mm

You can change pad properties for the separate pad or entire component's pattern directly in
the PCB Layout. Let's change one of the resistor pads. Hover over the pad you want to
change (it should be highlighted), right click it, and select Pad Properties from the submenu.
In the pop-up dialog box uncheck the Use Pattern's Pad Properties checkbox for custom
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pad settings or press Pattern's Pad Properties button to change default pad settings for the
pattern. To edit pattern pad properties, right click on the pattern (not the pad) and select Pad
Properties from the submenu.

< PCB Layout (== =]
File Edit View Objects Placement Route High Speed Verification Library Tools Help
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Place Component 4 e A - ,—|—|m
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o RES€ﬂ4@@ o o 8@¥R4239 MNote: 2 Value: 47k
: o F_— i o T 1 MName: RES 400
o Pad Properties - R [E=gfen’s Pad Properties pattern: RES 400
88+ T mE - Pattern”s Pad Properties... Additional:
- . X -53.34
Library Tooks 4 C1 Type: Surface - |ptvTor  Current pad - ¥ 54.61
Fitter Off | I Angle: 0
o ’ Points - — — Marking 2: Defauk =
c Width: 2.032 mm
Height: 1.499 mm ) o o Design Manager ] @g
. o L C1 - 20F - CAP -
=rE C2 - 2uF - CAP
Shape: 0 E R 1C1 - AndNot4X L
.. .. ¥ Round . Lo BT 1C2 - PIC18F24K20 3
= - R1 - 47kQ - RES 400
BGA-144/13x13 . . LEUREE 0.762 mm PICIBF 24K20 . = . R2 - 47kQ - RES 400
- - — e R3 - 47k - RES 400 -
0,991 mm
Component Pins:
[T Apply To Al Pads
“ »
R1:2 (2) X=-48.26 Y=54.61 K=-48.26 mm ¥=54.61 mm

Notice that if pattern's origin is different from the pattern's center position, the software will
show it while placing that pattern.

You can show / hide the pattern origin for all selected components: right click one of them,
and select Pattern Origin from the submenu. Try to rotate different components and you will
see that the pattern origin is actually the center of rotation. When hovering over the pattern
you will see the coordinates of the pattern, which are actually the coordinates of the pattern's
origin.

PartV: Other features and tools

This part of the tutorial includes the description of important DipTrace features not reviewed
above. We consider that the reader already knows how to accomplish basic tasks in
DipTrace, therefore we can move on to more complex stuff.

5.1 Connecting

5.1.1 Working with buses and bus connectors

Now we will learn how to use buses and connect sheets with bus connectors in the
Schematic. You can work with the circuit from the previous subsection of this tutorial or
create a new schematic with random components for practicing.

Create a bus
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Select "Objects \ Circuit \ Place Bus" from the main menu or press I= button on the
Objects toolbar, then draw a bus line on the design area by defining its key points. Right click,
and select Enter to finish bus placement. Right click on a free space to switch to the Default
mode. Hover over some pin with the mouse, left click it, and move the mouse pointer to the
bus, and left click again to create wire.

In the pop-up dialog box you can define the name of a new net or connect wire to one of
existing nets (which are already connected to that bus).
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Symbols EIC
1 2 N
Net Ports il = ’\/\/\,—a O
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Undo (U
Fitter OFff - Add To: uew Het] '
CAP i Bus Nets: Net 0 Design Manager ] L
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. . . . 1 Part Pins:
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We didn't connect wire to existing net, this is why we have seven separate wires-nets (Net 0
— Net 6) not connected to each other via the bus. Fortunately, you can change the wire-to-bus
connections at any given moment, just move the mouse cursor to the wire segment
connected to the bus, right click, and select Bus Connection from the submenu.
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In the pop-up dialog box connect Net 6 to Net 2 (select Net 2 from the list of the bus wires).
Now there is no Net 6 anymore. We have a single Net 2 connected via the bus.
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Add new sheet to the schemaitic, select "Edit \ Add Sheet" from the main menu or press
"Ctrl+Ins" hotkeys. You can see the list of sheets as tabs at the bottom-left corner of the
design area. Select Sheet 2. Multi-sheet and hierarchical structurel1s| will be described later
in the corresponding section of this tutorial.
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You can rename, move, delete, or insert new schematic sheets, right click on the sheet in
bottom-left of the design area and select appropriate action from the submenu.

Bus connector

Press = button on the Objects toolbar and place the bus connector on the Sheet 2 (it
should have "Port 0" name), then select Sheet 1, and place one more bus connector there (it
will be "Port 1" automatically). Now connect existing bus to the Port 1 connector: select the
bus tool, left click on the bus and draw the line to the bus connector (blue circle in the center
of the connector) and left click it to finalize.

Notice that bus connector glows green if the bus is properly connected to it, blue circle
means that there is no connection.
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Notice that two bus connectors on different sheets are still unconnected (they should have
the same name in order to be connected).

Rename Port 1, hover over it with the mouse cursor, right click it, select the first item from
the submenu, and rename bus connector to "Port 0" (as you remember we've placed "Port 0"
on the Sheet 2). Press OK. You can see that the box has appeared around the port's name.
This means that current bus connector is connected to another bus connector. In our case
connector from Sheet 1 is connected to connector on the Sheet 2.

Notice that designer can connect more than two bus connectors by defining the same names
to all of them.
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Select Sheet 2, and create a bus connected to the Port 0.

Notice that the name of the bus on this sheet is the same as on the first sheet, i.e. this is a

common bus. Now you can place random electronic components on the second sheet (for

example AD1317 from Analog Devices library) and connect their pins to the nets on the first
sheet via the bus.
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5.1.2 Working with net ports

We tried to use the single-pin net ports beforefisllin order to create VCC and GND
connections. This is the most common application of such components in real-life, but
sometimes multi-pin net port is a more comfortable design solution.

Make sure there are unconnected pins on the Sheet 2. Select the Net Ports library from the
Components library group on the Place Component panel, find Port 8 component, and place
it on the design area.

Make connections from the component pins to the pins of the Port 8, then place one more
Port 8 component to the Sheet 1, and connect it with some nets. Notice that net names
connected to the same pins of Port 8 on Sheet 1 and Sheet 2 are the same, i.e. all wires
connected to pin 1 of the Port 8 are connected to a single net, the same with other pins. You
can connect or disconnect ports (i.e. change schematic structure) by renaming them.
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Connecting without wires

As you already know DipTrace allows the user to connect pins visually (wires, buses) and
logically (without wires, by name, with net ports).

Connecting pins without wires

You can connect pins logically without wires. In this case pins don't depend on the sheet or

part location.

Hover over selected unconnected pin with the mouse, right click it, and select Add to Net
from the submenu. In the pop-up dialog box select net from the drop-down list, and check
Connect without Wire checkbox, then press OK. On the picture below you can see two
pins connected without wires.
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Connecting pins by name

Now find a blank spot on the design area, where we will try to connect pins to the net by
name. Place a single GND symbol from the Net Ports library, and create a small wire from
the GND's pin. Move the mouse a bit upwards, and press Enter, like on the picture below, to
create a wire segment. Now right click on the wire segment connected to the GND net port,
and select Properties from the submenu.

In the Net Properties dialog box rename net to "GND", and check Connect Net to Pins by
Name checkbox. Press OK to apply changes.

DipTrace will automatically connect all unconnected pins with corresponding name to this net.
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Select Analog Devices library, and findlissl AD1317KZ component (press
Fiter Off 4 " " - -
button, type "AD1317" into the name field and press Apply Filters).

Place several AD1317 components on the design area or copy them if you already have one.

Notice that all GND pins of placed component are automatically connected to the GND net
without wires due to active Connect Net to Pins option in the Net Properties dialog box.
This feature is the easiest way to connect pins with the same names for entire schematic.
Usually applied to POWER, GND, CLK pins or even data buses.
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Connect nets by name

DipTrace allows the user to connect nets on different sheets without net ports or buses.
Remember the name of some net that you have on the first sheet (for example, Net 3), then
go to Sheet 2, and right click on the net you want to connect to Net 3. Then select Properties
from the submenu, type in "Net 3", check Connect Nets by Name checkbox, and press OK.
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This feature works like a regular net renaming. When you enter the net name that already
exists anywhere on the schematic, DipTrace will ask if you want to connect these nets by
name.

Notice that you can not connect nets by name on different levels of hierarchy.

For hierarchy you can create global nets. We will learn how to use them later in the
Hierarchical Schematic[213 topic of this tutorial.

Connection Manager in Schematic and PCB Layout

Connection Manager is another DipTrace tool which allows the user to create / edit / delete
connections in Schematic and PCB Layout. Select "Objects \ Connection Manager" from the
main menu in Schematic or "Route \ Connection Manager" in the PCB Layout.

Open connection manager in Schematic. Select net from the drop-down list and you will see
all pins of selected net. You can easily add / delete pins to / from the net. To add new pin to
the net, select the component and its pin with the corresponding drop-down lists, and press
Add button. Notice that only unconnected pins are available in these drop-down menus, so if

you can't find the pin that you need, it is probably already connected to another net. Use |L|
button to create a new net, |_| button to rename current net, and |£| to delete it.
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Press OK to apply changes and close the Connection Manager or press Cancel to close it
and recover the old net structure.

5.2 High-speed differential connections

5.2.1 Create a differential pair

Differential pair signaling is the method of transmitting high-frequency signals using two tightly
coupled tracks on the circuit board. One track carries the signal and the other one carries an
equal, but opposite image of the same signal. Differential pairs are EMI immune, they
generate less noise than single-track connections and, basically, are the only acceptable way
of transmitting information at high speed.

Open DipTrace Schematic and go to "Objects \ Net Classes" from the main menu. In
DipTrace all differential pair parameters are governed by net classes and the program does
not allow the user to create differential pairs outside them. We need to create a new special-
type net class for differential pairs. Press Add button in the Net Classes dialog box, then type
in the name of the net class (for example, "Diff_Class_1"), and change Type to Differential
Pair. Now you can enter specific differential pair routing parameters.
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Enter the trace width for tracks of the pair, primary gap between the tracks, and clearance to
other objects on the PCB (for example, 0.009 inch, like on the picture above). You can leave

default values in other fields. Notice that the net class is empty (because the design is empty
itself).

Press OK to close the Net Classes dialog box and apply changes.

Now we need to populate our schematic with components of your choice for practicing with
differential pairs. We have Atmel AT49BV320S flash-memory module and a bit-obsolete
Altera EPM7096QC100-10 CPLD chip on the design area, but differential pair declaration can
be assigned to any nets between any components. Create two nets which will eventually
become a differential pair. For example, we have Net 0 connecting A3/D1 pin to pin#14 and
Net 1 connecting A9/C3 to pin#15.
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Now press | | button or select "Objects \ High Speed \ Define Differential Pair" from the
main menu. In the pop-up dialog box specify the positive and negative net of the differential
pair. For example, we select Net O in the Positive Net drop-down and Net 1 in the Negative

Net drop-down. You can also pin point nets directly on the design area by pressing ¥ or

¥ puttons and left clicking on the nets or their pins.

Since we have only one differential pair-type net class, the program automatically assigned
Diff_Class_1 to this differential pair. Net class properties are right below. Press Edit Net
Classes if you want to open the Net Classes dialog box and change differential pair
properties.
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Press OK. Net 0 and Net 1 are a differential pair now, these nets are renamed to DiffPair_P
and DiffPair_N respectively and marked with a special symbols on the design area. You can
hover over one net with the mouse and the other net of the pair will highlight. You can display
net names on the design area if you right click on each net, and select Display Name from
the drop-down submenu.
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Now let's switch this design to the PCB Layout stage and practice more in customizing,
routing, and verifying differential pairs. Proceed to the next topic of the tutorial.

5.2.2 Differential pair routing / editing

Notice that built-in DipTrace autorouter does not support differential pairs. We recommend to
route these nets manually or with external autorouters.

Select "File \ Convert to PCB" from the main menu in DipTrace Schematic and proceed with
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the schematic rules. In PCB Layout move components closer together. You can see that
differential pair is also marked with a special symbol, like on the schematic. You can see that
ratlines are twisted, it's possible to route the differential pair like that, but it would be much
easier to rotate U2 pattern to eliminate the twist. Select the component, and press "R" hotkey
two times to rotate the component 180 degrees. Now we're almost ready to start the routing,
but first we need to go to Net Classes dialog box to check if we have acceptable routing
parameters. Select "Route \ Net Classes" from the main menu, then select Diff_Class_1 net
class.

Differential pair routing parameters. DipTrace allows the user to specify various
differential pair routing parameters. DRC takes these values as routing constraints when
verifying the PCB. You can specify maximum uncoupled length for two traces of the
differential pair, length tolerance between the traces, dynamic phase tolerance (length
difference between the corresponding segments of each track) and phase error length, which
means that DRC will report any phase shift as an error only if it occurs on the track segment
longer than the Error Length value. Let's change Dynamic Phase Error Length to 0.3 inch.
Leave default values in other fields.

Since we have some small-pitch BGA footprints on the board we can estimate that our
differential pair with 0.009 inch wide tracks, gap, and clearance is too big to route. DipTrace
allows the user to define neck parameters, which can be easily applied to differential pairs
while routing in tight spaces. Press Neck Parameters button.
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In the small pop-up dialog enter 0.004 inch width and gap, and 0.1 as the maximum neck

length. This means that necked segment longer than 0.1 inch will be reported as an error by
the DRC. Press OK to apply neck parameters, and then press OK to close the Net Classes
dialog box.
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Let's create one more differential pair directly in the PCB Layout. First we need to create a

N

couple more nets with Place Ratline tool . For example, like on the picture below.

Then press Define Differential pair button (" on the High Speed toolbar). Define
Differential Pair dialog box will show up (this dialog is the same as in the Schematic
module), pin point the positive and negative nets, change color for convenience (blue in our
case), and apply the same Diff_Class_1 net class to this differential pair. Press OK and the
second differential pair with custom color appears on the design area.

Now press > button on the Route toolbar, or go to "Route \ Manual Routing \ Add Trace"
from the main menu and left click on any pad of the differential pair, two tracks will start to
appear simultaneously. Routing a differential pair is very similar to routing a single net(so).
Ratlines show the direction where to lead the traces. Continue from the U1 component to the
U2, and left click on the corresponding U2 component pad. The second trace of the pair will
be automatically connected to another pad. You can change routing layer, route mode,
current trace segment and other routing parameters on the Manual Routing panel (on the
Design Manager), with the corresponding hotkeys (noted in the brackets on the Manual
Routing panel), or with right-click submenu on the go.

If you want to change active trace of the pair that you route, select Change Control Trace
from the right-click submenu while routing.
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Single-track routing

In real life you will more often face more complex layout situations. Press > button on the
Route toolbar, or go to "Route \ Manual Routing \ Add Trace" from the main menu, then
change Current Segment to Free Line on the Manual Routing panel (press "S" hotkey two
times) and start to route the differential pair from U1 to U2. You will notice that BGA pitch is
very small and now is the time to apply the trace necking defined earlier in the Net Class
properties. When approaching the U2 left click to place the trace segments, and then right
click, and select Neck-down Segment from the submenu to reduce the width of two tracks
and the gap between the traces according to neck parameters. Left click again closer to the
U2 component to create a small narrow segment (orange traces are routed). Now the tracks
are small enough to fit the BGA's pitch, but you still can't finish routing the pair automatically,
hover over the terminal pad to see that the traces offered by the program are unacceptable.
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Routing each trace of the differential pair will allow you to succeed in this situation. Right
click, select Route Single Trace from the submenu or press "Z" hotkey, then change
current segment to regular lines with 45-degree angle on the Manual Routing panel, or just
press "S" hotkey, then left click on the terminal pad of the trace. DipTrace will switch to the
second trace of the pair for routing. If you want to change the trace of the pair that you route,
select Change Control Trace from the right-click submenu. Left click on the second pad to

complete the differential pair.
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Controlling the trace length

Controlling the total length of each trace is very important for successful high-speed routing.
Right click on any trace of the differential pair, and select Show Trace Length from the
submenu, the total length of each track of the differential pair will appear right next to the pads
of the differential pair in current measurement units. To hide the trace length, select the same
item from the same right-click submenu again. In our case the trace length is hidden to keep
design more empty and easy-to-understand.

Edit differential pairs

Right click on the differential pair, and select required action from the submenu. You can
unroute tracks or separate segments, change color of the differential pair, layer of the traces
or segments, delete differential pair declaration from the nets, remove necking, and much
more. There are two distinct editing modes applied to differential pairs: regular editing and

single track editing. Each one can be in a regular or free style. For example, press A
button on the Route toolbar, then drag and drop differential pair's traces to another location.
Notice that two tracks move with respect to the differential pair gap. You can also use the

by

Free edit tool ( button) in some situations.
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5.2.3

The other mode is similar to single-track routing, because it allows the designer to edit each

trace of the differential pair separately from the other. Press — button on the High Speed

toolbar, and move one track of the pair further away.

Single-track free edit mode ( — button on the High Speed toolbar) behaves in the similar
way to the regular Free edit mode, but applies only to one trace of the pair. You can practice
more with differential pairs and change the layer of the trace segment. Right click on the
longest differential pair's segment, and select "Segment Layer \ Bottom". Two traces will
move to the bottom layer. Vias will appear automatically.

Please undo the last changes to return blue differential pair to its initial state, then proceed to
the topic below for Differential Pair verification.

Verification and phase tuning

In our case we have Real-time DRC OFF, this is why we do not see any errors on the design
area. Turn it ON, and run DRCI731in the regular mode to see the error-report dialog box. DRC
checks all clearances and sizes against target values defined in the "Verification \ Design
Rules" main menu item. DRC also takes differential pair properties from the Net Classes
dialog box as design constraints. In our case we have three errors related to the differential
pair. When you click on the error in the list you see the description of each violation, including
current and target values. Rule Details section right below the list shows where you can
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change the target values.
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Move the DRC Error-report dialog box a bit, so it will not obstruct the view. First of all lets
make the necked differential pair segment a bit shorter, as we can see only 0.1 inch is

allowed by the necking constraints in the differential pair net class. Press Edit Traces Al
button on the Route toolbar, then hover over the place where traces become narrow, the
mouse cursor should appear as left-right arrow parallel to the traces. Then drag and drop
wide traces closer to the terminal pads to make necked traces shorter, like on the picture

. . & .
below. You can apply single-trace editing tools (for example | — ) from the High Speed
toolbar, if you can't succeed without an error while moving two traces simultaneously.
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Now only two errors left. The first error says that one trace is much longer than the other, the
second error reports that we have phase tolerance violation and it happened on the segment
that is longer than Dynamic Phase Error Length value in the Net Class parameters. We need
to make the shorter trace a bit longer and fix the phase shift. Since our differential pair is
almost the straight line, there is a chance that we can fix both errors at the same time with

the Phase Tune tool. Press button on the High Speed toolbar or go to "High Speed \
Differential Pair Tools \ Phase Tune" from the main menu. In the pop-up dialog box you can
check which track needs the phase tuning. Hover over the bottom track of the differential pair
with the mouse cursor and review Point Phase Lead values that will appear in the Phase
Tune dialog box, then hover over the upper trace — the violation is highlighted in red.
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In our case we see that the signal in the upper trace is a bit faster than in the lower. Left click
on the upper trace to create a meander, which will make the trace a bit longer.

By default a meander is approximately 3X the trace width. Check Custom Meander Size
checkbox and type in the new value into the Length Increasing field if you need bigger
meanders. In our case default meander works fine and the error-report dialog is now empty.
You can hover over the trace segments with the mouse and find out that while the segment
closer to the Ul is OK, the segment right next to the U2 component still has a backward point
phase lead violation, but DipTrace does not report it as an error, because the segment is
shorter than Dynamic Phase Error Length value in the Net Class parameters. This means
that we have a phase shift, but it occurs on the relatively short trace segment, which doesn't
matter for our project. Now you can close the DRC error-report box and switch to the Default
mode.
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5.2.4
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Differential Pair Manager

If you have complex design with a lot of differential pairs it becomes hard to manage them
directly on the design area. DipTrace has Differential Pair Manager which allows for easy
managing / editing / deleting differential pairs. Select "High Speed \ Differential Pair Manager"
from the main menu. In the pop-up dialog box specify the exact net class in the Net Class
drop-down to display only the pairs of the net class, or select All Classes to show all pairs
of the design in the list right below. However, this does not make any difference in our case,
because we have only two differential pairs of the same net class.
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Press Add to open Define Differential Pair dialog box and create a new differential pair, or
select existing one from the list and modify it's name, color, nets, net class etc. Right below
you can see the Class Properties and Pair values if this differential pair is routed. Red-
highlighted value is the violation. In our case Phase shift on selected differential pair is bigger
than the tolerance, but it is not considered an error unless there is a Phase Error Length
violation.

Define paired pads

On very rare occasions for the circuit boards with lots of various differential pair pads very
close to each other, DipTrace might not be able to draw two traces and finish routing. In this
case you will get a warning message that offers to use Define Paired Pads feature.

Warning @

!._ The pad is not paired. Completing differential trace is impossible!
To change this: cancel routing, right click on pad/trace and choose

"Define Paired Pads".

Here is a typical situation. We have R6 and R10 pads that belong to the negative net and
R11, R7 pads from the positive net of the differential pair. It is possible that the software in
such case can terminate the second trace on the R7 pad (not on the R11), or either drop the
warning message.

© 2016 Novarm Software



182 DipTrace Tutorial

R6
CN2 o

"O'l R10
O

. -
| =%

L]

[]
1 Ic14
| O. . R11 L
C13

To fix this issue, you need to group the pads. Go to "High Speed \ Define Paired Pads" from
the main menu. In the pop-up dialog box use the Differential Pair drop-down list to select the
pair. You can press Update button to let the program find pads automatically, or check
Manually checkbox and define the pair of pads using the lists right below.

We have one pair of pads on the side of the CN2 connector (CN2:3 and CN2:2). Select R11:2
from the Positive Net list and R10:2 from the Negative Net list, because we want the
differential pair to terminate on these pads. Then press the left arrow button to add selected
pads to the Paired Pads list, and press OK to apply changes.
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Now route the differential pair. Everything works fine, because the software clearly knows
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5.3

where you want to connect the differential pair nets. Finally, draw two traces from the R6 and
R7 pads to their respective nets.

RE
CNZ2 [] ]

'-O-l R10
-

R7 C13

Reference Designators

Now we will work with schematic examples located in "Documents \ DipTrace \ Examples"
folder. Open Schematic_2.dch file.

This project demonstrates applications of various DipTrace features. However, we will
experiment with some basic principles of working with Reference Designators in the
Schematic.

Current Schematic contains 23 capacitors from C1 to C24 (C19 is missing).
Optimize RefDes

While editing a principal circuit, sometimes you need to insert or delete components. Let's
add capacitor to the schematic, select CAP component from the My Library or Discrete
SMD library and place it on the design area. We want "C5" RefDes for this component, but
the software automatically assigned the "C19" RefDes, because C19 was missing and C5
existed on the schematic. Change the RefDes, right click on this capacitor, and select the
first item from the submenu, enter "C5", and press OK. The warning message suggests to
rename the component and shift the RefDes numeration, press Yes.
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C19 capacitor is now C5 and the old C5 became C6 and so on till C18 capacitor which is
C19 now. See the design manager panel to the right to find out that C19 reference designator
is not missing anymore, because you've inserted C5 and C5 — C18 RefDes indexes were

g

shifted ( use button to sort the components in the list). Now we have correct array of
RefDes indexes for all capacitors.

Now rename the C5 capacitor to C30, then check the list of capacitor designators on the

Design Manager ("Ctrl+2" to show/hide the Design Manager, press button to sort the
components in the list) — C5 and capacitors with C25 till C29 indexes are missing. To correct
this issue, right click on any capacitor, and select Optimize RefDes, then select RefDes
"C" — C30 becomes C24. The reason is simple — while optimizing the RefDes, DipTrace
removes all empty places in the designator index array, therefore C6-C24 become C5-C23
and C30 becomes C24.
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RefDes renumbering

But what if we need to renumber Reference Designators in a very easy way that makes it
simple to navigate through the schematic? Select "Tools \ RefDes Renumbering..." from the
main menu. In the pop-up dialog box do not change the First Index (starting point of
renumbering) and Page Step (if page step = 100, the designators on the second page will be
R101, R102, IC101, etc.). Now specify the renumbering direction: in rows or columns, and
choose how DipTrace is going to count components while renumbering. There are
components of different sizes and shapes. If we choose Top-left in the Component
Position section of the dialog box, DipTrace will renumber components, based on the
position of the top-left corner of each component. If you choose Origin the software will use
component origins to determine its position.

Notice that renumbering always goes from left to right and from top to bottom of the circuit.

Press OK to renumber all components.
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If you need to renumber only the designators of components of selected type, right click on
one of the components, and select RefDes Renumbering from the submenu. You will see a
typical RefDes Renumbering dialog box, but this time you can apply renumbering to current
RefDes.
RefDes Renumbering works the same in the PCB Layout.
Close DipTrace Schematic without saving progress and launch the PCB Layout module.
5.4 Renew layout by schematic

Sometimes electronic designer needs to make important changes to the circuit board, for
example, add new net or component. We always recommend to start implementing those
changes in the Schematic, but they do not automatically appear in the PCB Layout, you need
to launch Renew Design from Schematic to automatically update existing circuit board
according to the schematic.

If you have made changes in the Schematic and want to bring them to PCB Layout, select
"File \ Renew Design from Schematic” from the main menu in DipTrace PCB Layout, then
select one of available renewing modes:

1) By components means using the hidden IDs to determine component-to-pattern links —
this mode works only if the circuit was created in DipTrace Schematic. Renewing by
components doesn't depend on Reference Designators, therefore, they can differ in the
schematic and on the PCB.

2) By RefDes means that component-to-pattern links are determined only by Reference
Designators. Components must have the same reference designators on the circuit board
and in the schematic.
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3) Related Schematic means renewing by components from related schematic file (go to

"File \ Layout Information” from the main menu if you don't remember the source-schematic
file).

Now select the schematic file, and press Open. DipTrace will keep component placement

and current routing on the circuit board, new components will appear near the board outline
ready for placement.

55 Back annotate

Back Annotation allows the user to update schematic according to the PCB file. This feature
is useful when you've made changes directly on the circuit board and want to keep the layout
and schematic synchronized. Use it with caution, because Back Annotation, unlike the
Renewing from Schematiches has certain limitations.

Launch DipTrace PCB Layout module, then open "PCB_2.dip" file from the "Examples”
folder. Use Design Manager to find C8 and C10 capacitors — double click on the component
name in the list to localize and pan design area to selected component. Change the
reference designators of C8 and C10 capacitors to C28 and C30 (right click on the
component, and select the first item from the submenu). Select "File \ Save As" and save this
PCB in another file, for example "PCB_2_verl".

% PCB Layout - [E\DipTrace\Examples\PCB_2_verl.dip] =N R 5
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Close the PCB Layout and open Schematic Capture again (notice that you can open it
directly from the PCB Layout by selecting "Tools \ Schematic" from the main menu.

Open "Schematic_2.dch" file and find C8 and C10 components. You can use the Design
Manager or press "Ctrl+F", then type in "C8", and press "Enter" to find the component. C8
capacitor will appear highlighted in the center of the screen.
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Notice that you can minimize the Find Object dialog box by clicking the arrow in its upper-left
corner and use this dialog while editing the circuit.

Zoom on the design area to see C8 and C10 components better. PCB_2 is the circuit board
related to Schematic_2, but as you remember we have renamed C8 and C10 capacitors
directly on the board. Of course, we can rename that components manually in the schematic
or use the Back Annotate feature.

Go to "File \ Back Annotate" from the main menu, and select the PCB file where we saved
modified copy of the PCB_2 board ("PCB_2_verl" in our case), then press Open. Now you
can see that all designators in the Schematic (in our case C28 and C30) are changed
according to the PCB.

Notice that net names and net classes are also back annotated from the PCB, but this
feature has limitation and is not capable to add new nets or components.
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5.6

How to find components in the libraries

DipTrace 3.0 includes 130,000+ components in standard libraries and we continuously
expand them. Components are sorted by manufacturers and by types. The cross-module
library management system with custom library groups and search filters allows the user to
seek through the libraries and quickly find what he needs.

Search filters

Go to "Objects \ Find Component” from the main menu in the Schematic or press

Fiter Off

»

filters.

Filter - Mot Applied
Search Area:

Search For:

Text Parameters

Mame:

RefDes -

Pattem -

Value -
Apply Fiter

Al Libraries

Components

CAPTOODAP
C
CAPP-17

button on the Place Component panel to customize the search

In the pop-up dialog box specify the search
area: all libraries, current library group or
current library, and type in the name or part of
the name of the component. DipTrace allows
for filtering components by RefDes, Value,
Pattern, Manufacturer, Datasheet or Additional

Fields. Press |L| or |_| buttons next to the
corresponding search filter to add or delete
the search filter respectively. Use the drop-
down list to select the search parameter.

As you can see on the picture, we search for
CAP700AP capacitor with "C" RefDes and
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CAPP-17 pattern.

Press Apply Filter and close the dialog box. You will see that only filtered components, which
correspond to the search filters are visible on the Place Component panel.

The state of the search filters is always displayed on the Place Component panel — "Filter
ON/OFF". To disable the search filters, open the search filters dialog box, and press Cancel
Filter.

Place component

You can find and place components with the Place Component dialog box ("Objects \ Place
Component" from the main menu in Schematic). There are two sections in the pop-up dialog
box: Libraries and Components. Select library group from the drop-down list, then select
library, and, finally, select component from the corresponding list. Press Filter ON/OFF
button to customize and apply the search filters.

"Objects \ Place Component” dialog box is similar in the PCB Layout.

For example, we need a component that contains "232" in its name, but we don't remember
the other characters, letters or even a possible library. Press Filter ON/OFF button, select
Search area: All Libraries, type in "232" in the Name field of the filters dialog box, and press
Apply Filter. DipTrace has found 274 components with "232" in their name. Components are
in the list right below. Select component and you will see it's schematic symbol or press
Display Pattern to see how it looks on the PCB.

Add more search filters to narrow the results.

Place Compenent @ Filter - Applied (274 Components ) =
Libraries Components Search Area: Al Libraries -
Components - [ Filter OM h-‘

Search For: Components

- MAX2324EUP -
Discrete SMD MAX2324EUP+ Text Parameters
Symbaols MAX2325EGI
Symbaols EIC E MAX2326EUP Mame: 232 4
MNet Ports MAX2326EUP+
Antennas MAX2327EUP
Batteries MAX2327EUP+ - ;
Buzzers MAX232ACPE Apply Fite Cancel Fitter |
Capacitors MAX232ACSE
Con Symbols MAX3I2AMNE i
Con Backplane —
Con Batteries Part: Part 1 e X
Egg gﬂsalrjdb In Auto PWR/GND S0IC-16/150mil
Con Edge Cards
Con Flat Flexible o] | —
Con Headers - L L
Con Jacks . -— -_—
Con Memory Cards — . -—
Con Phone Jacks o [r— fr—
Con Power | — —
Con RCA Jacks —| — —
Con RF & Coaxial i

-— -—
I Library Setup... J [ Display Pattern 3
[C]Place by Coordinates
X |0 in Y: |0 in

[ Place l [ Cancel I
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Press Place button and left click on the design area to place selected component or check
Place by Coordinates checkbox and enter exact coordinates where you want that
component. This dialog box has all necessary tools to work with multi-part components as
well.

57 Electrical Rule Check

Electrical Rule Check (ERC) feature is one of the main verification features in DipTrace. ERC
checks the circuit for pin type conflicts, unconnected and superimposing pins as well as one-
pin nets and short circuits.

Launch DipTrace Schematic and open Schematic_2.dch from the "Documents/DipTrace/
Examples" folder. Define electrical rules, select "Verification \ Electrical Rule Setup" from the
main menu. In the pop-up dialog box specify incompatible pin-to-pin connections and the
program's reaction to them (error, no error or warning, depending on the color) by clicking in
the grid cells with green, yellow and red squares.

Pin Type checkbox in the Rules to Check section means checking pin-to-pin connections
defined in the grid;

Not Connected Pins — the program searches for unconnected pins;
Pin Superimposing — the program searches for pins overlaying each other;

Only One Pin in Net — the program reports nets with only one pin, i.e. net that makes no
sense. It can be a potential error in the net structure;

Short Circuit — the program reports any connections between Power and GND nets. Let the
software know which net is POWER and which one is GROUND in the Power Pins for SC
section below.

Electrical Rule Setup @
Passive Rules to Check
Input Pin Type
Output Mot Connected Pins
Bidirectional [¥] Pin Superimposing
. [¥] Only One Pin in Net
Open Hah Short Circuit
Open Low
Passive High
Passive Low
3 State

Power

Power Pins for SC

223
- 5 B £ £ 8 Power: U
€2 .58 2228
ﬁ z 2 B g gs gﬂ 2 7z 8 z Ground: GMD*®
5 & £ @ o o & & m &
Run ERC [ i ” el

Press OK to close the dialog box.
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5.8

Now select "Verification \ Electrical Rule Check (ERC)" from the main menu. If you verify
"Schematic_2.dch" file, according to the rules from the picture above, you should get a lot of
error reports in the list: one warning for Bidirectional to Output connection and a lot of Not
Connected pin errors. To localize error on the schematic design area, double click it in the list

(or press Localize). You can fix errors without closing the ERC report dialog box. Press Run

ERC button to start verification again.
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ERC will not report errors for pins, which are intentionally unconnected. Right click on one of
these pins and select Not Connected from the submenu. Or you can uncheck the
corresponding item in the ERC settings dialog box, but then possibility of an error increases,
because all unconnected pins are now OK, even if it is not supposed to be that way.

Bill of Materials (BOM)

DipTrace Schematic module has the BOM feature that allows the user to customize columns
and rows, add tables or pages to existing project, export files to Excel CSV format or save the
Bill of Materials as a text file with appropriate table formatting.

Select "Objects \ Bill of Materials" from the main menu. There are two main sections in the
pop-up dialog box: Table Rows and Columns. Specify Group Rows by: Components and
adjust Row Height if you need.

Include Power/GND parts checkbox allows the user to include the corresponding parts to the
BOM file.

Include Net Ports checkbox allows for net ports in the BOM table.

RefDes by Open Hierarchy allows the user to show RefDes with hierarchy block prefixes.
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The other checkboxes help to add header, row number and total quantity.

Now add columns to the BOM file with the settings like on the picture below. Select the
corresponding item (Quantity) from the Show: drop-down list, and press Add button. You
can add or delete rows from the table. Press Set Font button in order to customize the font
settings. Use only TrueType fonts for Unicode characters.

Set: Create On: New Sheet(s) and Sheet Templates: A4 Blank. Check Adjust by Width
to stretch table according to the page width.

4 Schematics - [E\DipTrace\Bxamples\Schematic_2.dch]
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Press Place Table button to add new A4 sheet(s) with ISO title and BOM table to the current
project (several sheets for big projects or detailed BOM). Do not forget to check Display
Titles and Display Sheet in the View main menu item if you need.

Select Sheet 2 or Sheet 3. Notice that you can edit the row height, number of lines for cells,
alignment, font, etc., just left click the cell and make necessary customizations in the pop-up

dialog box.
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5.9
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Notice that you can place the BOM table to the same sheet as the circuit: set Create On:
Current Sheet, press Place Table and left click on the design area. If you have multi-sheet
schematic with many components, separate BOM possible.

If you need some columns that can not be inserted directly in the DipTrace BOM dialog box,
you can left click on the table on the design area and select Insert Column or Insert Row
from the submenu.

You can save the Bill of Materials into CSV-file or text-formatted table, just right click on the
existing table, and select Save to File from the submenu. Then you can open this CSV file in
any spreadsheets editor.

Importing / exporting netlists

DipTrace allows the user to import and export netlist files of various formats (Accel, Allegro,
Mentor, OrCAD, PADS, P-CAD, Protel, Tango). Netlist export can be used to review
schematic net structure or board design in other software.

Export netlist
To export netlist from the DipTrace Schematic, select "File \ Export \ Netlist" from the main
menu, select the netlist format, specify folder and file name, and press OK to save the netlist
file.
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...... 9
CAPPR-2.54/5.08
+oy + IL 2 . C
' Sheet 1/ a 3
X=-16in Y¥=33in

Import netlist

DipTrace PCB Layout allows for importing netlists created in other software. We will import
Tango netlist as an example. Launch the PCB Layout, create a new project, and select "File \
Import \ Netlist \ Tango" from the main menu, then select "tango_1.net" file from "C:
\Users\<UserName>\Documents\DipTrace\Examples" folder.

As you already know, all components are represented by patterns on the circuit board. The

first step while importing the netlist is to make sure that each component has its pattern.
Check all patterns in the File Components list:

RefDes column shows component RefDes in the netlist,
Name column shows component's name,
Pattern Name column shows pattern's name from the netlist,

Pattern column shows attached pattern in the DipTrace libraries, if it is blank, the component
does not have a pattern.

Press Add button to add new pattern libraries, where we will get the patterns that we need.
For example, add CAP_SMD library to find pattern for C 225 components. Add several
libraries at a time with "Shift" and "Ctrl" hotkeys. DipTrace standard libraries are in the "C:
\Program Files\DipTrace\Lib" folder and user libraries — in the "Documents/DipTrace/My
Libraries" folder by default.

Select library and press Assign all Patterns by Names — the software will find and assign
patterns with the corresponding names automatically. In our case DipTrace has assigned the
DO-41 patterns.
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Sometimes DipTrace is not able to find all the patterns, because of partially or completely
different pattern names in the DipTrace libraries and in the netlist. In this case the designer
should find and assign all patterns manually. Select component in the File Components list,
then select library and pattern from the respective lists. Now press Attach to Component
button to attach pattern to the component according to the component RefDes, name or
pattern name. For example, we have attached the CAP_2225 pattern to all components with
CAP 225 pattern.

< PCB Layout = [ = =]
File Edit View Objects Placem{| Attaching Patterns - E\DipTrace\Examples\tango_1.net (=2
0O = | S & Pattern Libraries File Components - ‘ |
Cap_(E:\DipTrace\Lib\Cap.lib RefDes  Name Pattemn Name  Pattemn -
[ | TF Top Side Cap SMD (E:\Dip Trace\Lib\Cap . i) - = £ &
CFP (E:\DipTrace\Lib\Cfp.lib) c29 C 225 CAP 225 CAP_2225
Place Component 4 Diodes (E:\DipTrace\Lib\Diodes.lb c30 CAP MKP CAP MKP - rs | Objects | Properties
o Resistors  (E:\Dip Trace\Lib\Res.lib) i 2
Components » TO (E:\DipTrace\Lib\T0.lb) 1 CAP MKP CAR MKP - b
- . € . Top Assy
= . (E\DipTrace\Lib\_General.ib) fock] CAP D10H5 D10 H5 - b i
- I oo sik
Discrete SMD fock] C225 CAP 225 CAP_2225* " Top Mask
Symbols c34 CAP 100 CAP 100 - B oo paste
Symbals EIC 35 CAP 100 CAP 100 - ¢ Bl o (1)
Net Ports [ oadd ][ pekte | |55 (o CAP 225 CAP_2225* L
Antennas - I sottom 2
[ Assign All Patterns by Names I 37 C225 CAP 225 CAP_2225 b B 2ottom pact
Batteries - ottom Faste
Buzsers ca8 €225 CAP 225 CAP_2225 L Bottom Hask
- Pattems of Selected Library 39 c225 CAP 225 CAP_2225* T )
Library Tools » CAP_1812 e c40 C225 CAP 225 CAP_2235* ] gottom Sik
o Chp 00 [car caos CAP 225 chp 2235 | f Sottom Assy
CAP_2005 . ' i
Fiter OFf d CAP_2010 D1 FR107 DO-41 DO-41 Board Qutine
A CAP_2213
CAP 2220 D2 FR107 DO-41 DO-41 Contrast -
CAP 2225
Chp 2611 D3 FR107 DO-41 DO-41
CAP_2815 D4 FR107 DO-41 DO-41 ign Manager E @ ey
CAPA-10/1.25%2x0.5 D5 FR107 D041 D041
CAPA-10/1.6x3.15%0.635
CAPA-10/2.1x4x0.8 il D6 FR107 DO-41 DO-41
CADA AN 1vA dvi 77 D7 ER107 DO-41 DO-41
[ Attach to Component ™! | pe 107 D041 D041 -
Pattern:
CAP-2.54/6.6%3
CAP_2225 -
ponent Pins:
T Library:
- o
;
X=1875 mil ¥=2250 mil

The star symbol (*) after the pattern name in the list means that this pattern was connected
manually.

Click Import button when all components have correct patterns.

Saving /loading design rules

In the Converting to PCB/29] topic of this tutorial we mentioned that you can use Schematic
rules or load rules from any PCB layout project, while converting schematic to the PCB. No
need to specify all layers, net classes, via styles, and design constraints again. Let's see how
it works.

Create a new layout, select "File \ New" from the main menu or press "Ctrl+N" hotkeys. In the
pop-up dialog box you can choose to create an empty layout or use settings from the
previous project.
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< PCB Layout (== =]
File Edit View Objects Placement Route HighSpeed Verfication Library Tools Help
0 & |§|§30‘ ] |QQ@Q39% v 2sml + | @ s [ Top Assy - ‘ |
[B]lm + | @ mosce - 84| 0 a @ BS |/ 8 ~&xE|)|v & wag - <&~
HET EE EE A || tavers | Objects | Properties
i e N N + I Top Sik
\/ Top Mask
+ - Top Paste
+ Il (1)
+ B =otom 2
R S SO SRS + Il sottom paste
SERNNIRn. W Bottom Mask
Lozt sl + I :ottom sik
Library Tools R
") Create an Empty Layout \/ - Bottom Assy
Fiter Off @ Use Rules and Settings from Previous Layout +/ Il so0arc Outine
. D:\Tutorial_2016.dip Browse o £ Contrast . m
. C..iiiiliiiiiiii]T Design Manager ;E@%
CAP-2.54/6.6%3 .
Component Pins:
< +
X=-9550 mil ¥=7175 mil

Check Use Rules and Settings from Previous Layout, press Browse, and select the *.
dip file of the circuit board that contributes its settings for a new layout. Press OK. In our
case we have selected the *.dip file of the project that we have created in the first paragraph
of this tutorial. Layer colors and some DRC settings were changed.

In the DipTrace PCB Layout you can save settings in the special file, separately from the
layout itself. Just go to "Route \ Save Rules" from the main menu, enter the file name, and
press Save. Now you can use rules and settings from this file while creating new projects.
Go to "Route \ Load Rules" and choose the *.dip or *.rul file.

Please add some via styles, new net class with random parameters, GND and PWR inner
layers and save this as a *.rul file. We will use it later in the Fanoutl12 topic.

5.11 SPICE simulation

DipTrace does not have a built-in simulator, but the program allows the user to define SPICE
settings and export SPICE netlist to any third-party simulation software. We will try to
simulate astable flip-flop schematicl 81 using LT Spice simulation software, which is free and
of a good quality. However, if you have another program that you use for simulation, you're
good to go.

Edit SPICE settings

Launch DipTrace Schematic, and open "C:
\Users\<UserName>\Documents\DipTrace\Examples\Spice\Astable Flip_Flop_Spice.dch"
file. We have already defined all SPICE settings for this circuit. However, let's review a couple
of the components just to learn how to work with the SPICE simulation. Right click on the C2
capacitor, and select Spice Settings from the submenu. Spice settings for capacitors are
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pretty simple: select Model Type: Capacitor, enter values into the parameters table (in our
case "22uF "), and specify positive and negative pins (enter values into the pin-to-signal table
on the left side of the dialog box, the list of available signals is right below). Notice that you
can enter parameters directly into the table cells.

The Template field shows how this component is represented in the SPICE netlist. You can
scroll that field to the right if it is long. Make sure that settings are like on the picture below.

4} Spice Settings - C2 EI@
Model Type: Capacitor -
MINUS +F‘LUS Function: none
Template: C_C2 N+ N- 22uF IC=0
Parameters
Parameter value
Pin Signal Value (Capacity, F) 22uF

IC (Initial voltage, V) 0

Signal:
Available Signals

M+
M-

- Get Spice Model from Library

Apply To:  Similar Parts of Component -

[ 0K ] | Cancel |

Select another model type (for example, Current Source). The user can specify function for
this model type. Use the Function drop-down list and select PWL(). In the pop-up dialog box
enter the number of points for PWL function, and click OK. Now you can enter the values for
each point in the Parameters table. Different functions require different parameters
(amplitude, phase, etc.). See detailed description in the SPICE language documentation.

Now return back to the Capacitor model type, and discard any changes, or simply close the
dialog box.

SPICE model

Capacitors do not require additional model description, but transistors do. Right click on the
Q1 transistor, and select Spice settings from the submenu. In the pop-up dialog box you
can see that there is the Model tab near the Parameters tab, select it. Now you can enter
the model text or load the SPICE model from external file (Load and Save buttons). Some
component manufacturers publish SPICE models for their components on the web.
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4J) Spice Settings - Q1

[}
B
)
Pin Signal
C(C) MC
E(E) ME
B (B) MB

Signal:
Available Signals

MC (collector)
MB (base)

ME (emitter)
NS (substrate)

[=]l® s
Model Type:  BIT -
Function: none
Template: Q_Q1 NC NB ME NS 2M4401 1 IC=0, 0 Temp

Parameters | Model
.model 24401 NPN(Is=26.03f Xti=3 Eg=1.11 Vaf=00.7

Load | | Save |

- Get Spice Model from Library |

Apply To:  Similar Parts of Component =

[ 0K l | Cancel |

Notice that you can get all SPICE settings from another DipTrace library (use Get Spice
Model from Library button). Click OK or Cancel to close this dialog box (discard any

changes).

There is no valid SPICE model for the power source (battery) in the Astable_Flip_Flop_Spice.
dch file, we should define it. Right click on the B1 component, and select Spice Settings
from the submenu. You can see that component has the Voltage Source model type, but no
valid function. Set: Function : PULSE(), then specify the following parameters in the table
below: Pulse V2=5, Pulse PW=20s, Pulse PER=30s. Keep other parameters, and press
OK. Now we have the voltage source that produces 5V during the first 20 seconds, then
there is a 10-second interval. Now everything is ready for simulation.

Spice

Commands

GND Net: GHD -

.TRAN Os 305 0.1

s

Export SPICE netlist

Select "File \ Export \ Spice Netlist" from the main menu. In the
small pop-up dialog box select GND from the GND Net drop-
down list. Specify: Commands: .TRAN 0s 30s 0.1s to simulate
the circuit from Os to 30s with 0.1s step. Notice that you can define
/ change commands directly in the simulation software. Click OK
and save the *.cir netlist file. Launch the SPICE simulator that you
have. We will use LT Spice as an example (download it at Linear

Technologies website).
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Select "File \ Open" and open the *.cir netlist that you just saved (notice that you should
select correct Files of Type). Now you can see the netlist in the text format. Select "Simulate
\ Run" from the LT Spice main menu, and close the error-log window. Select "Plot Settings \
Visible Traces", and choose I(D_led1) to see electrical current on LED1. This component
works during the first 20 seconds, then has 10 sec interval. Select other signals to see how
they work.

LT L Tspice IV - Astable spice netlist EI@

Eile View Plot Settings Simulation Tools Window Help

e d e # QAR ELd HeR s 2o M DS

[Z) Astable spice netlist £ Astable spice netlist

hﬁhstable spice netlist EI@

ID_led1]

95 125 15s 168

5

@ Astable spice netlist = || =) e
=xx Component Het List Start ===

mi »

0_01 Net_0 Met_1 Net_é6 2Mu481 1 IC=0, 0 Temp=25
0_02 Net_2 Met_3 Met_4 2Mu481 1 IC=0, 0 Temp=25

R_R1 Net_1 Het_5 47K

R_R2 Het_8 Het_5 47K

R_R3 Met_2 Net_5 1K

R_R4 Het_3 Het_5 47K -

4 1] F

Right-Click to edit expression. Control-Left Click to integrate

Checking net connectivity

This type of verification allows the user to check if all nets on the circuit board are connected.
Net connectivity check reports broken connections and isolated copper areas (not depending
on the connection type: traces, thermals, shapes, or copper pours).

Launch the PCB Layout module, and open "PCB_2.dip" file from the "C:
\Users\<UserName>\Documents\DipTrace\Examples" folder. Go to "Verification \ Check Net
Connectivity" from the main menu. In the pop-up dialog box you define the objects that will be
considered as connectors by the verification algorithm, typically we recommend to keep all
checkboxes checked. Press OK to launch verification.

The circuit board does not have any unconnected nets, therefore we will make two errors
intentionally.

Close the error-log dialog box, press Al button on the Route toolbar, then move the mouse
to the trace that connects C16:2 to the via and GND copper pour in the Bottom layer, right
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click on this small trace segment, and select Unroute Trace from the submenu. This is
going to be our first error.

@ PCB Layout - [E\DipTrace\Examples\PCB_2.dip]
File Edit View Objects Placement Route High Speed Verification Library Tools Help

DS H|&R B ¢ @0 |8 & % «|25m - | of o [ Tophsy -
(k]m + |8 see -8 0o a0 BES|vE ~&x5 ba

Place Component 4

Rl
v | ) - c@@&-‘

“ | Layers | Objects | Properties

+ I Top Assy

+ Il op sik

v Top Mask

+ I Top Paste

v I (1)
+ - Bottom (2)
+ I Bottom Paste

1/ Bottom Mask

+ I Bottom sik

1/ - Bottom Assy

v - Board Qutline

g Contrast >~ @

Library Tools
Fiter Off

Design Manager

&l
£

C1-0,1-CAP o
€2-0,1-CAP o
C3 - 1UF - CAP100RP

C4 - 1uF - CAP1000AP

C5 - 1UF - CAP1000AP
C6-0,1-CAP

C7 - 1UF - CAP1000AP

C8 - 1uF - CAP1000AP -

Component Pins:

CAP-2.54/6.6x3

Cl16:2 (MINUS) X=2900 Y=1550 Met7 (Default) X=2917.4 mil ¥=1543.6 mil

Isolated copper pour area is the second error that we are about to commit. Double click on
the Bottom layer, then pan to the bottom-right corner of the circuit board, and draw a couple
shapes (arcs or lines) to isolate one of the vias, and don't forget to update the copper pour
(right click on the copper pour's outline, and select Update from the submenu).
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< PCB Layout - [E\DipTrace\Examples\PCB_2.dip] =N
File Edit View Objects Placement Route HighSpeed Verfication Library Tools Help
DE B & & A B« B &, & 600% ~ | 25mi - A Signal/Plane - e | 2% WF
[B]m + | @ oomomsee - 8| 0 a4 @ B S| B ~&>E| b @|¥ & oo - < £ £ s
Place Component 4 * [Layers | Objects| Properties
Components » N Copper Pour:
- Fill Type: Solid -
Discrete SMD Clearance: 15
Symbols Line Width: 25
Symbols EIC
Net Ports Line Spacing: 25
Antennas Island Removal: | |
Batteries Connect to Net: Net 7 -
Buzzers - Thermals: 4 spoke -
Library Tools » Spoke Width: 13.005
) Border: [ |
Fiter Off »
| Update |
CAP100
CAP200
CAP250 Design Manager = @ D
CAP300 Cl-0,1-CAP -
CAP350 £2-0,1-CAP
CAP400 C3 - 1uF - CAP100RP
CAP450 C4 - 1UF - CAP1000AP
CAP500 C5 - 1uF - CAP1000AP
i C6-0,1-CAP
C7 - 1uF - CAP1000AP
A ATE C8 - LuF - CAPL0DOAP b
Component Pins:
4 r
X=4253.5 mil ¥=1129 mil

The picture shows a simple situation when it's very easy to find the mistake, but most errors
of this type (isolated copper pour areas and non-connected pins) usually go unnoticed on
complex circuit boards.

Go to "Verification \ Check Net Connectivity” from the main menu, and click OK in the pop-up
dialog box. The verification reports a broken-net error. Click on the error in the list, and check
error Details. We have Net 7 broken to 4 unconnected areas, scroll down the Details section
of the Connectivity Check Results dialog box to see all unconnected areas of the net and
component pads sorted by areas. Area 1 is the biggest, it is the main part of the copper pour,
the second area is that C16 capacitor's pad which trace we unrouted at the beginning of this
topic, the Area 3 and Area 4 appeared as the result of isolating the part of the copper pour at
the bottom-right of the circuit board.
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< PCB Layout - [E\DipTrace\Examples\PCE_2.dip] (=1 =
File Edit View Objects Placement Route HighSpeed Verfication Library Tools Help

DE | & &E3WD L BRAR| o o &, & 600% - |25ml - | = & [ SonalPlne - | ke g% WE |

-m+ £ Boromside - $h | N, O A © B S| S E| S & M b |y 2 emm@ - o £ 2 o
Place Companent 4 Connectivity Check Result @
Components > Errors: Details:
- 0Q4:2, R2:2, R3:2, U2:6, U2:18, - -
Discrete SMD U2:28, U2:39, U3:15, UB:2
Symbols Area 2:
Symbols EIC C16:2
MNet Ports _
Area 3: |
Antennas 12:6 Y ==
Batteries i -
Buzzers - Area 4: e -
PAD13:1, PAD15:1, Q5:2, Ul:1,
Library Tools » Ui:2, UL:3, U1:4, UL:7 - os
; J
Fiter OFf » [ saetorie | | gos=e | bgste |
CAP100
CAP200
CAP250 Design Manager = @ ay
CAP300
Cl-0,1-CAP -
CAP350 C2-10,1-CAP
CAP400 C3 - 1uF - CAP100RP
C4 - 1UF - CAP10D0AP
g:‘;gg C5 - 1uF - CAP1000AP

C6-0,1-CAP
C7 - 1uF - CAP1000AP
C8 - 1uF - CAP1000AP

Component Pins:

CAP-2.54/6.6x3

1

X=4529 mil ¥=626 mil

You don't have to close the Connectivity Check Results dialog box to fix errors, just move it
a bit.

Sometimes it's hard to understand how to find and fix errors on the design area, we
recommend to use the Design Manager[so] for easy navigation. Just scroll down the list of
components and double click on the component in the list to highlight it on the design area.

You can also save the net connectivity error report into the text file.

5.13 Placement and autorouting

DipTrace has advanced placement features and integrated auto-placer. This makes
placement and layout optimization much easier.

Launch the PCB Layout module, select "File \ Open”, and select "C:
\Users\<UserName>\Documents\DipTrace\Examples\Schematic_4.dch" and use the
schematic rules for this layout. You will get something like on the picture below. The layout is
chaotic, because components are placed just like their symbols in the schematic. Arranging
components manually would be wasting time, this is why we recommend to use automatic
arrangement, but first let's start with the board outline.
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< PCB Layout =0 =R
File Edit View Objects Placement Route HighSpeed Verification Library Tools Help
D& W) | & & 3[)‘ ) | & 8 @ 158% - | 25m - | = o Signal/Plane = @‘ 2 |

W T - o @ @ o

Place Component 4 “ | Layers | Objects | Properties
J12
Components » ’—] s + I Top Assy

‘ + I Top sik

-q/ Top Mask

1/ - Top Paste

~ I e
e + B zotom 2
+ I =ottom Paste

+ Bottom Mask

v - Bottom Sik

-q/ - Bottom Assy

¢ + - Board Qutline

+ Contrast

Library Tools
Fitter Off

R e

-
(@]
D51 - RED - LED -

DS2 - GREEN - LED o
U2 - PICI6F84 - PIC16C84-10/S0 —
J1 - EXPANSION - IDC2X20M

B R1 - 470 - RES

R2 - 470 - RES

R13 - 470 - RES

R11 - 470 - RES z

Component Pins:

Design Manager

o
i

CAP-2.54/6.6x3

X=3790.8 mil ¥=6120.6 mil

DXF import

We will import the board outline from the DXF file. Select "File \ Import \ DXF" from the main
menu and open "C:\Users\<UserName>\Documents\DipTrace\Examples\outline.dxf" file. In
the pop-up dialog box you can see a DXF file that will become the board outline. Select
Board Outline DXF layer, and specify Convert to: Board Outline in a drop-down list
below.
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< Import DXF EI@
Source DXF File: o Import ] | cancel ‘
I DXF Units: Inches -
Import Mode: Mew -
Convert Blocks: Mone -
Layers
DXF Layer Convert to
+ [l Bozrd_outine  None
MNone
Pads
Top Pads
Bottom Pads
All Holes
Pad Holes
Mt Holes
Top Sik
Bottom Sik
Top Assy
Bottom Assy
Top Mask
Bottom Mask
Top Paste
Bottom Paste
Board Qutline
DXF Name: Top
Bottom
Convert to: one]
Pads in Signal Layers .. ]
Fil closed areas
e > Embedded Polygons
Pads in Signal Layers E=ll  When importing component drawings or entire layout from the DXF
Convert to Pads format, you can Fill closed areas and cut holes using Embedded
Lines polygons (usually DXF designs are made from the outlines without
IE fills). This feature works for copper and mask/paste layers only.
/| Circles
Elipses If you're importing pads in signal layer, then you can check the
Arcs Pads in Signal Layers checkbox, and press | |putton to
W . . . .
:”h:es specify what shapes will be automatically converted into pads and
ofygons . . . .
’ their possible dimensions.
/| Holed Polygons
¥Discs (Polyine based) Select Import mode: Add to add board outline to existing layout,
Possble Dimensions make sure inches are selected, and press Import button in the
Minimum: 27.56 mil upper-left_
Maximum: 275.5¢ mil . . .
The board outline will appear on the design area, but components
o] [Conel ] are still messed. Select "Placement \ Placement Setup” from the
main menu:

© 2016 Novarm Software



206 DipTrace Tutorial

Placement Setup @
Placement Grid: 30.37 mil
¥ Spacing: 118.11 il
Y Spacing: 118.11 il
Board Spacing: 118.11 mil

Use Pattern Spacings

Options

Place Components Qutside the Board Outline
[¥] Allow Pattern Rotation

[ Increase Placement Quality (reduces speed)

[ (o]4 H Cancel l

Check Place Components Outside the Board Outline checkbox to arrange components
near the board outline. Keep other settings like on the picture above (notice that values are in
mils, you can change units in "View \ Units" from the main menu). Click OK to apply changes

oo

and press button on the Placement toolbar or select "Placement \ Arrange

Components” from the main menu.

< PCB Layout =8 E=RE=")
File Edit View Objects Placement Route High Speed Verification Library Tools Help
DE H &R Ew B|v |8 & & % - [25m - | o e I sonpee - b | g8 Y| &
(B]m + | @ somomsce - 4 . 0 A4 @ B S| B S~ LxE b E|vE wa - o8&~
Place Component L] m m

Components » + I Top Assy

- + Il op sik
Discrete SMD 4 + Top Mask
Symbols + I Top Paste
Symbols EIC vl :
Net Ports
Antennas + Il sortom 2
Batteries + Il sottom Paste
-\/ Bottom Mask
. Bottom Silk
Liorary Tools > v
1/ - Bottom Assy
Fiter Off » + [ &oard Outline
r Contrast -~ |
]
Design Manager ] @ o,
DS1 - RED - LED ~
DS2 - GREEN - LED 0
U2 - PIC16F84 - PIC16C84-10/S0
J1 - EXPANSION - IDCZX20M
R1 - 470 - RES
R2 - 470 - RES
R13 - 470 - RES
RS EEE R11 - 470 - RES i

Component Pins:

X=2475.2 mil ¥=3502.1 mil

All components are now located in one place near the board outline.
Notice that Arrange components feature isn't the same as Auto-placement.

Automatic placement creates a layout with minimum possible total length of connections
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between the pads of components. Arrange Components feature simply brings all
components to one place and makes it easier to work with them.

However, in real life manual placement is widely used, because most of the time we have
certain places for certain components. DipTrace allows the user to combine automatic and

manual placement on a single circuit board.

Placement by list

Select "Placement \ Placement by List" from the main menu, then in the pop-up dialog box
select component from the list (left click it), move the mouse to the board outline, and click

inside the board outline to place selected component there.

< PCB Layout == ”_EE J
File Edit View Objects Placement Route High Speed Verfication Library Tools Help

D@;”Q@an‘gggn |QQ@11s%vzsmn - | ® & [@ SonalPene - @‘g}n‘ﬂ
(B]m + | @ somomsce - 4 . 0 A4 @ B S| B S~ <xE b E| v wy - o &~

Place Component

4

| Objectsl Properties |

Placement by List @
Components » nent:
= SW3 - RESET - PUSHBUTTONNO N -
S\ - SWPWR - SWITCHSPDT es: u1
Ul - BASIC STAMP 2 - BS2 . BASIC STAME
U2 - PIC16F84 - PIC16C84-10/S0
U3 - 298 - 298KV B BS2
U4 - 7805 - MC7B05ACT .
: DIP-P24
VD1 - 1K4000 - DIODE "
Antennas VD2 - 1N4000 - DIODE ional: [
Batteries xgi i BiSEE 2573.004
VDS - DIODE i| 30.158
- VD7 - DIODE
Library Tools » | |vps - DIoDE - kB 180
. ng 1: Default -
ot
e Close ing 2: Default -
ENEEE |
aood |
e
AP 6 o o [ SE38§{  Design Marager = @ L
s ¢ 2
eeel a0 | 3 ¢ © 9 [B1-BUZZ- SOURCEVOLT o
o o 2elg[] C1 - 1uF - CAP10ORP |
fo we, a8 C2 - 100UF - CAP100RP m
[ o g C3 - 100uF - CAP100RP
; §§ B3 [ C4 - 100uF - CAP100RP
&Y N 1o ge: 5 - 0,1UF - CAP
e SRR €6 - 0,1UF - CAP
gLazane e \gé‘\éi EHER I 7 - 0,1uF - CAP z
e L] SEEEN §Q Component Pins:
o
23 Ol Bl

X=-4119.642 Y=1383.781 X=-1546.5 mil ¥=1422.9 mil

Component disappears from the list after placement (the list shows only components outside
the board outline). Place U1, U2, U3, J1, J8, J12, RN1 and RN2 components manually, like on
the picture below. You can optimize connection lines with "F12" hotkey or uncheck the
Ratlines item on the Objects tab on the Design Manager to hide the ratlines. Close the
Placement by List dialog box when done.
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Custom component clearance

Default component clearance is set with X and Y spacings in the Placement Setup dialog
box. We need all other components to be at least 20 mm away from the U3 component,
therefore we will set a custom clearance for this component. Right click on the U3, and
select Properties from the submenu, then open the Placement tab, and define: Use:
Custom and Value: 800 mil (approx. 20 mm). Click OK to close the dialog box and apply
custom clearance.
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Now select all components which are already on the circuit board, and lock them ("Ctrl+L"
hotkeys).

Auto-placement

We do not have special requirements for other components, therefore we can place them
automatically with 5 mm spacings. Change measurement units ("View \ Units \ mm" from the
main menu). Select "Placement \ Placement Setup” from the main menu, change X Spacing
and Y Spacing to 5 mm, and set 3mm board spacing. Make sure that Allow Pattern
Rotation checkbox is checked (sometimes it is better to turn it OFF, for example, for single-
sided boards with jumper wires). Uncheck Place Components Outside the Board Outline
and make sure Use Pattern Spacings item is checked, this will allow the program to use 20
mm custom clearance of the U3 component. We do not recommend to check Increase
Placement Quality option now (you can try it later).

£l
Press OK to apply changes, and then press o button on the Placement toolbar or select
"Placement \ Run Auto-placement” from the main menu. DipTrace looks for the best location
for each component. You'll get something like on the picture. Notice that Design Manager
panel is hidden ("Ctrl+2" hotkeys), the ratlines are also hidden.
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Some connections are not optimal, because we have placed large components manually. If
you auto-place the entire board, you can get better results, but usually this is not the option in
real life.

It's clearly visible that there is no component on the board closer than 20 mm to the U3,
because of the custom clearance.

Autorouting with net classes

Check via properties in the "Route \ Via Styles" main menu item. One via style is enough for
this project (we use 1.2 mm via with 0.6 mm hole). Now we need to create a separate net
class for Power and Ground nets, because traces of these nets should be a bit wider. Select
"Route \ Net Classes" from the main menu. All nets belong to Default class. Press Add
button to create a new net class, then select it from the list, and enter its name ("POWER").
Specify: Trace Width: 0.6 mm, Clearance: 0.6 mm. Press Clearance Details button and in
the pop-up dialog box set Trace to Pad: 0.5 mm. Now press OK. Select VCC and GND nets
from the list of all nets of the project in the lower-right corner of the dialog box (use "Ctrl"

button for multiple selection) and add them to the POWER net class (press L’ button
above the list).
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Now select Default net class, and specify the following parameters: Trace Width: 0.4 mm,
Clearance: 0.4 mm, Trace to Pad: 0.3 mm. Use all via styles for both net classes (as you
know, we have only one via style). Press OK to close the Net Classes dialog box. Make sure
that Shape Router is active ("Router \ Current Autorouter\Shape Router"), then go to the
Autorouter Setuplss)dialog box, and in the Settings tab uncheck Use Priority Layer
Directions.

Now press "Ctrl+F9" or the v on the Route toolbar to launch the autorouter. In a few
second you will get the results. Change layer colors if you want.
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Detailed description of the autorouter settings available in the PCB Layout Help ("Help \ PCB
Layout Help" from the main menu). If you still have some unrouted nets, Undo, change trace
width/clearance, placement or other settings, then launch autorouter again. However, if you
follow the aforementioned instructions you should not get any problems.
5.14 Fanout

Fanout allows the user to automatically connect pads of selected components (BGA, SOIC,
QUAD) or SMD pads of selected net to inner plane layers with vias of selected style.

Open the PCB Layout module or if it is already open, select "File \ New" from the main menu.
Load rules from the *.rul file that we created at the end of Saving/Loading Design Ruleshos
topic of this tutorial. It should have default, through-hole and blind/buried via styles, custom
net class, and two inner plane layers.

Fanout a component

Now select Patterns library group, it contains all patterns available in standard DipTrace
libraries. Notice that these are just the patterns without schematic symbols. Place one
PLCC-20/8.97x8.97x1.27 from the General library and two BGA-100/10x10x1.27_15x15 from
the BGA library. We will use these patterns for demonstration, but you can select another
patterns / components for practicing with fanout.

Right click on the PLCC pattern, and select Fanout from the submenu. In the pop-up dialog
box specify: Pattern Type: SOIC/QUAD, Placement: Outside, Pads: Left (this means that
only the left row of the pads will have fanout vias), and make sure that Use Connected Pads
Only checkbox is unchecked (because we want to have fanout vias for all components pads,
regardless of whether they are connected or not).
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Select different Via Styles for the pads on the top and bottom side of the board (inactive if
there are no pads on that side). Preview parameters of existing via styles by pressing the Via
Styles... button. In our case we have three via styles: one with through-hole vias, another with
blind/buried vias and the Default via style with relatively big vias. Select the one which fits the
size of current component (Default via style in our case).
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. . Press OK, and vias will appear outside the left pad line

of the PLCC pattern. Right click on the same pattern,
and select Fanout again. Now we will place zigzag vias
/ BN _I ' for the top pads. Set: Placement: Zig-zag and Pads:
O O - Top, keep other settings, and click OK.

Now we will make through-hole vias for one of the BGA
IR ' patterns and blind/buried vias for another. Make sure
R ' that you have corresponding via styles first. BGAs will
S : need smaller vias (we used 0.5 mm vias with 0.25 mm
I_' B BB R _I _ holes for this example).
B B B BN BN R Right click on the first BGA pattern, and select Fanout
from the submenu, specify: Pattern Type: BGA - All
pads and select custom via style with through-hole vias.
Press OK.

Now select the second BGA package. Right click it, and choose Fanout from the submenu.
Select: Pattern Type: BGA - By rows. This allows the user to apply different via styles to
different pad rows of the same pattern or even exclude some rows from the fanout. Left click
on the row number, and select Via Style from the drop-down list.
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because these are usually connected on the top layer of the board.
Fanout net

We will connect several SMD pads to the GND plane layer using the Fanout feature. Place
several SMD and a couple of through-hole patterns on the design area. Create a net that
connects some pins of these components (we suppose this is our GND net that we should
connect to the GND plane layer). Select "Objects \ Place Ratline" from the main menu or

x

press button on the Objects toolbar to create ratlines (connections). Rename net to
"GND" if you want. Check the Ratlines item on the Design Manager's Objects tab if you
don't see the ratlines on the design area.

Make sure that there is a via style with blind/buried vias from Top to GND layer, then right
click on one of connected pads (not on the pattern), and select Fanout from the submenu. In
the pop-up dialog box select appropriate via style, and click OK. Now all SMD pads of
selected net have vias connecting them to the GND inner plane layer, where we placed a
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copper pour|e4] connected to GND net.
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5.15 Hierarchical schematic

We will design a very simple two-level hierarchical schematic just to show you how this
feature works in Schematic and PCB Layout modules of the DipTrace.

Hierarchy blocks

Launch DipTrace Schematic. Hierarchy blocks are associated with sheets, so, first of all, we
have to add two sheets to the blank schematic, select "Edit \ Add Sheet" from the main
menu twice. Then specify that additional sheets are hierarchical blocks, not just regular
schematic sheets, select the second sheet in the bottom-left corner of the design area, and
go to "Edit \ Sheet Type \ Hierarchy Block" from the main menu. Do the same for the third
sheet.

Select main (the first) sheet, and place several components there (for example, three
UGN3275K components from the Allegro library). This will be the main circuit. It doesn't have
any hierarchy blocks yet.

Select the second sheet, then go to "Object \ Hierarchy \ Place Connector" from the main

[z . ,
menu or press button on the Objects toolbar and place several hierarchy connectors to
the second sheet (notice that you can not place hierarchy connectors to non-hierarchical
sheets).

These connectors are the inputs and outputs of the hierarchy block, position and rotation of
connectors is the location of hierarchy block pins on the main sheet.
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Place eight connectors, four on the left side and four on the right. Add two diodes from the

Diodes library, connect them to the connectors, leave some free space for the upcoming

hierarchy block of the second level. Use "R" hotkey to rotate hierarchy connectors.
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Select Sheet 3, and create the second hierarchy block here. Place several hierarchy
connectors (two on the sides and two at the bottom), add couple components (for example,
two AD1317KZ components from Analog Devices library), and connect them.

Notice that you can rename hierarchy connectors in the right-click submenu (select the first
item from the drop-down menu). Connector name will be the name of the block's pin on the

main circuit.
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DipTrace supports multi-level hierarchy, i.e. hierarchy blocks can be inserted into the
main circuit and into each other as many times as needed.

Select Sheet 2, then go to "Objects \ Hierarchy \ Place Block" or press button on the
Objects toolbar. In the pop-up dialog box with the list of available hierarchy blocks, select
Sheet 3, and place two blocks (Sheet 3) into the second sheet (Sheet 2). Use "R" to rotate
blocks.

Notice that you can place Sheet 2 inside itself or make a closed loop of hierarchy blocks, but
it is an error. To avoid this situation, use "Verification \ Check Hierarchy" from the main menu.
DipTrace PCB Layout also checks hierarchy for closed loops and displays the warning
message when you open schematic with hierarchical errors.

We are not making any closed loops right now, just place two Sheet 3 blocks into the Sheet 2
, and connect them to connectors like on the picture below.
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You can rename hierarchy blocks just like regular sheets, right click on the corresponding
sheet tab in the bottom-left of the design area, and select Rename from the submenu.

Select the main sheet, and place hierarchy blocks to the main circuit (for example, add two
Sheet 2 blocks and one Sheet 3, like on the picture below). Connect hierarchy blocks with
other components of schematic.

Notice that hierarchy blocks are similar to regular components, they have pins and you can
rotate or move them around the design area.

These circuit is not a real-life project, it's just a demo example for this tutorial.
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Global nets

As you already knowls2), pins on different levels of hierarchy can not be connected with a

single net, unless it is a special-type net called "global". Global nets exist on different levels of
hierarchy and do not depend on hierarchical structure of the schematic.

Return to Sheet 3, and place a ground (GND) net port from the Net Ports library, then connect
it to GND pins of U4 and U5 components. Notice that the net has automatically became
global.
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Select Sheet 1 (the main circuit), and place GND net port there, then connect it (create a wire
from the net port to some free GND pin). You'll notice that this net now becomes Net 11
(Global). We have a single global net on two hierarchical levels. We can continue this net into
Sheet 1 etc. Rename net to "GND".

Notice that the same net ports anywhere on the circuit are automatically connected to a
single net (Global — if in hierarchy).

You already know how to connect nets by namele?) creating global nets does not differ a lot.
Right click on a random net, and select Properties from the submenu. In the pop-up dialog
box check Global Net for Hierarchy, and Connect Nets by Name checkboxes. Type in the
name of the global net that already exists, and press OK.

Hierarchyin the PCB Layout

Convert this hierarchical schematic to the PCB. Press "Ctrl+B", and select Use Schematic
Rules. In the PCB Layout module components that were in the hierarchy blocks are

superimposing each other, arrange@ them with button on the Placement toolbar).

Notice that all components have the same reference designators as in the Schematic + the
hierarchical block index.

Use "View \ Component Markings \ Main \ RefDes" to display the reference designators if they
are hidden.
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Right click on one of the components that were in hierarchy block, and select Properties
from the submenu. Notice that component involved in hierarchy has additional field with each
hierarchy block RefDes and component RefDes (path). This additional field is used while
updating the PCB by RefDes ("File \ Renew Design from Schematic" from the main menu).

Component Properties |E| Additional Fields @
mm Default Value
| Block4 Blockl U4
RefDes: U4_4
Value:
Mame: AD1317KZ
} Pattern: CLCC-16/17.3x1.27 E]E]
Manufacturer: Anzlog Devices Name:
Datasheet: [ 3 Type: Text -
Hierarchy: - E] Blocks Blockl U4 Default Value:
Library
TR - [ de. E:\DipTrace'\Lib\analog_devices.el E] Apply To:  Current Component -
= (2020 - [ Update component ] [ oK l ’ el
[ OK ] ’ Cancel ]

DipTrace works with hierarchy circuits in the PCB Layout module, you can automatically
arrange components by hierarchy blocks and apply routing and component placement
from one block to another similar block. On the printed circuit board all components,
regardless of their hierarchy level, are on the same layer.
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Select "Route \ Hierarchy" from the main menu. There are two hierarchical sheets available
(the same as in the Schematic). Select Sheet 2 and you will see two actual hierarchy blocks
(because Sheet 2 was inserted two times into the main circuit in the Schematic). Select
Sheet 3 and you will see five blocks inside it (because Sheet 3 was inserted two times into
each Sheet 2 hierarchy block, and inserted once directly into the main circuit in the
Schematic). Notice that the name of the block of higher hierarchical level is listed in the
brackets. When you select hierarchical block from the list, you can see components and nets
that belong to this block on the right in the Block Content field.

Hierarchy @
Hierarchical Sheets: Sheet Blocks
Sheet 2 eet Bloc
Sheet 3 Mon Routed: Routed: BlockS Content:
Blockl (Block3) Components: -
Block2 iBIockB U4 1 -AD1317KZ
US_1-AD1317KZ
Blockl (Block4)
Block2 (Blocks) MNets:
GND
MNet 18
Met 10_1
MNet 8_1
Net9_1
Select Blocks Unroute
Copy Placement and Routing -
0K l [ Cancel

None of the blocks is routed at the time.

First of all we need to arrange components by blocks on the circuit board, select hierarchy
block in the list and DipTrace highlights its components on the design area. Press Select
Block button to arrange components by selected hierarchy blocks.

Egh}ckél Hierarchy ==
5 1 - Hierarchical Sheets:
1] / Sheet 2 Sheet Blocks
| SHeet 3 MNon Routed: Routed: Block5 Content:
Blockl (Block3) Components: -
Block2 iBInckB U4 1 - ADI317KZ
}] H US_1 - AD1317KZ
Blockl (Blocks)
Block2 (Blocks) Mets:
GND
Met 18
Net 10_1
Net 8_1
g Net 9_1
J ) Select Blocks Unroute
Copy Placement and Routing -

[ oK ][ Cancel ]

We will arrange components of two hierarchy blocks on the board, select Block3 and Block4
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from the Sheet 2 (use "Ctrl" to select two blocks at a time), press Select Blocks button, and
then press OK to close the dialog box and apply arrangement. Now two blocks of
components are clearly visible on the design area. We will work with Block 3, which is right
below the Block 4.

Change the layout of components in the Block 3 and route traces automatically, do not route
global nets. Since GND is a global net, we need to exclude the GND net from the
autorouting. Right click on any pad that belongs to the GND net, select Net Properties
from the submenu, and in the pop-up dialog box specify Auto-route Mode: Don't Route.
Press OK to apply.

Notice that global nets should be routed only after finishing routing and arranging components
in the hierarchy blocks.

Now let's route the traces, right click on component pad, and select Route Net from the
submenu or right click on the component, and select Route Traces to route all nets of this
component. Autorouter automatically creates a rectangular board outline. Edit traces
manually if you need.

Notice that we didn't autoroute the entire board: only the traces inside the Block 3, some
connections to Block 4, traces to components from the main schematic sheet.

< PCB Layout EI@
File Edit View Objects Placement Route HighSpeed Verfication Library Tools Help
D@g|§@30‘ B |QQ@22D%vD.635mrrv @ & [ Top Assy - @‘gg |
owm ot |8 oese - H|N o0 a0 ES| S E S(fwe|lre|lve wo | ofea
Place Component 4 ) ) ) ) ) ) ) ) ) 0_ 0_ ] == o
Components » jD :ID
a
IR A . . . . . . . . . ] . .
Lattice a
Linear L 0F U5_%
Maxim
OCNIP
Micron
Mital i
Liorary Tools >
Fiter Off »
24LC256MF =
24LC256MS
24LC256P
24LC2565M
24LC2565N
24LC2565T
dsPIC30F1010_MM
dsPIC30F1010_S0O

dsPIC30F1010_5P
dsPIC30F2010_MM
dsPTCI0F20H0 S50 7
TSSOP-8

==

4 *
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Copy placement and routing between hierarchical blocks

Go to "Route \ Hierarchy" from the main menu, select Sheet 2 again. This time Block 3 is
routed. Select Block 3 from the Routed list, and Block 4 from the Non Routed list, then
press Copy Placement and Routing button to apply Block 3 placement and routing to the
Block 4.
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If you have routed a lot of traces from Block 3 to Block 4, the Block 4 can appear in the
Routed list on the hierarchy dialog box. Just select it, and press Unroute, then apply routing
and placement.
Let's also apply placement and routing to Block 5 without closing the Hierarchy dialog box.
Select Block 5 on the Sheet 3, and then select one of the routed blocks, then press Copy
Placement and Routing button again. Now press OK to apply routing.
Routed blocks are next to the board outline, use box selection to move them on the design
area.
Notice that DipTrace didn't copy traces heading outside selected hierarchical block.
< PCB Layout [E=H =R
File Edit View Objects Placement Route HighSpeed Verification Library Tools Help
D#H|§@30‘%E‘|n |@Q@Q242%v0.635mrrv = amc [ Top Assy - @‘gﬁﬂ;{|
(Blm + | @ mosee -84 0 a0 BES|/ B S“A>id|ra|veEg oo -| o€
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Mital
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5.16 3D preview and export

DipTrace PCB Layout module features built-in real-time 3D visualization with STEP and
VRML export. This tool allows the user to visually check the circuit board with all components
installed and export the PCB model to mechanical CAD programs for developing the device
housing etc.

Download and install 3D model libraries from the DipTrace website. Components without
3D models appear only as footprints on the circuit board in the 3D mode.

Launch PCB Layout then go to "File \ Open" (or press "Ctrl+O") and select "C:

\Users\<UserName>\Documents\DipTrace\Examples\PCB_6.dip", then press button on
the Standard toolbar. The Attached 3D Models dialog box will pop up. DipTrace checks if all
components have 3D models and tries to find correct models for components without them.
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See 3D preview and export section in the PCB Layout Help ("Help \ PCB Layout Help" from
the main menu) for more details.

<} Attached 3D Models =5 Eol ===

Some patterns don” t have attached 3D models and/or some models were found automatically
(red items). Please check the list of attached 3D models and add new ones below.

RefDes Pattern 30 Model File Save to Project Edit -
U1 IDC34M idc34m.wrl

U2 ROCC-32L rlcc-32_11.5x14x1.2

u3 HDR-2¥20 hdr-2x20t_2.54%2.5 1./

4 HDR-2X22 hdr-2x22t_2.54x2.5 !

us SIMM-1.27/2V72  simm-1.27_2v72.wil . |4
s 5028 soic-28_300mil.wrl

u7 (0] (o] soic-8_150mil.wrl >

Save all new models to project

Show this window before 3D preview if necessary

[ 0K H Cancel l

Press OK and you'll see a 3D model of the circuit board. You can rotate the circuit board
model by three axes, move it with your mouse, zoom in and out with the mouse wheel, etc.

You can change colors of the background, board, solder mask, and component and via
display options, just press Redraw to implement certain changes.

@ 3D Preview [re [ ]
ol K.\ Colors
Background
I coard
I solder Mask
Copper (Pads/ Traces)
Sik Screen

Displaying

Components

[T Open Vias

Board Thickness: 1 mm
Sld Mask Swell: 0 mm

[ Reset View ] [ Redraw ]
L& [« |
[ Bxport STEP ]
( Export VRML ]

Close

3D export
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STEP VRML 2.0 DipTrace 3D Preview module allows the user to
E”:;“T”D == E‘“;‘:““MUD &9 export 3D model of the board to STEP (*.step) and
. - VRML 2.0 formats (*.wrl) supported by most
lpackage Modeis 7] Paciage odels mechanical CAD software.
Pad Holes Pad Holes
Models 5o Gcommended) < || T When in the DipTrace 3D preview & export
sty module press Export STEP button. In the pop-up
| el ] | ones Mewrs - dialog box specify which objects to include in the
— exported model (Board, Package models, Pad

holes), and whether to export model as a solid
body or as parts.

Press OK to specify the filename and the folder. We recommend to export project as a Solid
body in STEP format.

Notice that exporting holes dramatically slows the process.

To export the board model to VRML format, press Export VRML button, select which objects
to include in the exported model, set the units, press OK, and set the file location.

Mapping a 3D model

Press | = |button in the Attached 3D Models dialog box or right click on any component
on the design area in the PCB Layout, and select 3D Model from the submenu. In the pop-up
dialog box you can rotate a 3D model by three axes, zoom in and out, move the model by
holding the right mouse button, and change the colors of the preview.

If you need to change a 3D model, press All Models>> button, and select a 3D model from
the list of all available models sorted by pattern libraries.

To attach a 3D model from the separate file, press the |_| button to specify the path to the
file on your computer. DipTrace supports 3DS, VRML, STEP, and IGES files.

DipTrace automatically places a 3D model to fit the pattern's drawing, but sometimes you

may need to adjust a 3D model location or its scale. Just enter appropriate values into the

corresponding fields of the 3D Model Properties section (shift, angle, and scale for each

axis). Changes apply instantly. Check out Attaching a 3D model topic o4 of this tutorial and
PCB Layout Help for more details about mapping a 3D model.
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3D Model - 1C2 (=23
3D Model File:
E:\Dip Trace\models3d\_VRML\PLCC\plcc ... |
[ Load Model | [ Al Models >> |
[ Turn Off Automatic Search
File Units: Wings 30«
3D Model Properties
X Shift: 0.85 mm
Y Shift: 0 mm
Z Shift: 0 mm
X Angle: 0 deq.
¥ Angle: i deg.
Z Angle: 180 deg.
X Scale: 1 fa)
Y Scale: 1
Z Scale: 1
[T Flip by Z Axis
Apply To: Current Component -
Colors
Background
Pads
B Sik Screen
[ oK ] I Cancel ‘

Press OK to close the 3D Model dialog box.
Search 3D models

Go to "Tools \ 3D Preview \ Patterns and Models Search", in the pop-up dialog box you can
change the search accuracy and active search folders.

In the Pattern Search section you can select the level of conformity that will be used by
DipTrace while searching for the models (more strict requirements mean less possible
models found). Press Search 3D Models... to check the results.

If you have 3D models in other folders on your machine, you need to let the software know
that it should search 3D models in those folders, just add new folder to the 3D Model
Folders list. By default all 3D models are in the "models3d" folder inside the "DipTrace"
directory.

Notice that standard 3D libraries are not included in the DipTrace installation package. You
need to download them from the DipTrace website.

Notice that we recommend to attach 3D Models in the Pattern Editor while drawing the
footprint.
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X=84.72 mm ¥=101.68 mm

5.17 DipTrace Links
DipTrace official website.

EAQ.

How to install DipTrace.

DipTrace Support Portal.

DipTrace Sales.

Download the latest version (go to "Help \ About" if you don't know your current version).

Order DipTrace.

Download Libraries.

DipTrace Forum — suggest new features, discuss DipTrace and share your experience.

DipTrace Community at Yahoo!

DipTrace PCB Design Service.
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